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About this document

This guide describes the activities that you can perform when using the DPN 
Devices configuration toolset submenu. 

The following topics are discussed in this section:

• “Who should read this document and why” (page 21)

• “What you need to know” (page 21)

• “How this document is organized” (page 22)

• “Text conventions” (page 24)

• “Related documents” (page 25)

Who should read this document and why
This guide is intended for personnel who define and configure service data to 
meet customer requirements. It can also be used by those who install, 
engineer, and monitor the DPN networks, namely:

• provisioning operators

• network engineers

• network operators

• network administrators.

What you need to know
Before using the configuration for DPN Devices toolset, it is assumed that 
you know how to log on to the Preside Multiservice Data Manager (MDM) 
and how to work with the Preside MDM user interface. You must have had 
some exposure to both computers and network concepts. Basic computer 
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literacy is required to operate the applications. You must know how to use a 
keyboard and a mouse, what a menu is, and how to start applications from a 
menu using a mouse.

241-6001-802 Preside MDM User Interface Primer is designed to acquaint 
you with the user interface and it provides necessary information to get you 
started. 

To use the command line applications described in this document, some 
knowledge with Sun workstations, the UNIX operating system, namely the 
editing facility vi to be able to modify files, and X.25 network 
communications would be helpful.

How this document is organized
This guide consists of an introductory chapter and a chapter for each tool in 
the DPN Devices configuration toolset. 

241-6001-012 Preside MDM Configuration Management for DPN User 
Guide contains the following sections:

• “DPN Devices configuration tools” (page 27) lists all the tools available 
in the DPN Devices Configuration toolset. 

• “Uploading and downloading MCFs” (page 39) describes the MCF 
uploading and downloading terminology.

• “Opening the Configuration - DPN Devices toolset” (page 47)details 
how you can activate and use the tools within the DPN Devices 
configuration toolset.

• “Component Provisioning” (page 61) explains how Component 
Provisioning allows you to define, edit, and display service data for the 
DPN-100 network.

• “Global Data Manager” (page 127) explains how the Global Data 
Manager tool manages service data that is common across more than one 
module. It will help locate, duplicate, and distribute global provisioning 
data to simplify synchronizing data on multiple modules.

• “Service Data Backup” (page 161) explains how the Service Data 
Backup tool is used to back up service data files for the DPN-100 
module(s).
241-6001-012   14.3RSUP   
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• “Service Data Restore” (page 169) explains how the Service Data 
Restore tool is used to retrieve backed up MCF sets from the Backup disk 
for a DPN-100 module.

• “Software Distribution” (page 179) explains how the Software 
Distribution tool provides a software distribution service from a Preside 
Multiservice Data Manager (MDM) workstation.

• “Software Substitution” (page 193) explains how to use the Software 
Substitution tool to upgrade to images on the DPN-100 modules.

• “Service Data Conversion” (page 207) explains how to use the Service 
Data Conversion tool to migrate your service data to a new level of 
software.

• “Envelope Editor” (page 221) explains how the Envelope Editor is used 
to edit and create service data envelopes or Service Data Area (SDA) 
headers.

• “Network Activation” (page 235) explains how to use the Network 
Activation tool to automate the activation process.

• “MCF Directory Merge” (page 277) explains how you can use the DPN 
Master Configuration File (MCF) Directory Merge application to merge 
a selected number of MCF directories.

• “MCF management” (page 281) details the commands that are available 
to help networks with MCF management.

• “Using HP OpenView NNM desktop” (page 305) describes how you can 
access DPN Devices configuration tools from the OV Desktop 
application.

• “Service data format” (page 311) has a conceptual model of how service 
data is presented by Component Provisioning.

• “Component Provisioning paste keys” (page 315) lists the services that 
are supported when pasting PVC or direct call components when you 
select the Change Keys option in Component Provisioning.
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Text conventions
This document uses the following text conventions: 

• nonproportional spaced plain type

Nonproportional spaced plain type represents system generated text or 
text that appears on your screen.

• nonproportional spaced bold type

Nonproportional spaced bold type represents words that you should type 
or that you should select on the screen.

• italics

Statements that appear in italics in a procedure explain the results of a 
particular step and appear immediately following the step.

Words that appear in italics in text are for naming.

• [optional_parameter]

Words in square brackets represent optional parameters. The command 
can be entered with or without the words in the square brackets.

• <general_term>

Words in angle brackets represent variables which are to be replaced with 
specific values.

• UPPERCASE,lowercase

In Preside Multiservice Data Manager (MDM), uppercase and lowercase 
letters that appear in UNIX commands and parameters must be matched 
exactly. The system matches upper and lowercase characters differently.

• |

This symbol separates items from which you may select one; for 
example, ON|OFF indicates that you may specify ON or OFF. If you do 
not make a choice, a default ON is assumed.
241-6001-012   14.3RSUP   
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• ...

Three dots in a command indicate that the parameter may be repeated 
more than once in succession.

The term absolute pathname refers to the full specification of a path starting 
from the root directory. Absolute pathnames always begin with the slash ( / )
symbol. A relative pathname takes the current directory as its starting point, 
and starts with any alphanumeric character (other than /).

Mouse buttons
Clicking the select (left) mouse button selects action buttons and radio 
buttons in windows and dialogs when you place the cursor over those buttons. 
Clicking select also places your cursor where you want it to be when you want 
to perform activities in a window or start entering text in a field.

Clicking the modify (middle) mouse button modifies selections. For example, 
by clicking modify you can lengthen or shorten the amount of text selected for 
a copy or cut operation as discussed later.

Holding down the menu (right) mouse button brings up a menu of commands. 
When you move the pointer to a specific place on the screen (such as the 
icon), press and hold down the menu button. Move your mouse, and therefore 
your screen pointer, until the command you want to execute is highlighted. 
Then, release the menu button. The command that you highlighted is executed 
when you release the menu button.

Related documents
See the following documents for related information:

• 241-1001-303 DPN-100 Operator Commands and Responses

• 241-2001-340 DPN-100 Envelope Definitions

• 241-6001-011 Preside MDM Fault Management User Guide

• 241-6001-022 Preside MDM Network Reporting System User Guide

• 241-6001-304 Preside MDM Configuration Management Administrator 
Guide

• 241-6001-501 Preside MDM Proxy Alarms Reference Guide
Preside MDM Configuration Management for DPN User Guide   14.3RSUP
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Chapter 1
DPN Devices configuration tools

Configuration for DPN Devices consists of a set of applications used to define 
and maintain service and operating parameters for DPN-100 modules, 
namely access modules (AM), resource modules (RM), and access 
concentrators (AC). See the figure “DPN Devices - configuration 
applications” (page 29).

DPN Devices configuration provides the following capabilities:

• The ability to examine and edit service data residing on DPN-100 
modules.

• Command line applications that allow you to combine Master 
Configuration File (MCF) directories on a DPN-100 module.

• The ability to view, change, delete, and add provisioning data for almost 
all DPN services, such as ITI, X.25, SNA, and UTP.

• Applications that allow service data to be backed up to a Backup disk or 
an Preside Multiservice Data Manager (MDM) server, and restored from 
the selected Backup source.

Applications for DPN Devices configuration provide a readable presentation 
of DPN service data and a simplified logical representation of the parameters.

The DPN Devices configuration system consists of a set of graphical user-
interface (GUI) applications along with command line applications. All the 
GUI applications have the capability to copy text from the Messages areas 
and paste it into another location. 
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See the following sections for information on the Configuration toolset 
submenus for DPN devices:

• “Component Provisioning” (page 30)

• “Global Data Manager” (page 30)

• Administration 

— “Service Data Backup” (page 31)

— “Service Data Restore” (page 32)

— “Software Distribution” (page 32)

— “Software Substitution” (page 32)

— “Service Data Conversion” (page 32)

— “Envelope Editor” (page 33)

— “Network Activation Tool” (page 33)

• Network Reporting System 

— 241-6001-022 Preside MDM Network Reporting System User Guide

• Inventory Reports. See 241-6001-808 Preside MDM Device Inventory 
Tools User Guide.

See the following sections for information on the tools which can only be 
accessed with a command line in the UNIX shell:

• “MCF Directory Merge” (page 35)

• “MCF management” (page 35)
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Figure 1
DPN Devices - configuration applications
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Component Provisioning
The Component Provisioning tool can define, edit, and display service data 
for DPN-100 modules. Component Provisioning allows you to do the 
following: 

• access and navigate through the service data hierarchy

• edit or view service data 

• verify the sanity of edited service data

• download the edited service data to the module or NMS disk

• manage several service data views, including the committed and 
activated

• generate service data reports

• access templating

• create propagation log files

See “Component Provisioning” (page 61) for more details.

Global Data Manager
The Global Data Manager (GDM) tool provides a mechanism whereby 
certain global service data components can be duplicated from one master 
configuration file (MCF) to one or more MCF(s) in the network. It allows you 
to provision an arbitrarily designated master MCF as a source of service data 
envelopes to be copied to one or more target MCF(s). 

The GDM tool can also be used to update the preferred path service data in 
resource modules (RMs) with the routing data obtained from a transaction file 
that is created with the Network Traffic Engineering (NTE) tool, or with third 
party software.

This tool can be used either by means of the graphical user interface or by a 
command line in a UNIX shell. If you choose to use the command line 
interface, necessary information is entered as command parameters or it can 
be kept in a command file. You can also save messages by enabling Log file 
in the graphical user interface.

See “Global Data Manager” (page 127) for more details.
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Administration
The Administration submenu provides the following items:

• “Service Data Backup” (page 31)

• “Service Data Restore” (page 32)

• “Software Distribution” (page 32)

• “Software Substitution” (page 32)

• “Service Data Conversion” (page 32)

• “Envelope Editor” (page 33)

• “Network Activation Tool” (page 33)

Service Data Backup
The Service Data Backup tool is an application that provides facilities to 
create backups for the master configuration files (MCF) on a Backup disk, on 
a Preside Multiservice Data Manager (MDM) server, or on DPN-100 
modules. In the last case, it also triggers the dumping process that transfers 
backup MCFs from the DPN-100 module to the backup system. The Dump 
Start command overrides the dump schedule at the DPN-100 module.

The Service Data Backup tool allows you to perform the following functions:

• authentication

• connect to the DPN module 

• retrieve a list of MCF sets 

• select MCF sets for creating backups 

• create MCF backups 

• activate and terminate MCF dumping process 

See “Service Data Backup” (page 161) for more details. 
Preside MDM Configuration Management for DPN User Guide   14.3RSUP



32   Chapter 1 DPN Devices configuration tools
Service Data Restore
The Service Data Restore tool is an application that provides facilities to 
retrieve backup master configuration files (MCF) from the Backup source and 
restore the MCFs to a specific DPN module. It also allows you to clean up 
MCFs stored on a Backup site.

See “Service Data Restore” (page 169) for more details. 

Software Distribution
The Software Distribution tool instructs the DPN-100 module to copy images 
from a Remote Download Site (RDS) back to the DPN-100 module disk. It 
also allows you to download DPN software images from the Software 
Distribution Site (SDS) to the DPN-100 modules.This tool is accessible by 
means of the graphical user interface or a command line interface from a 
UNIX shell. If you choose to use the command line interface, necessary 
information is entered as command parameters or it can be kept in a command 
file. You can also save run time messages in a log file.

See “Software Distribution” (page 179) for more details.

Software Substitution
Software Substitution is an application used to upgrade images from an older 
release to a newer release on DPN-100 modules. This tool can be used either 
by means of the graphical user interface or by a command line in a UNIX 
shell.

See “Software Substitution” (page 193) for more details on images upgrades.

Service Data Conversion
The Service Data Conversion tool allows you to convert service data from one 
generic to another, one MCF at a time. The new service data can then be used 
with the new switch software. This tool allows a service data conversion for 
each new main release.

See “Service Data Conversion” (page 207) for more details.
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Envelope Editor
The Envelope Editor application provides a tool that edits and creates service 
data envelopes or Service Data Area (SDA) headers. The Envelope Editor 
displays service data in ASCII hex or binary format. In the Envelope Editor, 
you can perform a number of operations on service data. These operations 
are:

• retrieve service data for viewing or editing 

• add new service data envelopes or SDA headers

• delete service data envelopes or SDAs

See “Envelope Editor” (page 221) for more details. 

Network Activation Tool
The Network Activation Tool (NAT) simplifies and automates the activation 
process for multiple modules in a network. The activation and commit 
operations can be performed interactively or in batch mode.

See “Network Activation” (page 235) for more details.

Network Reporting System
The Network Reporting System contains the following items:

• “Service Integrity Audit” (page 33)

• “Configuration Reports” (page 34)

• “Configuration Differences” (page 34)

Service Integrity Audit
The Service Integrity Audit item opens the DPN Service Integrity Audit tool. 
This tool is used to populate the NRS database for DPN and/or Passport 
modules, and to do the following optional tasks:

• execute the NRS-based Service Integrity checks (NSICs)

• populate the Network Configuration Database (NCD)
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See 241-6001-022 Preside MDM Network Reporting System User Guide for 
more details.

Configuration Reports
The Configuration Reports item opens the Configuration Report dialog which 
lets you produce simple configuration hierarchy reports.

See 241-6001-022 Preside MDM Network Reporting System User Guide for 
more details

Configuration Differences
The Configuration Differences item opens the Configuration Differences 
dialog which lets you select two sets of configuration data and produce a 
report on the differences between the two configurations.

See 241-6001-022 Preside MDM Network Reporting System User Guide for 
more details.

Inventory Reports
The Inventory Reports item opens the Inventory Reports tool. This tool lets 
you report on the hardware and software configuration of selected devices in 
your network. 

See 241-6001-808 Preside MDM Device Inventory Tools User Guide for 
more details.

Command line applications
Configuration for DPN Devices includes the following tools which you can 
access from a command line:

• “MCF Directory Merge” (page 35)

• “MCF management” (page 35)
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MCF Directory Merge
MCF Directory Merge is a UNIX command line application used to merge a 
selected number of MCF directory files into a new MCF directory file. After 
the on-switch tidy command is executed, the MCF directory merge 
application allows you to keep three or more bundles on a DPN-100 module. 
A bundle is an MCF directory and its associated files. 

For more information on the tidy command, see 241-1001-303 DPN-100 
Operator Commands and Responses. See “MCF Directory Merge” 
(page 277) for more details on MCF Directory Merge.

MCF management
MCF management is a set of UNIX utilities used to help manage MCFs on 
PMs and NMS disks.

See “MCF management” (page 281) for more details.

Provisioning specific services
This document does not cover the provisioning of specific services. See the 
table “Provisioning document references” (page 35) for references to specific 
provisioning documents.

Table 1 
Provisioning document references

Service Reference

3270DSP TPAD/HPAD 241-1001-189 DPN-100 3270DSP (TPAD/HPAD) User Guide 
and Specification

Access_To_Call_Redirection 241-1001-115 DPN-100 Call Redirection System User Guide

Access_To_NUI_Validation 241-1001-112 DPN-100 Off-Network NUI Validation System 
User Guide

AM/RM modules 241-1001-109 DPN-100 AM and RM Provisioning User Guide

API Service  241-1001-192 DPN-100 API Service User Guide and 
Specification

Broadcast Server 241-1001-013 DPN-100 Broadcast System User Guide

 (Sheet 1 of 3)
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Call_Redirection_List 241-1001-115 DPN-100 Call Redirection System User Guide

Call Redirection Server, 
Access to Call Redirection

241-1001-115 DPN-100 Call Redirection System User Guide

Call Services Resource 
Module (CSRM)

241-7401-110 Passport 7400, DPN-100 Interworking Guide

CASP  241-1001-170 DPN-100 Q.931 and Demand-Established B-
Channel User Guide

Cluster Remote Display Unit 
service (CRDU)

 241-1001-014 DPN-100 CRDU TPAD Service User Guide

CUG Mapping 241-1001-181 DPN-100 X.75 Service Specification

Dial-up Network Links 241-1001-015 DPN-100 Network Link and Trunk User Guide

DEB 241-1001-170 DPN-100 Q.931 and Demand-Established B-
Channel User Guide2

DORS Provisioning on SNA 241-1001-315 DPN-100 SNA Dial-out Service User Guide

DORS Provisioning on X.32 241-1001-314 DPN-100 X.32 Service User Guide

DPN-100/1 241-1001-171 DPN-100 DPN-100/1 User Guide2

Frame Relay 241-1001-120 DPN-100 Frame Relay Service User Guide and 
Specification

Gateway Access Service 
(GAS)

 241-1001-165 DPN-100 Gateway Access Service User Guide

HDLC Transparent Data 
Service

241-1001-158 DPN-100 HDLC Transparent Data Service User 
Guide

Hunt Group Server 241-1001-117 DPN-100 AM/RM Hunt Group Server User Guide

ITI_Network_Components 241-1001-018 DPN-100 Asynchronous Service Provisioning 
User Guide

ITI, Point of Sale, ITI Videotex 241-1001-018 DPN-100 Asynchronous Service Provisioning 
User Guide

LAPB Network Link 241-1001-197, RM Network Link Specification

Table 1  (continued)
Provisioning document references

Service Reference
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LAPD X.25  241-1001-194 DPN-100 LAPD/X.25 User Guide and 
Specification

Local_Trans_Table 241-1001-317 DPN-100 X.25 Gateway User Guide

NCS 241-2001-102 DPN-100 Network Control System User Guide

NDI Server, GMS, Access to 
NUI

241-1001-112 DPN-100 Off-Network NUI Validation System 
User Guide

PE_Hunt_Group_Server 241-1001-117 DPN-100 AM/RM Hunt Group Server User Guide

PE_NDI_Server 241-1001-112 DPN-100 Off-Network NUI Validation System 
User Guide

PE-Universal_Server 241-1001-018 DPN-100 Asynchronous Service Provisioning 
User Guide

Remote_Trans_Table 241-1001-317 DPN-100 X.25 Gateway User Guide

SABRE TPAD 241-1001-017 SABRE TPAD Service User Guide

SNA Services 241-1001-125 DPN-100 SNA Multihost and LU Multiplexing 
User Guide

Source Call Router, 
Destination Call Router

241-1001-111 DPN-100 Routing & Call Establishment General 
Description

SWIFT BSC TPAD 241-1001-016 SWIFT BSC TPAD Service User Guide

Token-Ring SNA PAD 241-1001-163 DPN-100 Token-Ring SNA PAD Service User 
Guide

X.224 System 241-1001-118 DPN-100 X.224 System User Guide and 
Specification

X.25 241-1001-184 DPN-100 LAPB/X.25 Specification

X.25 Gateway 241-1001-317 DPN-100 X.25 Gateway User Guide

X.32 241-1001-314 DPN-100 X.32 Service User Guide

X.75 Gateway 241-1001-181 DPN-100 X.75 Service Specification

Table 1  (continued)
Provisioning document references

Service Reference
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Chapter 2
Uploading and downloading MCFs

Service data created by DPN Devices configuration is stored on disks 
attached to either a Preside Multiservice Data Manager (MDM)  workstation 
or a DPN-100 module. When a provisioning session is started, the service 
data must be retrieved from the disk before it can be changed. This operation 
is called uploading. When a provisioning session is completed, the service 
data is placed back on the disk. This operation is called downloading.

Many DPN Device configuration applications involve uploading and 
downloading service data from DPN-100 modules. Some important 
fundamentals involved with the upload and download operations are 
described in the following sections.

Master configuration files
An MCF is a hierarchical set of MC (master configuration) files containing 
binary service data used by DPN switches. At the top of the hierarchy is the 
root MCF. Usually, the entire MCF is referred to by the name of the root MCF. 
A root MCF is specified as follows:

MC.<bundle>.<namsid>.0

where: 

bundle

are 1 to 8 alphanumeric or underscore characters

namsid

is a numeric value between 256 to 49151
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Example
MC.93061603.9999.0

Each MC file, including the root MCF, contains references to other MC files 
and/or service data; this forms the hierarchy. This paradigm allows multiple 
MCFs to share subordinate MC files.

NAMS ID
The NAMS ID is an integer between 256 and 49151 which uniquely identifies 
a packet module in the network. Configuration for DPN Devices treats the 
NAMS ID as an optional field when uploading and downloading MCFs.

Note: When uploading an MCF from an NMS disk the NAMS ID is 
mandatory.

When uploading MCFs, if the NAMS ID is not specified, the NAMS ID of the 
COMMITTED MCF on the module is used. 

When downloading MCFs, if the NAMS ID is not specified, the NAMS ID of 
the uploaded MCF is used.

Location
MCFs are typically stored on the local disk of the packet module (PM) to 
which they apply. They may also be stored on the disks of other PMs or an 
NMS disk.

When uploading or downloading MCFs to an NMS disk, the actual directory 
used is the one specified in the /opt/MagellanNMS/cfg/PFA.cfg configuration 
file. The directory is locally accessible from the Preside Multiservice Data 
Manager (MDM) host on which the PFA server is running.

Authentication
During upload and download the Preside Multiservice Data Manager (MDM) 
issues an NCS command to the module containing the DNA of the MDM 
host. The module then places a call to the Preside MDM. This activity can be 
done automatically by the application if the module is reachable via NCS and 
the authentication information is supplied by the user for validation. 
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Authentication is required to associate the DPN Device configuration session 
with an OA in the network. The Destination, User ID and Password must be 
specified before authentication occurs.

All DPN Devices configuration tools use the Connection Manager for 
authentication. See “Connection Manager authentication” (page 48) for more 
information.

Manual access mode
DPN Devices configuration has the capability to access a module manually. 
Manual access mode is used when the call from the module to the Preside 
Multiservice Data Manager (MDM) needs to be placed manually. For 
example, this would be necessary if a module was unreachable by NCS.

How to establish a manual call

1 In the Preside MDM window, select Configuration -> DPN Devices -> 
Component Provisioning.

The Command Console Connection Manager dialog opens.

2 Select the Manual Access Mode check box.

3 Click Authenticate or hit the return key.

The Command Console Connection Manager dialog is closed.

4 Enter the component id in the Component area field.

5 Click Expand or press enter.

6 Issue the CALL command either from the local operator console for the 
module or via the NCS command console. The command syntax is a 
follows:

con pagent call x <x121 address> pagent <lock id>

The time in which this command must be entered is specified in the 
PFA.cfg file, the default is 30 seconds.

Note:  The userdata field must be PAGENT in order for the call to be 
established, otherwise the call request will be cleared with a code of C1.

NCS routing
When uploading or downloading MCFs to a module, the specific NCS 
routing information for locating that module can be specified. This is required 
if there is a CFNS OA in the NCS hierarchy. This explicit routing information 
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is used to navigate through the NCS hierarchy from the OA in which the 
configuration session is logged to the module. For example, the path to 
<pm_mnemonic> in TOR5 can be specified as:

‘TOR1-TOR2-TOR5-<pm_mnemonic>’

When a backup OA is created it is usually given the same name as the primary 
OA, except -B is added to the end. For example, OANAME -B is the backup 
for OANAME. DPN-100 NCS supports path routing to the module when the 
backup OA becomes the primary OA. Configuration for DPN Devices allows 
the use of this implicit path routing to access a module. However, 
Configuration for DPN Devices does not support explicit naming of a path 
route that includes a backup OA name with the form <OANAME> -B.

MCF naming
There are five different naming conventions for identifying MCFs when 
uploading and downloading from the modules.

Active
Active mode allows you to upload the active MCF on a given module.

Note: Active mode does not apply when downloading or to MCFs stored 
on a NMS disk.

Committed
Committed mode allows you to upload the committed MCF on a given 
module.

Note: Committed mode does not apply to downloading or to MCFs 
stored on a NMS disk.

User specified
The most flexible mode, user specified, allows you to explicitly specify the 
bundle and NAMS ID which comprise the MCF. This mode can be used to 
name any MCF. For example:

MC.MYBUNDLE.9999.0

When uploading MCFs in user specified mode, you supply the upload bundle 
(and optionally NAMS ID). If the specific MCF exists, it is uploaded.
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When downloading MCFs in user specified mode, you supply the download 
bundle (and optionally NAMS ID). If the specific MCF does not exist, it is 
downloaded. If the specific MCF already exists, the download will fail.

Keyed
Keyed mode interprets the bundle field as a key concatenated with an index. 
A keyed MCF is specified as follows:

MC.<key><index>.<namsid>.0

where:

key

are 1 to 6 alphanumeric or underscore characters

index

is a numeric value between 00 to 99

namsid 

is a numeric value between 256 to 49151

Example
MC.MYKEY44.9999.0

When uploading MCFs in keyed mode, you supply the upload key (and 
optionally NAMS ID). The latest MCF (the one with the greatest index) is 
retrieved based on the MCFs matching the pattern as follows:

MC.<key>*.<namsid>.0

Note: If no MCFs exist with that key, the upload fails.

When downloading, the same logic is applied and the next in the sequence is 
created. The user specifies a download key (and optionally NAMS ID) and 
Configuration for DPN Devices determines which MCF is to be downloaded.
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For example, given the key MYKEY, if the following MCFs exist at the 
specified location,

MC.92010110.9999.0

MC.92010120.9999.0

MC.MYKEY19.9999.0

MC.MYKEY20.9999.0

MC.0001019.9999.0

MCF MC.MYKEY20.9999.0 would be the latest.

Dated
Dated mode is similar to keyed mode except the key is a date in the form: 
yymmdd where yy represents the year, mm the month, and dd the day. A dated 
MCF is specified as follows:

MC.<yymmdd><index>.<namsid>.0

Example
MC.93061612.9999.0

When uploading MCFs in dated mode, you supply the upload date (and 
optionally NAMS ID) and the latest MCF is retrieved based on the MCFs 
matching the pattern as follows:

MC.*.<namsid>.0

The bundle portion is processed and those MCFs having an 8-digit bundle 
where the first 6 digits are a valid date are considered. The MCF with the 
greatest date not exceeding the upload date is selected. 

Note: If no MCFs exist with the upload date, the upload does not 
necessarily fail; the next latest MCF is chosen.

When downloading, the same logic is applied and the next in the sequence is 
created. You specify a download date and the system determines which MCF 
is to be downloaded. 

This allows the provisioning system to determine, given a date what the latest 
MCF is relative to that date.
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For example, given the date 970101, if the following MCFs exist at the 
specified location,

MC.92010100.9999.0
MC.92010110.9999.0
MC.92010120.9999.0
MC.99010120.9999.0
MC.0001019.9999.0

MCF MC.92010120.9999.0 would be the latest.

Dated algorithm
To account for the year 2000 and beyond, Configuration for DPN Devices 
interprets 000101 as later than 991231. The base year has been chosen as 
1980. This means 800101 precedes 900101 which precedes 000101 which 
precedes 790101. In other words:

if (yy < 80)
   year = 2000 + yy
else
   year = 1900 + yy

This means:

80 => 1980
90 => 1990
99 => 1999
00 => 2000
10 => 2010
79 => 2079

Activation date
In Preside Multiservice Data Manager (MDM), an edition-issue has an 
activation date associated with it. The activation date is in the following 
format in the SDA header: yyyymmddhhmmssss where yyyy is the year, mm is 
the month, dd is the day, hh is the hour, mm is the minute and ssss is the 
seconds.
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When a download takes place this activation date is stored in each SDA 
created (in the SDA header). Although no support exists on-switch to activate 
service data based on this date, some customers use it to manage their service 
data and to run network service integrity checks based on this activation date.

When uploading MCFs the activation date may or may not be displayed.

When downloading MCFs in dated mode, the activation date will be set to the 
download date. Otherwise, the activation date may be specified. If the date is 
not specified, the activation date of the uploaded MCF is propagated to the 
downloaded MCF.

Download type
There are two different download types: incremental and complete. 
Incremental download means only the MC files containing modified 
components are created. Complete download means all MC files are created.
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Opening Configuration tools

This chapter tells how to open the tools in the DPN Devices configuration 
toolset either from the command line interface, or from the Preside 
Multiservice Data Manager (MDM) window. It also describes how to use the 
common features of the tools’ graphical user interfaces (GUIs).

Command line interface
See the following sections for information on the applications that you can 
open from a UNIX command line:

• “Global Data Manager” (page 127)

• “Software Distribution” (page 179)

• “MCF Directory Merge” (page 277)

• “MCF management” (page 281)

• “Service Data Conversion” (page 207)

• “Software Substitution” (page 193)

See “Accessing UNIX” (page 53) for steps on how to get a UNIX shell. 

Opening the Configuration - DPN Devices toolset
The Preside MDM window displays all the toolsets available to you.

How to open a tool
1 Open Preside Multiservice Data Manager.

The Preside MDM window opens.
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Note:  The Toolsets icon displays the Preside Multiservice Data Manager 
(MDM) release you are running.

2 In the Preside MDM wiindow, select Configuration -> DPN Devices

The DPN Devices toolset submenu opens.

3 Select the tool that you want to use.

The tool’s main window appears. If you have not yet connected to a device 
and authenticated, the Command Console Connection Management 
window opens. See “Using the Connection Manager” (page 51) for more 
information.

Connection Manager authentication
The Connection Manager (CM) is a server process residing on the Preside 
Multiservice Data Manager (MDM) workstation used to manage all the 
network connections originated for your logon session. The CM dialog is 
displayed when any of the user interface tools are accessed.

Manual access mode allows the user to invoke a provisioning agent on the 
packet module manually using the console call operator command. See 
241-1001-303 DPN-100 Operator Commands and Responses - Volume 1. 

Manual access mode is only available in the Component Provisioning, 
Envelope Editor and Service Data Conversion tools. 

If Manual Access Mode is not selected, the application will automatically set 
up a connection to the packet module after the destination, user id and 
password are provided.

Connection Management dialogs
The three dialogs described in the following sections are associated with 
connection management:

• “Command Console Connection dialog” (page 49)

• “Data Viewer Connection dialog” (page 50)

• “Authentication dialog” (page 50)
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Command Console Connection dialog
The Command Console Connection dialog allows you to Connect or 
Disconnect a network destination. It provides the following options:

• Server Host this field displays the DPN and Passport server host names. 
All network communications are performed through these hosts. 

• Destination List lists all of the network destinations which are available 
from the current server hosts. The destination is either a destination 
mnemonic name for the DPN network or a GROUP name for the 
Passport network. Select a destination to set the destination field and 
populate the User Id list. Double click on the Destination list to select the 
destination and perform the default action (you must first supply a user 
id and password). The state is "CONNECTED" if any active connections 
exist to the destination. The state is "AUTHENTICATED" if any 
authentication data is available for the destination. 

• Destination Buttons allows you to hide/show the DPN or Passport 
destinations. 

• User Id List lists all previously authenticated user ids associated with the 
selected destination. It allows you to re-use authentication data. Select a 
user id to set the User Id and Password fields. Double click on the user id 
to set the User Id and Password fields and perform the default action. 

• Destination you can manually enter the destination into this field or 
select one from the Destination list. 

• User Id you can manually enter the User Id into this field or select one 
from the User Id list. 

• Password you can manually enter the Password into this field or select 
one along with a User Id from the User Id list. 

• Message displays messages related to the current request. 

• Connect connects to the selected destination. 

• Disconnect disconnects from the selected destination. 

• Close closes the dialog without performing any action. 
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Data Viewer Connection dialog
The Data Viewer Connection dialog allows you to Connect to a Passport 
group. It provides the following options:

• Server Host displays the Passport server host name. All network 
communications are performed through this host. 

• Destination List lists all of the Passport groups which are available from 
the current server host. Select a destination to set the destination field and 
populate the User Id list. Double click on the Destination list to connect 
to it (you must first supply a user id and password). The state is 
"CONNECTED" if any active connections exist to the destination. The 
state is "AUTHENTICATED" if any authentication data is available for 
the destination. 

• User Id List lists all previously authenticated user ids associated with the 
selected destination. It allows you to re-use authentication data. Select a 
user id to set the User Id and Password fields. Double click on the user id 
to set the User Id and Password fields and connect. 

• Destination you can manually enter the destination into this field or 
select one from the Destination list. 

• User Id you can manually enter the User Id into this field or select one 
from the User Id List. 

• Password you can manually enter the Password into this field or select 
one along with a User Id from the User Id list. 

• Message displays messages related to the current connection request. 

• Connect connects to the selected destination. 

• Cancel closes the dialog without performing a Connection request. 

Authentication dialog
The Authentication Dialog allows you to log on to a network destination, with 
your User ID and Password. This dialog provides the following information: 

• Server Host displays the server host name. All network communications 
are performed through this host. 

• Destination List lists all the network destinations which are available 
from the current server host. The destination is either a destination 
mnemonic name for the DPN network or a GROUP name for the 
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Passport network. Select a destination to set the destination field and 
populate the User Id list. Double click on the Destination list to set the 
destination and perform the authentication (you must first supply a user 
id and password). The destination state is "AUTHENTICATED" if 
authentication data is available for the destination. 

• User Id List lists all previously authenticated user ids associated with the 
selected destination. It allows you to re-use authentication data. Select a 
user id to set the User Id and Password fields. Double click on the user id 
to set the User Id and Password fields and perform the authentication 
action. 

• Destination allows you to manually enter the destination into this field or 
select one from the Destination list. 

• User Id allows you to manually enter the User Id into this field or select 
one from the User Id List. 

• Password allows you to manually enter the Password into this field or 
select one along with a User Id from the User Id list. 

• CM Manual Mode allows you to toggle the Manual Mode operation 
selection during Authentication of some DPN Devices configuration 
tools. 

• Message displays messages related to the current authentication request. 

• Authenticate performs the authentication. The dialog closes upon 
successful completion. Otherwise, an error message is displayed in the 
Message area. You can choose to alter parameters and try again or to 
cancel the request. 

• Cancel closes the dialog without performing an authentication request. 

Using the Connection Manager
1 From the DPN Devices toolset submenu, choose the tool you wish to run.

The Command Console Connection Management dialog opens
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2 Enter the Destination manually or select one from the Destination List.

The selected destination is displayed in the Destination area.

3 Enter the User Id and Password.

4 Click on the Manual Access Mode box if manual access mode is required.

For information on manual access mode, see “Manual access mode” 
(page 41).

5 Click Authenticate or hit the Return key.

If the authentication fails, an error message is displayed. Otherwise, the 
Command Console Connection Management dialog is closed and the 
main window of the tool is displayed.

If Cancel is selected, a warning message is displayed asking if you want 
to continue with the session. If Yes is selected, the CM dialog is displayed 
again and the authentication information can be entered. If No is selected, 
the application session will be terminated.
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Re-authentication
Re-authentication allows you to access PMs controlled by different OAs 
without having to restart the tool. It also allows you to switch between manual 
and automatic access mode. Re-authentication is available in the following 
tools:

• Component Provisioning

• Envelope Editor

• Service Data Backup

• Service Data Restore

• Global Data Manager

• Software Distribution

• Service Data Conversion

How to re-authenticate from within a tool
1 From the Security... menu in the title bar of the tool window, choose 

Authenticate.

The Command Console Connection Management dialog is displayed.

2 Follow the steps in “Using the Connection Manager” (page 51).

How to close a tool
The tool is closed by selecting Exit from the title bar menu.

1 From the File menu in the title bar choose Exit. 

The tool’s main window closes.

Accessing UNIX
The following procedure is common for all command line interface 
applications. 

How to access UNIX
1 In the Preside MDM window, select System -> Utilities -> UNIX Access

A window outline appears. The outline represents the outline of the UNIX 
window.

2 Drag the pointer to where you want the window to appear, then click 
select.
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The tool’s main window appears.

See 241-6001-802 Preside MDM User Interface Primer for more information 
about the Preside Multiservice Data Manager (MDM) workstation interface.

Common GUI functions
The Preside Multiservice Data Manager (MDM) tools have dialogs with pull-
down menuswith common or similar functions. These include:

• “File menu” (page 54)

• “Options menu” (page 54)

• “Security menu” (page 55)

• “Help menu” (page 55)

• “Working dialog” (page 57)

• “Error dialog” (page 57)

• “Help on Keys” (page 58)

• “Confirmation dialog” (page 57)

• “Message area” (page 58)

File menu
The Options menu contains the following commands:

• Log to File... allows you to specify a log file. 

• Stop logging stops recording output from the tool in the log file.

• Exit closes the Preside Multiservice Data Manager (MDM) tool.

Options menu
Run Command File pops up the Command File dialog, allowing you to enter 
a command file, and then performs the operation based on the information in 
the command file. 

Command File dialog
This dialog lets you enter the name of the command file that you wish to use. 
You can enter the file name directly into the Command file data entry field, or 
you can use the Directories and Files lists to find the desired command file. 
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The dialog initially appears with $HOME/MagellanNMS entered. To change 
directories, either select a directory from the Directories list and then select 
the Change Directory button, or double click the directory in the list. You can 
navigate the directory tree by successively moving through directories in the 
list. 

Once you are in the correct directory, the command file can be chosen either 
by selecting the command file in the Files list and then selecting the Run 
Command File button, or by double clicking the command file in the list. The 
Command File dialog provides the following items:

• Command File field allows you to enter the required information in order 
to run an Preside Multiservice Data Manager (MDM) tool’s command 
file

• Run Command File button uses the command file in the data entry field 
to control the tool’s operation. 

• Change Directory button moves from the current directory to the 
directory selected in the Directories list. 

• Cancel button ignores any changes made in this dialog since it was 
popped up and returns to the tool’s main window.

 

Security menu
Authenticate... opens the Connection Manager window. See also “Connection 
Management dialogs” (page 48).

Help menu
This tool supports context-sensitive help in the main window. Pressing the 
Context Help button changes the mouse cursor into a question mark (?). Drag 
the cursor to the component for which you want help and press the Select 
mouse button. 

All pop-up dialogs also have a Help button.

Log file
A log file contains processing and error messages that are produced by the 
application you are running. Logging can be enabled by means of the 
graphical user interface (GUI), command line, and command file. 
Preside MDM Configuration Management for DPN User Guide   14.3RSUP



56   Chapter 3 Opening Configuration tools
If you want to use a log file through the GUI, you must enable the Log to File 
option from the File menu in the title bar. The application also provides the 
option of writing to a log file by means of the -log option in the command line 
or the command file. If this is chosen, output is directed to the log file as well 
as to stdout/stderr. The same messages appear in both. 

By default, the applications send error messages to stderr, and other messages 
to stdout. This allows you to redirect output as necessary. 

If two or more applications are running concurrently, the log file may be 
locked by the application. The applications will wait until the log file is 
unlocked. For more information about log files specific to a tool, refer to the 
individual tool chapters. 

Logging is supported by the following applications: 

• Global Data Manager

• Software Distribution

• Master Configuration File Merge

• Service Data Conversion

• Software Substitution

Log File dialog
This dialog lets you enter the name of the log file you wish to use. The file 
name can be entered directly into the Log file data entry field, or the 
Directories and Files lists can be used to find the desired log file. 

The dialog initially appears with $HOME/MagellanNMS entered. To change 
directories, either select a directory from the Directories list and then select 
the Change Directory button, or double click the directory in the list. You can 
navigate a directory tree by successively moving through directories in the 
list. 
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Once you are in the correct directory, the log file can be chosen either by 
selecting the log file in the Files list and then selecting the Log to File button, 
or by double clicking the log file in the list. The Log File dialog provides the 
following commands:

• Log to File uses the log file in the data entry field to record the messages 
generated by the tool. 

• Change Directory moves from the current directory to the directory 
selected in the Directories list. 

• Cancel ignores any changes made in this dialog since it was opened and 
returns you to the tool’s main window. 

Processing dialog
This dialog appears when the tool begins replacing service data. The dialog 
closes when the replacement process is completed. To stop the replacement 
process before it completes, select the Stop button in the dialog. 

Note that if processing is stopped while a download is in progress, the 
download will be completed before the tool terminates. 

Working dialog
This dialog appears when the tool begins performing its function. The dialog 
window closes when the operation is completed. To stop the operation before 
it is completed, select the Stop button in the dialog. 

Error dialog
This dialog appears when a serious error has occurred. 

In the case of a communication error, the Preside Multiservice Data Manager 
(MDM) tool cannot establish contact with the Connection Manager. Restart 
the tool and if the problem persists report it to the System Administrator. 

Confirmation dialog
The tool cannot communicate with the network until authentication is 
successful. Select the Authenticate button to retry authentication. 
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If the OK button is selected, the tool will remain active but all functions used 
during the normal interaction with the network will be disabled. 

Message area
All errors, warnings, and status messages generated by the Preside 
Multiservice Data Manager (MDM) tool in the course of its operations appear 
in this area. The text field is scrollable so you can read previous messages 
using the scroll bar. 

Verbose
The Verbose button either expands or collapses the amount of data that is 
displayed. Select this button when the expanded display of the tool’s actions 
is required. Deselect this button when detailed display of the tool’s actions is 
not required.

Log Error dialog
You must specify a valid UNIX file name as the log file. 

Command Error dialog
You need to specify an existing UNIX file name as the command file. 

Transaction Error dialog
You need to specify an existing UNIX file name as the Routing Data 
Transaction file. 

Help on Keys
The keyboard can be used instead of the mouse to perform the default action 
in a dialog, select a menu item, or execute a command by using an accelerator. 

Performing the default action
Dialogs have a default action button, which can be distinguished from other 
buttons in the dialog by the highlight box around it. The default action is 
performed when the Return key is pressed while keyboard focus is in the 
dialog. 
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Menu items
Mnemonics are single characters that uniquely identify a particular menu 
item. Mnemonics can be used to perform any function on the menu bar. The 
single character that selects a given menu item is shown by an underscore 
under that letter in the name of the menu item. 

Mnemonics can be used by pressing the F10 key, entering the mnemonic for 
the menu, and then entering the mnemonic for the entry you want to use; or 
by pressing the meta key with the mnemonic for the menu you want to access, 
followed by the mnemonic for the specific menu item. 

For example, to use the Authenticate (mnemonic A) item in the Security 
(mnemonic S) menu, use either of the following key sequences: 

• F10 S A 

• META+S A

 

Command accelerators
The Preside Multiservice Data Manager (MDM) tool provides the following 
accelerators: 

• Ctrl+E exits from the tool. 

• Shift+Help changes the cursor into a question-mark-shaped pointer. 
Specific context-sensitive help for a window object may be accessed by 
placing the cursor over the object and pressing Select. 

Other GUI functions
Consult the individual tool descriptions for details on functions that are 
specific to particular tools.
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Component Provisioning

The Component Provisioning tool is used to modify, view, or verify service 
data that resides in a DPN network.

The Component Provisioning tool allows you to perform the following tasks:.

• Check data entry semantics

See “Type of service data checked” (page 63)

• Verify the sanity of service data at the module level

See “Module-level semantic checks” (page 64)

• Edit or view service data

See “Modified Components area” (page 75)

• Verify the sanity of service data

See “Verifying service data” (page 85)

• Access and navigate through the service data hierarchy

See “Viewing service data” (page 86)

• Manage several service data views, including the committed and 
activated view

See “Viewing service data” (page 86)
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• Manipulate service data components

See “Manipulating service data components” (page 86)

• Download edited service data

See “Downloading service data” (page 90)

• Generate service data reports

See “Generating reports for service data” (page 95)

• Create and manipulate service data templates

See “Templates” (page 98)

• Set user preferences

See “User preferences” (page 114)

• Perform module integrity checks

See “Module integrity checks” (page 121)

• Duplicate service data changes in a module

See “Using the Propagate command” (page 121)

• Broadcast service data status to other applications

See “Working with Context” (page 125)

Note: An MCF must be converted to the latest service data level before 
trying to modify the MCF using Component Provisioning. If the MCF is 
not at the latest level, an error message is generated. See “Service Data 
Conversion” (page 207) for more information on how to convert service 
data.
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Semantic Checks
Module-wide service data semantic checks are performed at different levels 
and at various times during a Component Provisioning session to ensure 
service data validity and integrity. Semantic checks are executed as soon as 
possible to provide timely feedback.

Semantic errors can be indicated by messages or background colors.

Note: When defining any PM mnemonic, do not use a hyphen (-) in the 
name. Such mnemonics would be copied incorrectly to other modules, 
causing the provisioning to fail. Underscores (_) however, are acceptable

Type of service data checked
Semantic checks are performed on the following service data:

Field range
Each service data field is validated for a valid range and data type. For certain 
types of data representations in the user interface, the range validation is 
automatic, for example, check boxes and buttons. For data entry fields the 
range is validated with each key stroke and an X icon is displayed to the left 
of a field to indicate when an error has been detected.

Intra-envelope semantics
Service data checks that involve data fields within the same service data 
envelope (that is, the same screen) are performed when Verify or Verify and 
Save are selected. Errors and warnings are displayed immediately in the 
Messages area of the dialog. All errors must be corrected before it is possible 
to close the edit dialog. See “Verifying service data” (page 85).

Mandatory component limits
Mandatory subcomponents are automatically presented in a serial manner 
when a component is added. While cutting or deleting a mandatory 
component is allowed, a download will not be successful unless the 
component is present. The limit on the maximum number of components is 
enforced during the add operation of the component. To find out more about 
mandatory components, see the component hierarchy section in the service 
specific documents. For a list of service specific documents, see 
“Provisioning specific services” (page 35).
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Inter-component semantics
Checking is not always performed immediately because of lengthy response 
times due to a complex semantic or when dependent fields from other edit 
forms have not been entered yet. In these cases, data semantic checks 
involving data fields from various envelopes are not performed until the 
service data is downloaded. All errors and warnings are displayed in the 
Download Message dialog during a download. Text can be copied from the 
Messages area and pasted into another location. See “Module integrity 
checks” (page 121).

Network-wide semantic checks
In addition to the module-wide data entry semantics provided by DPN 
Devices configuration network-wide level of check can also performed by 
NRS-Based Service Integrity Checker (NSIC). For more information on 
NSIC, see 241-6001-022 Preside MDM Network Reporting System User 
Guide.

Module-level semantic checks
Module-level semantic checks can be run on components before downloading 
the changes. This can be a lengthy process if there are several levels of service 
data under the selected component, for example, if the selected component is 
the packet module (PM). See “How to perform a Module-level semantic 
check” (page 64).

Semantic Check Message dialog
A semantic-check message dialog displays messages generated during the 
semantic check of service data. The error message can be copied and pasted 
to another window. Click OK to dismiss the dialog.

How to perform a Module-level semantic check
1 Upload the packet module and make any necessary changes.

2 Select the subcomponent in the Subcomponent area.

3 Press the mouse menu button in the Subcomponent area and choose 
Check Semantic.

Errors and warnings are displayed in the Semantic Check Message 
dialog.

4 Click OK to close the dialog.
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Figure 2
Component Provisioning main window

Component Provisioning main window
The Component Provisioning main window contains the following functional 
areas, which are shown in the figure “Component Provisioning main 
window” (page 65):

• “Menu Bar” (page 66)

• “Component area” (page 67)
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• “Subcomponents area” (page 71)

• “Modified Components area” (page 75)

• “Messages area” (page 76)

Menu Bar
The menu bar is located at the top of the provisioning tool window. Within the 
menu bar are File, Options, Security and Help pull-down menu buttons.

• The File menu provides actions to clear module data, stop module 
logging, download service data and exit the tool. See “File menu” 
(page 66).

• The Options menu is located next to the File menu. The menu contains 
the following options: Change Upload Preferences, Change Download 
Preferences, Change Template Preferences, and Save Preferences. 
See“Options menu” (page 67).

• The Security menu is located next to the Options menu. The Security 
menu contains the Authenticate command. See “Security menu” 
(page 55).

File menu
The File menu provides access to commands used to clear all module data, 
stop module logging, download module data, and exit the tool: 

• Clear All Module Data discards all current working data for the current 
view. Any changes not downloaded will be lost. However if any changes 
have been made, a confirmation dialog will appear before the actual 
command is performed. 

• Stop Module Logging stops the propagation logging of provisioning 
actions into a file. The logging is started if Propagation Logging is 
selected in the Upload Preferences dialog. 

• Download downloads all service data to the location specified in the 
Download Preferences dialog. Module data will be cleared from the tool 
after a successful download. 

• Exit exits the Component Provisioning session. 
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Options menu
The Options menu provides access to commands used to manipulate user 
option preferences. The commands available are: 

• Change Upload Preferences… displays a dialog which allows the 
manipulation of user preferences related to the uploading of MCFs. For 
example you can specify that the active MCF from the default PM should 
always be uploaded, regardless of the PM entered. See “Upload 
preferences” (page 115).

• Change Download Preferences… displays a dialog which allows the 
manipulation of user preferences related to the downloading of MCFs. 
For example you can specify that prior to downloading an MCF, you 
should be presented with a confirmation dialog. See “Download 
preferences” (page 118).

• Change Template Preferences… displays a dialog which allows the 
manipulation of user preferences for the loading and deletion of 
templates. For example, you can specify that prior to deleting a template, 
you should be presented with a confirmation dialog. See “Template 
preferences” (page 99).

• Change Custom Form Preferences… displays a dialog that allows you to 
customize the user preferences for custom form selection. For example, 
you can specify workstation custom forms, user custom forms, or both. 
See “Custom form preferences” (page 113).

• Save Preferences saves the current user preferences to the file /<x>/
MagellanNMS/ProvisioningUser.cfg, where <x> is the user's home 
directory. 

Security menu
See “Security menu” (page 55) for details.

Help menu
See “Help menu” (page 55) for details.

Component area
The Component area, located just below the menu bar, displays a Mode 
option button, a Component data entry field and an Expand push-button. The 
Mode menu button selects whether you can change (Edit) or display (View) 
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the components. Use the Component data entry field to specify the component 
you wish to work with. Components are identified by the component name 
followed by a "/" and the component value. Several hierarchical components 
may be specified at one time. The Expand button expands the component you 
have entered by listing all subcomponents in the Subcomponent area. 

Mode option button
The Mode option button in the main window allows you to change the mode 
of a provisioning session to one of the following:

• Edit allows changes to the service data and downloading the modified 
view. When the Edit mode is selected, all modification commands are 
enabled. The modification commands are: Edit, Add, Cut, Delete, and 
Paste.

• View only allows you to view the service data, copy desired components, 
create templates, and generate service data reports. No service data 
modifications or downloads can be performed in this mode.

Note: If an attempt is made to change the Mode during a provisioning 
session, a dialog will be displayed asking the user to confirm the mode 
change. If Yes is selected, the uploaded provisioning data will be cleared 
regardless of any possible changes made to the current view.

Component data entry field
This field specifies the component with which you wish to work. The 
components are identified by a component name followed by a '/' followed by 
a component value. Several hierarchical components may be specified at one 
time. For example, PM/abcd PE/1 PI/1 PO/1 would identify port 1 on PI 
1 for a module with a mnemonic of 'abcd'. 

To display the component data entry pop-up menu, position the mouse pointer 
in the component data entry field and press the right mouse button. The 
following commands are available:

• Edit… creates an Edit area for the currently selected component. More 
than one Edit area can exist simultaneously. 

• View… creates an edit area for viewing service data. All editing 
commands that are common to the Edit area are disabled when the view 
command is invoked. 
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• Cut Component removes the selected service data component and places 
it in a cut/copy area. This only operates on components below the PM 
level. 

• Copy Component copies this component and all levels of subcomponents 
below it into a copy area. 

• Paste Component adds the last copied or cut components below the 
currently selected component, if appropriate. See also “Paste 
Component” (page 69).

• Delete Component deletes a component, such as PEs, PIs, POs and 
envelopes from the service data when selected. 

• Add… adds a component to the service data instance hierarchy. You can 
add a component that is a subcomponent of the selected component. 

• Add without Forms… is not applicable for DPN.

• Create module creates a new view of the specified module. Edit forms for 
all mandatory subcomponents are displayed. 

• Expand all displays all levels of subcomponents below the selected 
component. 

• Put context generates a component name and sets a Network Model 
context for another application based on the current component name. 

• Get context sets the current component name based on the current DPN 
Network Model context. 

• Cut, Copy, Paste, Delete, Select All, Deselect All are standard commands 
that enable you to manipulate the contents of data entry fields.

Paste Component 
The Paste component cascading menu is used to paste the last cut or copied 
component below the current component in the service data hierarchy. The 
component can be pasted as is (when doing a move) or with different keys 
(when copying an existing component). 

Change keys changes the key values. As the pasting operation proceeds, all 
components that have key values have a dialog displayed for them. The key 
value can be changed at this time. Examples of key values are the cug index 
for a CUG or the port number for a port (PO). 
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Use existing keys uses the existing key values, therefore, no prompts for key 
values appear. If duplications are encountered the paste operation aborts. 

Create module 
The Create module command creates essential components, known as 
mandatory components that are necessary for each module. 

How to create a module

1 Enter the name of the new module in the Component area.

2 Press the mouse menu button in the Component area and choose Create 
module....

Dialogs appear sequentially, prompting you for mandatory information for 
the new module. This new information is displayed in the Modified 
components area. 

3 To display the subcomponents of the module, select the module and 
choose Expand from the Subcomponents menu.

Expand button
The Expand button takes the specified component in the Component area and 
displays all its subcomponents in the Subcomponents area. 

Specifying a component
The Component area of the Component Provisioning tool is used to specify 
an existing DPN-100 module component and optionally subcomponents. 

How to specify a component in the component area
1 Click select in the Component area. 

2 Enter the component name. 

When specifying a component the proper prefixes and syntax must be 
used. PM/<module_name> identifies the packet module, PE/<#> 
identifies the PE number, PI/<#> identifies the PI number and PO/<#> 
identifies the port number.

3 Press Return or click Expand.

When Return or Expand is selected, the system attempts to upload the 
bundle. If Return is selected, the module will not appear expanded in the 
Subcomponents area. If the upload fails, an error message is displayed in 
the Messages area.
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Note:  Once the operation is selected, a dialog may appear requesting 
either Bundle, NAMS ID, or Location for a particular view of service data, 
or any combination of the options depending on the upload user 
preferences selected. 

4 Enter the Bundle, Namsid, and Location.

5 Click OK.

The tool establishes a call to the selected DPN-100 module and accesses 
service data for the selected component.

Question dialog
This dialog presents a question, which may contain several lines of scrollable 
text. The text can be copied and pasted to another window. The Yes button 
answers the question in the affirmative and action will be taken in the context 
of the question. The No button answers in the negative. 

Error dialog
This error dialog presents error messages to the user. Each message may 
contain several lines of text which can be scrolled. The text can be copied and 
pasted to another window. The OK key acknowledges the error dialog. 

Subcomponents area
The Subcomponents area, located just below the Component area, consists of 
a multiple-line display. You can use this area to view and manipulate the 
subcomponents of the component listed in the Component area. This area 
graphically displays the structure of service data. It can be a valuable aid in 
locating unfamiliar service data.

Components with attribute/key values that must be available or unique 
throughout the entire network (i.e., network-wide data) have a small icon to 
their left.

Initially, the components displayed in the Subcomponents area all have the 
standard background color. When you check for semantic errors, the 
background color changes for each component with an ErrorState of “error” 
or “warning”. “Error” means that major errors are present and the service data 
cannot be activated. “Warning” means that a configuration problem exists. 
With a warning, you can still activate the service data but it may cause 
problems with the switch.
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See also “Using the Subcomponents menu” (page 72).

Using the Subcomponents menu
To display the subcomponent pop-up menu, position the mouse pointer on the 
desired subcomponent data and press the right mouse button. The following 
commands are available:

• Edit… creates an Edit area for the currently selected component. More 
than one Edit area can exist simultaneously. 

• View… creates an edit area for viewing service data. All editing 
commands that are common to the Edit area are disabled when the View 
command is invoked. 

• Cut Component removes the selected service data component and places 
it in a cut/copy area. This only operates on service data components 
below the PM level. 

• Copy Component for the selected component, copies all levels of 
subcomponents and the service data for these subcomponents into a copy 
area. 

• Paste Component adds the last copied or cut components below the 
currently selected component, if appropriate. See also “Paste 
Component” (page 69).

• Delete Component deletes a component, such as PEs, PIs, POs and 
envelopes, from the service data when selected. 

• Add… adds a component to the service data instance hierarchy. You can 
add a component that is a subcomponent of the selected component. 

• Add without forms… is not applicable for DPN.

• Expand displays one level of subcomponent below the selected 
component. 

• Expand all displays all levels of subcomponents existing below the 
selected component. 

• Compress removes displayed subcomponents of the selected component 
from the Subcomponents area. Note: Components are not deleted, just 
hidden from view. 
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• Put context generates a component name and sets a DPN Network Model 
context for another application based on the current component name. 

• Report… invokes the Service Data Reporting function on the selected 
component and visible subcomponents. 

• Templates provides a means to save and reuse portions of service data. 
The commands in the Templates cascade menu are as follows:

— Create… copies the service data into a user specified file for use at 
a later time. 

— Delete Component erases the specified service data template file. 
The templates for deletion appear within the cascade menu. 

— Use – with forms sequentially displays all editing forms for all 
components contained in the template. The usable templates appear 
within the cascade menu. 

— Use – without forms adds the service data, but does not display 
forms. The usable templates appear within the cascade menu. 

See also “Templates” (page 98).

• Custom Forms allows you to create, change, and delete custom forms. 
The commands in the Custom Forms cascade menu are as follows:

— Create opens the Form Editor with the default form for the specified 
component. You can save the custom form as a workstation custom 
form that is accessible to all users of a workstation; or, you can save 
the custom form as a user custom form that is accessible to an 
individual user.

— Change edits an existing workstation or user custom form for a 
specified component. There are two commands in the Change 
cascade menu: Workstation Custom Form edits an existing 
workstation custom form; User Custom Form edits an existing user 
custom form.

— Delete deletes an existing workstation or user custom form for the 
specified component. There are two commands in the Delete 
cascade menu: Workstation Custom Form deletes an existing 
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workstation custom form; User Custom Form deletes an existing 
user custom form.

See also “Custom Forms” (page 103).

Note: A component’s custom form can be modified by only one user at a 
time. When one user makes modifications to a components’s custom 
form, the Custom Forms command for that component is disabled to 
other users.

• Check Semantic checks for semantic errors under the selected 
component. Any semantic errors or warning will be displayed in the 
Semantic Check Message dialog. In addition to producing error and 
warning messages, the semantic check can change the background color. 
The background color of components with an ErrorState of “error” (or 
their closest displayed parent) changes to errorColor, which is set to the 
standard Preside Multiservice Data Manager (MDM) color for errors. 
The background color of components with an ErrorState of “warning” 
(or their closest displayed parent) changes to warningColor, which is set 
to the standard MDM color for warnings.

• Copy list copies the text of the subcomponents list into a buffer. You can 
now paste the list into a file. 

Expanding component levels
You can use Expand and Expand All to expand components into their 
respective subcomponents. 

Expanding from the Component area
From the Component area, you can expand a component into its 
subcomponents by using the Expand button, or by using the Expand All 
option from the component menu. When Expand all is selected, the same 
process occurs as with Expand, but all levels of components are displayed in 
the subcomponents area.

Note 1:  It is not recommended that the Expand all option be used on 
larger AM/RM modules, at the module level, as the memory and time 
required to complete this action may be excessive.

Note 2:  With both the Expand button and Expand all, any display 
currently in the subcomponents area is replaced
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Expanding from the Subcomponents area
The Expand and Expand all menu options can expand a component within the 
Subcomponents area. 

On an Expand or Expand all operation, the component and its children have 
their background colors change to show which subcomponents have an 
ErrorState of “error” or “warning”.

1 Select the component within the Subcomponents area that you want to 
expand.

2 Press the mouse menu button in the Subcomponents area and choose 
Expand or Expand all. 

Note:  Fully expanding on higher level components extracts large 
amounts of data from the module and therefore will take longer to 
process.

Compressing subcomponents levels
The Compress command in the Subcomponents menu is used to hide the 
display of subcomponents of the selected component.

On a Compress operation, the closest parent of a subcomponent with an 
ErrorState of “error” or “warning” has its background color change to show 
the existence of a subcomponent error or warning.

1 Select the component you want to compress. 

2 Press the mouse menu buttoin the Subcomponents area and choose 
Compress.

All subcomponents listed under the selected components are removed 
from the list.

Modified Components area
The Modified components area, located below the Subcomponents area, 
consists of a multiple line display field, a pop-up menu and a Download 
button. You can use the Modified components area to view new or modified 
components before you download these components. 
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The Modified Components area has a pop-up menu with the following 
options are available:

• Edit... creates an Edit area for the currently selected component. More 
than one Edit area can exist simultaneously. 

• View... creates an edit area for viewing service data. All editing 
commands that are common to the Edit area are disabled when the View 
command is invoked. 

• Copy list copies the text of the Modified components list into a buffer. 
You can now paste the list into a file. 

• Discard removes the selected item(s) from the list of changes which will 
be downloaded. Any changes made to the discarded subcomponents 
during the current provisioning session will be lost. 

• Put context generates a component name and sets a context for another 
application based on the current component name. 

Download button
The Download button downloads all modified components. This download 
button invokes the same download action as the one under the File menu. 

Messages area
The Messages area, located at the bottom the window, is used to display 
informative messages on the current status of the application. The following 
options are available: 

• Copy copies selected text to a buffer. 

• Select all selects all of the text in the message area. 

• Deselect deselects the selected text in the message area. 

Editing service data
The edit option allows you to alter service data information. Edit areas vary 
depending on the component you are editing. Several edit windows can be 
opened simultaneously for different components. The Edit command is found 
in the Component, Subcomponents, and Modified components areas. 
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Figure 3
Edit area dialog

Edit/View dialog
The Component Provisioning Edit/View dialog is used to edit, view, or verify 
service data for DPN components. The Edit/View dialog provides a scrollable 
data area which contains service parameters that relate to a component. This 
Edit/View scrollable dialog is also known as a form. If you need, you can 
concurrently display Edit/View dialogs for multiple components. 
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The display of Edit/View dialogs can be customized. For information on 
customizing the Edit/View forms used during component provisioning, see 
“Custom Forms” (page 103).

The Edit/View dialog contains a menu bar, component title, service data entry 
area, messages area, and action buttons. See the figure “Edit area dialog” 
(page 77)..hde.

See also...

• “Menu bar” (page 78)

• “Component title” (page 78)

• “Service data entry area” (page 79)

• “Messages area” (page 79)

• “Action buttons” (page 80)

• “Using the Edit/View dialog” (page 80)

Menu bar
The menu bar contains the options File, Edit, and Options. Most of the 
commands under these options are enabled only when you are working with 
custom forms. The two options that may be enabled in the Edit/View dialog 
are:

• Show hidden, under Options, which displays hidden fields in a lighter-
than-normal color.

• Revert to saved default values, under Edit, which changes the values of 
all fields in the dialog, including hidden fields, back to the saved defaults. 
Revert to saved default values is enabled only when you are using a 
custom form in the Edit/View dialog.

For information on all the menu bar options, see “Form Editor window” 
(page 105).

Component title
The component title displays the full path name of the component being 
edited or viewed, as well as the MCF bundle file name.
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Service data entry area
The service data entry area, located just below the component title, allows you 
to edit the service data, or, attribute values, for the selected component. Each 
attribute is represented by one of the following:

• Data entry field, which allows you to enter a specific value. You can 
display the valid values of a data entry field by pressing the menu button 
while the pointer is on the left arrow symbol beside the data entry field. 

• Radio button box, which allows you to turn an option on or off. 

• Check button box, which allows you to select as many options as you 
need. 

• Data entry list, which allows you to alter groups of attributes that have 
dependencies on one another. A service data entry area with a data entry 
list contains the additional buttons:

— Find finds an entry in the list with the attribute value or values that 
you specify.

— Add adds a new entry to the list. All values in the new entry need to 
be valid. If the list is sorted, the new entry is added in the correct 
location.

— Add before adds a new entry to the list before the currently selected 
list entry. If the list is sorted or of a fixed size, this button is not 
enabled. All values in the new entry need to be valid.

— Replace replaces the currently selected list entry with a new entry. 
All values in the new entry need to be valid.

For help on fields or the component, from the Help menu, select Help On 
Service Data Description. Then, select the specific field or the background. 
For help on all fields, see 241-2001-340 DPN-100 Envelope Definitions.

Messages area
The messages area, located below the service data entry area, displays 
warning and error messages for the Edit/View dialog.
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Action buttons
The action buttons, located at the bottom of the Edit/View dialog, are used to 
Verify and Save, Verify, or Cancel the service data entries. The buttons are:

• Verify and Save verifies the data first then, if correct, saves and closes the 
Edit/View dialog. 

• Verify only checks the correctness of the entered data without saving 
them, and leaves the Edit/View dialog open. 

• Cancel closes the Edit/View dialog without changing the service data, 
which reverts to the last update. For the View mode, only the Cancel 
button is enabled.

Using the Edit/View dialog
You can edit service data by following this procedure.

How to edit service data
1 Enter the component name and follow the steps in “How to specify a 

component in the component area” (page 70).

2 Select the component you want to edit.

3 Press the mouse menu button and choose Edit....

Depending on the component, one of the many possible Edit areas is 
displayed.

4 Edit the information as required. 

This is done by selecting buttons and check boxes and adding data in data 
entry fields and lists. If there is any information about which you are not 
clear, see “Help menu” (page 55).

5 Click Verify to ensure that the changes made to the service data are 
correct.

In this case the Edit window is not closed and the modified component is 
placed in the Modified components area.

6 Click Verify and Save in the edit area when you complete making changes 
to the service data.

Changes are verified and the Edit window is closed. The component is 
placed in the Modified components area of the Component Provisioning 
window. The changes can now be downloaded to the network component. 

7 To close the edit window without saving changes, click Cancel. 
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The edit window is closed with no changes made.

Data entry List
Data entry lists within an edit form allow you to make changes to groups of 
repeating fields. These lists provide an easy way to handle groups of fields 
and fields with dependencies on each other by grouping lists, data entry fields 
and action buttons in one area. 

The lists may have a different number of columns depending on the data type. 
When a data entry list has more than one column, it means that the fields in 
each column are related and one field cannot be added without adding data to 
the other fields. Each group of fields in the list has its own column, title and 
data entry field directly below the list column.

Get List dialog
Each data entry list title contains the Get list information command. This 
command is important because it will display the information that is 
particular to that list. This dialog will display the following information.

• How many items are currently in the list.

• How many items are currently selected in the list.

• The maximum number of items allowed in the list.

• If the list is a sorted list, and if so how it is being sorted.

• If the list is a fixed size list.

List Item Menu Commands
The commands that can be performed on the List are grouped in different 
areas as follows: 

• All the commands that operate only on the list portion are in the list title 
menu. 

• All the commands that need a list item to be selected are in the list item 
menu. 

• All the commands that don't need a list item to be selected are 
represented as buttons at the bottom of the List. 
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Commands are:

• Add Before Adds a new list item before the currently selected item in the 
list. All of the data entry fields must be filled in with valid values, and the 
list must not be sorted or of fixed size before this Add Before command 
will become enabled.

• Copy to entry area takes the selected command and places its values in 
the data entry fields below the list. It will not affect the current list item 
in any way. The data entry field values can then be modified and added/
replaced back into the list. 

• Delete Deletes a list item. The list must not be of fixed size for this menu 
command to be enabled. All the currently selected items in the list will 
be deleted. The only way to undo this action is to CANCEL the current 
edit form and re-edit the same component. Note: You will lose any 
previous changes made to the edit form if you select CANCEL. 

• Replace Inserts a new list item in the position of the top most currently 
selected item and deletes all currently selected items. All of the data entry 
fields must be filled in with valid values before this command will 
become enabled.

• Select all selects all list items. 

• Deselect all deselects all currently selected list items. 

List Add button
All of the data entry fields must be filled in with valid values before this Add 
button will become enabled. Then if the Add button is selected, the data from 
the data entry fields will be added to the list as a new list item. 

If the list is a sorted list the new list item will be put in the proper location 
according to the sort criteria; otherwise the list item will appear at the bottom 
of the list. After the list item has been added, the data entry fields are erased. 

List Find button
The Find button is enabled as soon as any one of the data entry fields has a 
valid value. When the button is selected, all the data entry fields with valid 
values are used as search criteria and the first list item, from the search start 
point, matching the values is selected and scrolled into view. 
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The search start point is the first item in the list, if nothing is selected; 
otherwise, the search start point is the first selected item in the list. 

Hence all list items matching the current search criteria can be found by 
repeatedly pressing this Find button.

Figure 4
Data entry list - example

The example illustrated in the figure “Data entry list - example” (page 83) 
represents just one of many possible lists.
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An error icon (X) is displayed beside the data entry fields whenever an invalid 
value is entered. However, this does not prevent you from closing the edit 
form as the data entry fields are just used for entering service data and are not 
actually service data themselves. You will loose any changes made to the 
currently displayed edit form if you select Cancel.

How to add data
The Add command adds data to the list in the correct position. If there is 
sorting associated with the list, the new list item is inserted into the list 
according to the specified sort. Otherwise, the new list item is placed at the 
bottom of the list.

1 Enter the new data in the data entry area.

The add operation will only be possible when the data is valid, as 
indicated by the enabling or disabling of the Add button.

If there is a no sorting associated with the list the Add before button will 
be enabled. Otherwise the new entry will be added to the list according to 
the specified sort.

If there is any information about which you are not clear, see “Help menu” 
(page 55).

2 Click Add.

If the data is not valid, an “X” will appear beside it. 

3 Click Verify and Save to close the dialog.

How to replace data
Data can be replaced in the list by entering new data in the data entry area as 
follows.

1 Select the data you want to replace.

The information in the list will be copied into the data entry fields below.

If there is any information about which you are not clear, see “Help menu” 
(page 55).

2 Enter the new data in the data entry area.

3 Click Replace.

The new data will appear in the list.

4 Click Verify and Save to close the dialog.
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How to find data
Existing data can be found by typing the value in one or more of the fields in 
the data entry area. If there are no matches, no selecting occurs. Each find 
must match the data in the data entry area exactly. If the list has multiple 
columns, only one of the columns must contain valid data to perform a search. 

1 Enter the data to find in the data entry field.

2 Click Find.

The Find command starts searching from the currently selected item, or 
from the top of the list if there is no selected item. The items that are 
matched are scrolled into view in the list area and are automatically 
selected.

How to delete data
Fields that have been deleted cannot be undone except by cancelling from the 
edit form. 

1 Select one or more items from the list to delete.

2 Press the mouse menu button and select Delete.

The data is removed from the list.

Verifying service data
Service data must be verified before the changes can be downloaded. 

How to verify the service data
1 Enter the component name and follow the steps in “How to specify a 

component in the component area” (page 70).

2 Select the component you want to verify the service data.

3 Press mouse menu button and select Edit....

The Edit dialog opens showing the service data for the selected 
component.

4 Click Verify or Verify and Save to return to the main window.

The sanity of the service data is verified. If the data is incorrect, an error 
is displayed in the Messages area of the Edit dialog. All errors must be 
corrected before the changes can be saved.
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Viewing service data
The View command can be selected from the Component, Subcomponents, 
and Modified components areas. When View is selected the edit area is 
displayed. This window is displayed in read-only mode and changes are not 
permitted.

How to use the View command
1 Enter the component name and follow the steps in “How to specify a 

component in the component area” (page 70).

2 Select the component you want to view.

3 Press the mouse menu button and select View.... 

The Edit/View area is displayed with the Verify and Verify and Save 
buttons deactivated.

4 Click Cancel to close the dialog.

Manipulating service data components
Components in the provisioning tool are distinct entities and can be added, 
deleted, cut, copied, and pasted. The difference between cutting and deleting 
is that when a component is cut the text is removed from its original location 
but remains in the copy buffer so that it can be pasted later. When a 
component is deleted it is not placed in a buffer and therefore cannot be 
retrieved.

Add windows
An add window allows the creation of new subcomponents. One of the 
components displayed may be selected. Depending on the component 
selected, one or more windows will subsequently be displayed. These will be 
either KEY windows or EDIT windows, depending on the type of component 
being added. 

The action buttons at the bottom of an Add window are: 

• OK Select this button after the desired component has been selected from 
the list. One or more dialogs are displayed to allow entry of the necessary 
service parameters for the component. 

• Cancel exits the current window without adding the component. 
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Adding a component
A component can be added from either the Component or Subcomponents 
area. 

How to add a new component
1 Select the component to which the subcomponents will be added.

2 Press the mouse menu button in the Component or Subcomponents area 
and choose Add...

The Add dialog is displayed containing all of the subcomponents which 
can be added. Some of the items may be grayed out indicating that they 
are already present. The mandatory components are automatically added 
to the selected component.

3 Select the appropriate button and click OK.

During the add operation, you may be presented with a series of key and 
edit dialogs. You must supply the appropriate information for these dialogs 
to complete the add operation.

Deleting a component
A component can be deleted from the Subcomponents or Component area.

1 Enter the component name and follow the steps in “How to specify a 
component in the component area” (page 70).

2 Select the component you want to delete.

3 Press the mouse menu button in the Component or Subcomponents area 
and choose Delete Component. 

The deleted component and all of its subcomponents are removed from 
the display. The modified component appears in the Modified components 
area ready to be downloaded. 

Cutting a component
The Cut Component command is used to remove (in fact, delete service data) 
the selected component and all of its subcomponents. The component and 
subcomponents that are cut are placed in the paste buffer.

1 Enter the component name and follow the steps in “How to specify a 
component in the component area” (page 70).

2 Select the component you want to cut.
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3 Press the mouse menu button in the Component or Subcomponents area 
and choose Cut Component. 

The component and subcomponent that are cut are removed from the 
Subcomponents area if they were visible. The parent of the cut 
component is displayed in the Modified components area.

Copying a component
The Copy Component command is used to place the selected component and 
all of its subcomponents in the paste buffer.

1 Enter the component name and follow the steps in “How to specify a 
component in the component area” (page 70).

2 Select the component you want to copy.

3 Press the mouse menu button in the Component or Subcomponents area 
and choose Copy Component. 

Note:  There are no changes to the existing component.

Pasting a component
The Paste Component command is used to add the component in the paste 
buffer to the selected component. The Paste Component command has a pull-
down menu that provides the following options:

• Use Existing Keys - The component and its subcomponents as they exist 
in the paste area are added. This is normally used for moving a 
component from one location to another. For example, PE, PI, or PO, to 
another. 

• Change Keys - Prompts for the keys of all components and 
subcomponents. This is normally used for creating new components 
similar to existing components but with different keys.

There is only one paste buffer for each user. When a component is cut or 
copied, the entire paste buffer is over-written with the new component. The 
paste buffer is shared between the Component Provisioning tool instances and 
thus the cut/copy/paste component operations are supported between 
Component Provisioning tool instances for the same user. The Paste 
Component operation, prior to pasting, checks if the component being pasted 
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is valid in the hierarchy. If the component is not valid, then the operation is 
terminated with an error message. For example, a port cannot be pasted under 
a PE, or an ITI DC cannot be pasted to an X.25 service.

Component Provisioning will prompt for key fields when pasting direct call 
or permanent virtual circuit (PVC) components if the Change Keys option has 
been selected. Services that are not supported by Component Provisioning are 
not prompted for during a paste operation. See “Component Provisioning 
paste keys” (page 315) for a list of services and key fields that are prompted 
for during a paste operation.

The component from the paste buffer can be repeatedly pasted because the 
content of the paste buffer is not altered with the paste component operation.

How to use the Paste component command
1 Enter the component name and follow the steps in “How to specify a 

component in the component area” (page 70).

2 Select the component you want to paste under.

3 Press the mouse menu button in the Component or Subcomponents area 
and choose Existing Keys or Change Keys from the Paste Component 
pull-down menu. 

Use Existing Keys from the menu to paste the component with the same 
keys as in the paste area, or use Change Keys from the menu to paste a 
component with user selected keys. If you have chosen the Change keys 
option, you will be prompted for keys for all components in the paste area 
in a series of separate dialogs.

4 Enter the appropriate key and click OK.

The component and subcomponents pasted are displayed in both the 
Subcomponents and Modified component area.

Discarding modified components
The Discard command from the Modified components area menu is used to 
discard changes that were made to a component that is now listed in the 
Modified components area. The discard operation is hierarchical.

How to use the Discard command
1 From the Modified components area, select the component you want to 

discard. 
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2 Press the mouse menu button in the Modified components area and 
choose Discard.

The component is removed from the list of components in the Modified 
components area. All changes that were made to the component during 
the current session are lost. The component remains as it was when the 
session was started.

Downloading service data
After you have edited a subcomponent using the edit area, the change is 
placed in the Modified components area. Changes do not affect the module 
until they are downloaded.

Note 1:  Downloading the changes to the individual subcomponent of a 
module is not permitted.

Note 2:  If a download fails because the VC between the Preside 
Multiservice Data Manager (MDM) workstation and the module is 
broken, you will be informed of the situation. You then have two choices: 
download the updated service data to an alternate location, NMS disk or 
another module; or attempt the download again after the problem with 
the module VC is fixed. In this situation, the system establishes the VC 
and downloads the updated service data.

Download button
Download all service data to the location specified in the Download 
Preferences dialog. Module data will be cleared from the tool after a 
successful download. The download button invokes the same download 
action as the command under the File menu.

Download Message dialog
This dialog displays messages generated during the downloading of service 
data. The messages may be errors, warnings, or informational messages. 
Errors must be corrected before a download will succeed. If there are no 
errors, the service data is downloaded and any warnings or informational 
messages are returned once the download is complete. Click the appropriate 
button to dismiss the dialog:

• Select all selects all of the text in the message area. 

• Deselect deselects the selected text in the message area. 
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• Copy copies selected text to a cut buffer. 

User Specified dialog
This dialog is presented when uploading or downloading an MCF. You 
specify the name of the MCF and this information is then used to search for 
or create an MCF. The format of an MCF is MC.<bundle>.<namsid>.0. 

Some combination of the following fields or buttons will be present on the 
dialog: 

• Bundle indicates the bundle of the MCF. 

• Namsid indicates the namsid of the MCF. 

• Location indicates the NCS mnemonic of the PM to access. This may 
include NCS routing information. For example, to upload from NY1-
AM10 you may need to enter NY1-AM10, SUP NY1-AM10, or TOR5 
MON1 NY1-AM10. (Note that dashes ('-') are changed to spaces (' ') 
before calling NCS.) 

• OK proceeds with the operation. 

• Cancel cancels the operation. 

How to download changed service data
To download changes to a specific DPN-100 module, perform the following 
steps:

1 From the File menu choose Download or click Download on the main 
window. 

The changes located in the Modified components area are downloaded 
to the DPN-100 module.

Note:  There are two download types, incremental and complete. If a 
complete download fails, re-attempting with an incremental download is 
not possible.
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Figure 5
Service data reporting dialog

Service Data Reports
The Report command allows you to quickly select specific service data that 
is displayed in the Reporting dialog and to send it to a printer or disk. The 
feature also has filtering capabilities to extract particular subsets of service 
data. A knowledge of UNIX regular expressions is required to use this 
capability. See “Generating reports for service data” (page 95) for the 
procedure.
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The Service Data Reporting dialog is illustrated in the figure “Service data 
reporting dialog” (page 92). The dialog consists of a title, service data list, 
Filter text field and Filter button, and a Display button. These items are as 
follows:

• Title displays the title of the report. This field is initially set to the first 
component of the report. It can be changed to any text label, and will 
appear at the top of each page on a printout and the top of the file of a 
saved file.

• Service data list displays the actual components and its fields. The list 
has a menu. The commands in the menu operate on the text in the list. 
There must be text in the list for the majority of the commands to be 
active. Some of the commands work only on selected text (for example. 
Delete) and will be disabled if there are no selected lines of text. 

• Filter text field accepts text which will be interpreted according to the 
regular expression syntax of the UNIX editor ed. A blank screen as the 
result of a filter operation means that there were no matches. At this point 
perform an undo and try a different filter. 

• Filter button applies the text in the adjoining field as a filter to the service 
data in the list. 

For example, typing "DNA" in the filter data entry field then clicking the 
Filter button. If the display is All fields, every component with the string 
"DNA" as part of the component name, or part of any of its field, is 
displayed. All other components are removed from the list. If the display 
is Components, every component with the string "DNA" as part of the 
component name, and only those fields that had DNA as a part of the 
field, label, or value, is displayed. 

• Display option allows two types of display: Components and All fields. 

— Components: no fields are displayed, unless a filter is applied. 
Switching to Components from All fields will always remove all the 
fields. Performing an Undo will also remove any fields placed on the 
screen by a filter. 

Note: This display hides the fields, it does not remove the field data. 

— All fields: fields for every component are displayed, except for fields 
that have been permanently removed by a Delete. 
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• Close closes the Reporting dialog; settings made are retained for the next 
call, as long as the Component Provisioning tool is open. 

• Print command under the list menu will print the indicated service data 
to a local printer. The options are: 

— All prints all the data that is currently in the service data area 
according to the printer options set by the Print options dialog. 

— Selected prints only the selected lines of data from the service data 
area according to the printer options set by the Print options dialog. 

The print command can be changed using the Print options... command on 
the main list menu. “Print options” (page 94)

• Save command under the list menu will save the indicated service data in 
a file on disk as named in the Save options dialog. The choices are: 

— All saves all of the data that is currently in the service data area to a 
file specified in the save file dialog. 

— Selected saves only the selected lines of data from the service data 
area to a file specified in the save file dialog. 

The save file name can be changed using the Save options... command on the 
main list menu. “Save options” (page 95)

Component reports commands are either visible in the report dialog or under 
the service data list popup menu. 

Print options
This dialog allows the print command options to be altered. See “How to 
change the report print options” (page 97). Only the UNIX print commands 
pr and lpr may be entered in the data entry field. These may have any options 
the command permits. The lpr command must always be present. If the pr 
command is present, it must come before the lpr command and be separated 
by a unix pipe ("|") character. 

Choose Cancel to close the Print options dialog without changing the original 
command, or OK to save the text of the print command. This text will be used 
the next time service data is printed. 
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Save options
Any file name, with leading directory specification, may be entered in the 
Save options data entry field. 

Choose Cancel to close Save options without saving the original text, or OK 
to save the new file name. The new file name will be used the next time a 
service datum is saved. 

Report Error messages
One of the following functions may display an error message: 

• Filtering The software is filtering text that has been entered does not 
conform to the syntax rules of the UNIX ed editor. Type a new filter. 

• Saving The file that is specified could not be opened due to lack of 
permission, or the file was opened and there was not sufficient disk space 
to write all the data to disk. Verify that the file name is correct, or create 
more disk space by removing unessential files. 

• Printing There was insufficient disk space in /tmp to write the print file. 
Either reduce the amount of data for printing or clean up the /tmp 
directory. 

OK error dialog
Acknowledgement of the error message. The dialog is closed. 

Generating reports for service data
The following procedures demonstrate the various uses of the service data 
Reporting feature

How to generate a service data report
1 Enter the component name and follow the steps in “How to specify a 

component in the component area” (page 70).

2 Expand the top level components into the subcomponents area as 
desired.

3 Select the component in the Subcomponents area. Press the mouse 
menu button on a component or subcomponent in the Subcomponents 
area and select Report...
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The component that was chosen along with any of its subcomponents 
that were displayed in the subcomponents area display in the service data 
area of the reporting dialog.

Note: The top level component is specified once in the title and once at 
the top line of the report. All components that follow are subcomponents 
of this top level component, and as such do not display the top level 
component as the leading portion of their component name.

How to display service data
1 To display all the service data associated with a component, select the All 

Fields button.

All the fields for each component will appear indented below the 
component name.

2 Select the Components button to display only the component level.

Only the component names will be displayed in the list.

How to filter a service data report
The result of filtering service data depends on keywords entered and the 
button selected in the Display area. If the Display is set to Components, only 
the components and individual fields that contain the keyword are displayed 
and the display will revert to all fields. If the Display is set to All Fields the 
components and all their fields are displayed if the component contains the 
keyword or if one of the component fields contains the keyword. 

1 Generate a service data report. 

2 Enter keyword(s) in the Filter area and click Filter.

All service data components containing that keyword will be selected and 
displayed in the service data display area.

How to remove text from a report
1 Select one or more components and lines of service data fields from the 

service data display area.

2 Press menu and choose Delete.

All the selected text is removed from the service data area.

Note:  If a component is deleted, all of its related fields are also removed 
from the report display.
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How to save a service data report
1 Generate a service data report. See “How to generate a service data 

report” (page 95) for more information.

2 Select the component you want to save. 

3 Press the mosue menu button in the service data area and choose Save 
selected or Save all from the Save pull-down menu.

Save selected will save only selected lines of service data and Save all 
will save all the service data. 

Note:  The service data will be saved in the default SDReports file in your 
home directory unless specified otherwise by the Save options... 
command.

How to change the report file name
1 Press the mouse menu button in the service data area and choose Save 

options.... 

The Save Report dialog is displayed.

2 Enter the directory and file name.

3 Click OK.

How to print a service data report
1 Generate a service data report. See “How to generate a service data 

report” (page 95) for more information.

2 Select the component you want to print.

3 Press the mouse menu button in the service data area and choose Print 
or Print all from the Print pull-down menu.

Print all will print all the information in the service data area and Print 
selected will print only selected lines of service data. 

Note:  The printed data will go to the default printer unless it is changed 
in the Print options...

How to change the report print options
1 Press the mouse menu button in the service data area and choose Print 

Options...

The print options dialog appears. 

2 Enter the print options.
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The pr and lpr UNIX commands may be entered here. Refer to the UNIX 
manpages for a description of these options.

3 Click OK.

Templates
A template contains a snapshot of service data that is saved in a file with a 
user-specified name. When a template is used, a copy of that data is added to 
the current service data. The data in a template can be as small as an 
individual NCUG_Index or as large as all the service data for an entire PE. 

The Templates command found in the Subcomponents menu, provides a pull-
down menu that allows you to use, create, and delete service data templates. 

Note: The Service Data Conversion tool does not convert templates to the 
latest software level when a conversion is done. See 241-6001-304 
Preside MDM Configuration Management Administrator Guide for more 
information on converting templates.

Create Template dialog
The Create Template dialog is displayed when creating a service data 
template. The template is created for the component on which the Create 
operation was invoked. By default, the template name will be the name of that 
component, but it can be changed by entering a different name in the Template 
name data entry field. 

Clicking OK creates the service data template, store it on disk in the directory 
specified in Template Preferences dialog and make it available for use. 

Clicking Cancel terminates the Create operation and does not create a 
template. 

Note: The template name may not be blank, and may not contain 
underscores (_) nor forward slashes (/). The name must be unique with 
respect to other service data template names. 
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Template preferences
Template preferences can be modified using the Change Template 
Preferences option in the Options menu. The following options are available:

• setting the directory in which the service data templates are accessed

• disabling the Confirm template deletion dialog. 

Pressing Apply will set the preferences for the current provisioning session 
and reload templates from the Template directory. Error messages are written 
to the Messages area of the dialog. Pressing Close will close the dialog. 

Template directory
The name of the directory to which service data templates will be saved and 
from which they will be accessed. 

Confirm Template deletion
If this box is checked, then a confirmation dialog will appear when the 
Templates - Delete command is used. Otherwise, the template is immediately 
deleted without any confirmation. 

Cancel button
Ignores any changes made on this dialog and closes the dialog. 

OK button
Sets the templating preferences and closes the dialog. These preferences are 
now in place for the duration of the provisioning session. 

In addition, the templates will be reloaded from the workstation 'Template 
directory'. A message indicating how many templates were loaded will appear 
in the Provisioning User Interface message area after the preferences dialog 
has been closed. 

Creating templates 
Templates are created from existing service data. This is done by uploading a 
master configuration file (MCF), and selecting Create from the Templates 
pull-down menu. A maximum of 80 templates can be created for any one 
component type, for example, PE, PI, port, and NCUG_Index. Once a 
template is created, it is referenced from the component immediately above 
from where it was created. For example, a template created for an ITI line is 
available from the templating menu on the port component (which is the 
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component immediately above the ITI). Therefore, although an ITI template 
is created from the ITI templating menu, it is used and deleted from the port 
templating menu. 

How to create templates
1 Select the component in the Subcomponents area from which you want 

to create a template.

2 Press the mouse menu button in the Subcomponents areas and choose 
Create from the Templates pull-down menu. 

The Service Data Template Creation dialog is displayed and prompts you 
for a unique location and name. 

3 Enter the template name.

If no name is specified the system will use the component as the default, 
for example, ITI.

4 Click OK.

The name of the new template that you have just created appears in the 
Messages area. To verify whether this new template has been created, 
press the mouse menu button on the parent component and choose Use-
with forms from the Templates pull-down menu. You will see the new 
template. 

Deleting templates
Templates that have been previously created and are no longer required can 
be deleted.

1 Press the mouse menu button in the Subcomponents area and choose 
Delete Component from the Templates pull-down menu. 

2 Click Delete.

Note:  You have the option of not having the confirmation dialog appear 
when you use the Delete command. This feature can be accessed from 
the Options menu, by selecting Change Template Preferences... and 
clicking Confirm template deletion and turning the checkbox off. 

The Delete service data template dialog appears and prompts you for a 
unique location and name. 

3 Click OK.
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Using templates
Using a template creates service data which is an exact image of the data in 
the template.

1 Select the location of the new service data in the Subcomponents area.

2 Choose Use - with forms from the Templates pull-down menu if you want 
each editing dialog for the new service data displayed and available for 
editing.

3 Choose Use-without forms from the Templates pull-down menu to be 
prompted to enter the new value for any key fields. A separate dialog 
appears for each key.

Note:  The Use - with forms option is functionally equivalent to choosing 
Use - without forms and, after the operation completes, individually 
editing each new component. 

Template management
Template files consist of data extracted from an MCF. The data, and the form 
it is in, may need to change with a new software release even when explicit 
MCF conversion is not required by the new software release. To ensure that 
templates work properly with a new software release they need to be 
regenerated, using the regentemplates command (see 241-6001-304 Preside 
MDM Configuration Management Administrator Guide for details).

Template management recommendations
Nortel Networks recommends that a small set of MCFs (the fewer the better) 
be maintained on NMS disk for the purpose of maintaining service data for 
templates. Service data in these MCFs should come from working on-switch 
service data by cutting and pasting to ensure that service data obtained from 
templates works properly the first time it is put into service. To start a new 
template MCF, upload an existing MCF from a Packet Module (or NMS disk) 
using the Provisioning UI (or the API), and then download it to NMS disk 
giving it a different name (for example, use a special namsid) that will make 
it recognizable as a template MCF.

In order to be able to regenerate a template file there must be an MCF 
containing the service data that is in the template and this MCF must be kept 
until the template is recreated from another MCF (as a result of MCF 
conversion or MCF consolidation). A consequence of this is that templates 
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need to be created from service data that has not been modified since it was 
uploaded. If changes have been made then the service data must be 
downloaded first, followed by an upload of the new MCF, and then the 
templates can be created.

It is not necessary to keep track of the MCFs and component ids that were 
used to generate a template manually. The MCF and component id are 
recorded within the template file. To extract this information select a Unix 
window, go into the template directory and enter the following Unix 
command:

     egrep ’^MCF=|^Comp_Id=’ *

This produces a list of template file names and the MCF and the component 
id used to generate each template file. There are two lines of information per 
template file. For example:

      PE_5.sdt08:MCF=MC.95111100.4034.0
      PE_5.sdt08:Comp_Id=PM R34 PE 5
      PI_5.sdt08:MCF=MC.95111100.4034.0
      PI_5.sdt08:Comp_Id=PM R34 PE 5 PI 5
      PO_1.sdt08:MCF=MC.95111100.4034.0
      PO_1.sdt08:Comp_Id=PM R34 PE 5 PI 5 PO 1

To help keep the number of MCFs required for template maintenance to a 
minimum it is suggested that:

1 Creation of new templates should be “batched”

When new templates need to be created make all the service data    
changes first, download them, upload the new MCF and then generate    
the templates. 

If service data changes are made and downloaded separately for each 
new template then the number of MCFs that need to be kept for template 
maintenance is increased unnecessarily.

2 MCFs for templates should be consolidated from time to time

As MCFs are updated with new service data for new templates the older 
templates continue to refer to the older MCFs even though their service 
data remains unchanged in the new MCFs. To reduce the number of 
MCFs, recreate the older templates using newer MCFs (see 
241-6001-012   14.3RSUP   



Chapter 4 Component Provisioning   103
241-6001-304 Preside MDM Configuration Management Administrator 
Guide for details) and then use the deletmcf command to delete the MCFs 
that are no longer referenced.

When new software is installed all templates need to be regenerated so 
this is a good time for a consolidation. Consolidation can be done at other 
times as needed.

For additional information on managing templates see in 241-6001-304 
Preside MDM Configuration Management Administrator Guide.

Alternative template management using MCF backups
If the template management recommendation described in the previous 
section cannot be implemented, then an alternative procedure is available 
when both the following are true:

• templates are being generated from MCFs downloaded to a packet 
Module

• downloaded MCFs are backed up to NMS disk

See 241-6001-304 Preside MDM Configuration Management Administrator 
Guide for details.

Custom Forms
Provisioning is made easier and more accurate by using custom forms. You 
can create a custom form for any subcomponent that can be edited or viewed. 
The custom form enables you to simplify the display of the Edit/View form 
for a subcomponent. In addition, you can use the custom form to set default 
values for a subcomponent’s fields. To create a custom form for a 
subcomponent, use the Form Editor. 

Once created, a custom form replaces the default form in all operations where 
Edit/View forms are used. These operations include the following:

• editing

• viewing

• adding 

• templating
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Using the Form Editor, you can customize the Edit/View form in the 
following ways:

• hiding the display of fields

• changing the display order and grouping of fields

• assigning your own default values to fields

Hiding the display of fields
You can hide from view the fields that you do not frequently access, greatly 
simplifying the custom form. The option Show hidden allows you to redisplay 
any hidden fields. For more information on how the Form Editor handles 
hidden fields, see “Options menu” (page 108).

Changing the display order and grouping of fields
You can rearrange fields within a custom form. Also, you can define new 
groups, reorder fields within their group, and move fields into other groups.

Assigning your own default values to fields
Default values are assigned by setting the values of the fields. When you save 
a custom form, the field values are saved as default values. These default 
values are applied when a custom form is used for any subsequent adding 
operation.

Form Editor
You create a custom form for a subcomponent by using the Form Editor. 
When opened, the Form Editor displays an Editing Dialog. When you modify 
this Editing Dialog and save the changes, you create a custom form. You can 
save your custom form in one of two ways:

• as a workstation custom form that is accessible to all users of a 
workstation, or 

• as a user custom form that is accessible to one specific user 

The following rules apply to any subsequent custom forms, templating, 
editing, viewing and adding operations:

• A custom form takes precedence over a default form.

• A user custom form takes precedence over a workstation custom form.
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• If a custom form is used within a templating operation, it gets any 
relevant service data values for that subcomponent from the template.

You can override this order by establishing custom form preferences. See 
“Custom form preferences” (page 113).

See also...

• “Form Editor window” (page 105)

• “Starting the Form Editor” (page 109)

• “Modifying an existing custom form” (page 109)

• “Deleting a custom form” (page 110)

• “Moving fields within a custom form” (page 111)

• “Custom form preferences” (page 113)

Form Editor window
The Form Editor opens and displays an Editing Dialog. The content of this 
dialog depends on the selected subcomponents.

See also...

• “File menu” (page 106)

• “Edit menu” (page 107)

• “Options menu” (page 108)

• “Service data entry area” (page 108)

• “Messages area” (page 109)

• “Action buttons” (page 109)

For an illustration of the Editing Dialog, see the illustration “The Editing 
dialog of the Form Editor” (page 106).
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Figure 6
The Editing dialog of the Form Editor

File menu
The Form Editor File menu provides commands that allow you to save 
custom form definitions or close the Form Editor. The File menu contains the 
following commands:

• Save as workstation custom form saves the custom form and permits 
access to this form by any user of the workstation. When saved in this 
way, a workstation custom form is used in place of the component default 
form. Workstation custom forms are stored in the directory /opt/
MagellanNMS/cfg/cfdf/fdf/.
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• Save as user custom form saves the user custom form and only permits 
access to the form by a specific user. When saved in this way, a user 
custom form is used in place of a workstation custom form or the 
component default form. User custom forms are stored in directory 
$HOME/MagellanNMS/cfdf/fdf/.

• Close closes the Form Editor.

Edit menu
The Form Editor Edit menu provides commands to display, hide, and group 
fields. In addition, you can modify and rename groups of fields, and set fields 
to their default values. 

Most of the Form Editor Edit menu items work on the selected fields and 
groups in the Edit/View form. The selection can be a single field or multiple 
fields. To select a single field, position the pointer over the field label or frame 
and click select. To add fields to a selection, position the pointer over another 
field label or frame and, while holding down the Shift key, click select. To 
toggle a field in or out of a selection, click select over the field label or frame 
while holding down the Control key.

Unlike the menu items that work on fields and groups, Revert to saved default 
values operates on the entire form.

The Edit menu contains the following:

• Hide hides the selected fields. The Form Editor uses one of two modes 
for hidden fields: Hide hidden or Show hidden. If the Form Editor is in 
Hide hidden mode, the selected fields are not displayed on the form. If 
the Form Editor is in Show hidden mode, the selected fields are displayed 
in a lighter-than-normal color. For information on how to change the 
mode, see “Options menu” (page 108).

• Unhide displays the selected field regardless of the hidden mode setting.

• Group… groups selected fields. You can specify a group name for the 
new grouping.

• Delete group deletes the selected group. Only an empty group can be 
deleted. For information on how to empty a group see “Moving fields 
within a custom form” (page 111).

• Change group name… changes the name of the selected group.
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• Revert to saved default values changes the values of all the fields in the 
form, including hidden fields, back to their last saved defaults.

Options menu
The Options menu lets you determine how the Form Editor handles hidden 
fields. The Options menu contains the following:

• Show hidden mode displays hidden fields in a lighter-than-normal color. 
Hidden fields are not disabled. You can interact with the hidden fields in 
the normal manner, for example, you can change values in hidden fields.

• Hide hidden mode removes the display of hidden fields so that they do 
not appear on the form.

Service data entry area
The service data entry area, located just below the component title, allows you 
to edit the service data, or, attribute values, for the selected component. Each 
attribute is represented by one of the following:

• Data entry field, which allows you to enter a specific value. You can 
display the valid values of a data entry field by pressing the menu button 
while the pointer is on the left arrow symbol beside the data entry field. 

• Radio button box, which allows you to turn an option on or off. 

• Check button box, which allows you to select as many options as you 
need. 

• Data entry list, which allows you to alter groups of attributes that have 
dependencies on one another. A service data entry area with a data entry 
list contains the additional buttons:

— Find finds an entry in the list with the attribute value or values that 
you specify.

— Add adds a new entry to the list. All values in the new entry need to 
be valid. If the list is sorted, the new entry is added in the correct 
location.

— Add before adds a new entry to the list before the currently selected 
list entry. If the list is sorted or of a fixed size, this button is not 
enabled. All values in the new entry need to be valid.
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— Replace replaces the currently selected list entry with a new entry. 
All values in the new entry need to be valid.

For help on fields or the component, from the Help menu, select Help On 
Service Data Description. Then, select the specific field or the background. 
For help on all fields, see 241-2001-340 DPN-100 Envelope Definitions.

Messages area
The messages area, located below the service data entry area, displays 
warning and error messages for the Form Editor window.

Action buttons
The action buttons, located at the bottom of the Form Editor window, are the 
same as the action buttons on the Edit/View dialog. On the Form Editor 
window, the Verify and Save and Cancel buttons are not enabled. The 
remaining action button, Verify, checks the correctness of the entered data and 
leaves the Form Editor window open. 

Starting the Form Editor
To create a custom form for a subcomponent, use the Form Editor.

Creating a custom form with the Form Editor
1 From the Component Provisioning main window, specify the desired 

component and subcomponent. 

2 With the mouse pointer in the subcomponent area, press the mouse 
menu button to display the Subcomponent menu. 

3 From the Subcomponent menu, select Custom Forms. 

A cascading menu is displayed. 

4 From the cascading menu, select Create.

The Form Editor opens an Editing Dialog for the specified subcomponent 
The fields displayed in this dialog vary according to the selected 
subcomponent. 

5 Make appropriate changes to the Editing Dialog.

6 To save your custom form, from the File menu select either Save as 
workstation custom form or Save as user custom form.

Modifying an existing custom form
To make changes to an existing custom form, use the following procedure.
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1 From the Component Provisioning main window, specify the desired 
component and subcomponent. 

2 With the mouse pointer in the subcomponent area, press the mouse 
menu button to display the Subcomponent menu. 

3 From the Subcomponent menu, select Custom Forms. 

A cascading menu is displayed. 

4 From the cascading menu, select Change.

A second cascading menu is displayed.

5 From the second cascading menu, select either the Workstation or User 
Custom Form.

The Form Editor opens an Editing Dialog for the specified subcomponent 
displaying the existing custom form. Make your modifications.

6 To save your modifications, from the File menu, select the appropriate 
save command.

Deleting a custom form
To delete an existing custom form, use the following procedure.

1 From the Component Provisioning main window, specify the desired 
component and subcomponent. 

2 With the mouse pointer in the subcomponent area, press the mouse 
menu button to display the Subcomponent menu. 

3 From the Subcomponent menu, select Custom Forms. 

A cascading menu is displayed. 

4 From the cascading menu, select Delete.

A second cascading menu is displayed.

5 From the second cascading menu, select either the Workstation or User 
Custom Form.

A Question Dialog that asks for verification to delete the custom form is 
displayed.

6 To delete the custom form, click the OK button.
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Moving fields within a custom form
There are several types of fields within the Edit/View dialog. There are text 
data selector fields, radio button fields, and two types of check button fields. 
One type of check button field, shown alongside the label Allowed packet size, 
provides a range of values from which you can choose. A second type of 
check button field, shown under Call options allowed, turns settings on or off. 
The Form Editor handles these on/off check button fields differently from all 
other field types. 

You can move fields and groups of fields within a custom form to rearrange 
the display of the form according to your needs. There are, however, two 
restrictions. You can move a field or group only within a single form, not 
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among different forms. Also, you cannot move a field into a different group 
type. For example, you cannot group on/off check button fields with other 
fields. 

Before a group can be deleted, it must be empty. Move fields out of a group 
to create an empty a group. When a group becomes empty, a frame is 
displayed below the group name, outlining the drop location. This permits 
fields to be moved back into the group, if necessary, at a later time.

Figure 7
Form Editor Field Types
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Moving fields within a form
1 Move the pointer over the label or frame of the field to be moved. 

2 Press and hold down both the Shift key and the modify mouse button.

3 While holding down the Shift key and the modify mouse button, drag the 
pointer between the two fields of the desired destination.

As you move the pointer across the form, the pointer changes to indicate 
either a valid or invalid drop location. A valid location is indicated by a 
page containing an arrow. An invalid location is indicated by a page 
containing a circle with a line through it.

4 At a valid destination, release the middle mouse button and then the Shift 
key.

Moving groups within a form
1 Move the pointer over the group name to be moved. 

2 Press and hold down both the Shift key and the modify mouse button.

3 While holding down the Shift key and the modify mouse button, drag the 
pointer to a valid destination.

As you move the pointer across the form, the pointer changes to indicate 
either a valid or invalid drop location. A valid location is indicated by a 
page containing an arrow. An invalid location is indicated by a page 
containing a circle with a line through it.

4 At a valid destination, release the middle mouse button and then the Shift 
key.

Custom form preferences
Two types of custom forms are available: workstation custom forms and user 
custom forms. Workstation custom forms are accessible to all users of a 
workstation; user custom forms are accessible to one specific user. You can 
modify custom form preferences from the Options menu by selecting Change 
Custom Form Preferences. The resulting Custom Form Preferences dialog 
lists two options: workstation custom forms and user custom forms. Specify 
your preferences by selecting or de-selecting these options. Four choices are 
available:

• both options de-selected
When both workstation custom forms and user custom forms are de-
selected, only default forms are used for component provisioning.
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• workstation custom forms selected
Workstation custom forms are used in place of default forms.

• user custom forms selected
User custom forms are used in place of default forms.

• both options selected
Both types of custom forms are available, however, user custom forms 
take precedence over workstation custom forms.

To save your custom form preferences to a file, from the Options menu, select 
Save Preferences.

User preferences
User preferences are loaded from the ProvisioningUser.cfg file in your home 
directory when a Component Provisioning session is started. The user profile 
saves your preferences from one provisioning session to the next. This file is 
optional, and if it does not exist the system defaults are used.

Preferences can be modified and saved to disk by choosing Save Preferences 
from the Options menu. When it is saved, the previous version is renamed to 
ProvisioningUser.cfg.old. 

Note: Some options in the preference dialogs may be protected and you 
may not be able to modify them. This will occur if your system 
administrator has restricted the options available to you.

See also...

• “Upload preferences” (page 115)

• “Download preferences” (page 118)
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Upload preferences
The upload preferences can be modified by choosing Change Upload 
Preferences from the Options menu. These preferences allow you to do 
specify such things as:

• how you would prefer MCFs to be uploaded by the Component 
Provisioning tool

MCFs are uploaded when the name of a PM, which is not currently 
updated, is entered in the Component field.

• if you want propagation log files to be created

See the figure “Upload Preferences dialog” (page 116).
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Figure 8
Upload Preferences dialog

Mode indicates the method used to locate the name of an MCF to be uploaded 
each time an upload takes place. You may select one of the following: 

• User specified enables you to specify the name of the MCF to be 
downloaded. You are prompted for the bundle and namsid of the MCF. 
The MCF matching MC.<bundle>.<namsid>.0 is created. 

• Keyed enables you to specify a key in the Key field, which is used to 
search for MCFs. 

Note: The Key field is not visible until you select Keyed mode.
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• Dated enables you to specify a date in the Date field, which is used to 
search for MCFs. 

Note: The Date field is not visible until you select Dated mode. You can 
enter today or a valid date in the format yymmdd in the Date field. 
Entering today substitutes the current date at upload time so that you 
always get the latest service data file. See“Dated algorithm” (page 45) 
for more information on Date format.

Key is only visible when the Keyed radio button has been selected for Mode. 
When Mode is Keyed, the value supplied for key is used to search for the 
MCFs with a pattern matching: MC.<key>nn.<namsid>.0, where nn is 
between 00 - 99. The MCF with the highest index is uploaded. Date is only 
visible when the Dated radio button has been selected for Mode.

Location indicates the method used to find the location of an MCF. You may 
select one of the following: 

• Default Destination downloads the MCF to the location from which it 
was uploaded. This may be either NMS_Disk or a PM. 

• NMS Disk writes the MCF to the UNIX directory indicated in the 
pfaserv.cfg file. 

• User specified prompts for the PM to be accessed. 

Propagation Logging creates a log file of all the changes made to MCFs 
during a session. Logging can be turned on only when an upload is done, but 
can be turned off any time using the Stop module logging option from the File 
menu. 

File data entry field only appears when logging has been selected. This field 
allows you to direct the logging output to a specific file, or if left blank, 
Component Provisioning will create a default file: MC.<identifier>.prop in 
your home directory.The log files should be stored in a secure directory that 
is not writable to other users. This is because DPN service data, including 
plaintext passwords, are stored in these files. By default, your home directory 
is writable by other members of your group. If the Create module option has 
been selected from the Component area menu, the default file name will be 
MC.CREATED.0000.0.prop. These files can then be used to apply the same 
changes to multiple bundles. This is useful when doing a software migration, 
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where service data changes to many MCFs is required. See “Using the 
Propagate command” (page 121) for information on how to propagate 
changes to many MCFs.

Download preferences
The download preferences can be modified by choosing Change Download 
Preferences from the Options menu. These preferences allow you to specify 
how you would prefer MCFs to be downloaded by the Component 
Provisioning tool. MCFs are downloaded when Download is selected from 
the File menu. Once you have set your preferences they are valid for the 
duration of the provisioning session.

See the figure “Download Preferences dialog” (page 119).
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Figure 9
Download Preferences dialog

Items in the dialog are as follows:

• Mode indicates the method used to name the new MCF that is created 
each time a download takes place. 

• Location indicates the method used to determine the destination for the 
new MCF.
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• Key is visible only if you select the Keyed radio button.

• Date is visible only if you select the Dated radio button. You can enter 
today or a valid date in the format yymmdd in the Date field. Entering 
today substitutes the current date at download time so that you always 
download a new file with the key set to the current date. See “Dated 
algorithm” (page 45) for more information on Date format.

• Type indicates the type of download you prefer. Incremental will 
download only the envelopes that have been modified and complete will 
download all the envelopes.

• Check allows you to perform a complete, incremental, or minimal MCF 
service check at download. Incremental MCF will only check the MCFs 
that have been modified and/or expanded. Complete MCF will check all 
of the MCFs in the bundle regardless of whether it has been modified or 
not. Minimal MCF will only check the MCFs that have been added or 
modified. These MCFs may not be activatable on the PM.

• Activatable indicates whether or not the MCF, once downloaded, can be 
activated on a PM. Before the download operation begins, a dialog 
appears prompting you to confirm the download parameters. You can 
either proceed with the selected parameters, or choose to cancel the 
download and use the Change Download Preferences selection from the 
Options menu to change the download options. 

• Confirm Download displays a dialog when a download is performed. 
This dialog displays any errors or warnings 

• Change Activation Date allows you to change the current MCF activation 
date when it is downloaded. This field appears dimmed out if Dated 
download mode has been selected. You can enter today or a valid date in 
the format yymmdd in the Activation date field. Entering today 
substitutes the current date. See“Dated algorithm” (page 45) for more 
information on Activation date format.
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Module integrity checks
Module integrity checks are required to maintain the sanity, physical integrity, 
and consistency of service data on the switch. These checks provide the 
following benefits:

• ability to perform an optional complete module integrity check at 
download time

• ensure that the service data, which other tools may use, contains no 
service data check errors

Component Provisioning allows you to perform a complete module integrity 
check at service data download time to ensure the integrity of the MCFs. This 
feature does not introduce any new service data checks, only existing 
semantic checks are performed when Complete MCF service check is 
selected. See the figure “Download Preferences dialog” (page 119).

Service data checks can be either incremental or complete. Incremental 
checks can be done when the data is changed. They will be executed by 
selecting Verify or Verify and Save from the editing window. Complete checks 
can only be done with a download, when all the related data is available. All 
the service data functions are automatically called to ensure that the service 
data is correct. Error and warning messages from the service data checks are 
displayed in the Download messages dialog. Any service data errors detected 
must be corrected before the download can proceed. 

The time for a complete service data check on an entire module will vary 
according to the size of the module. The following message is displayed in 
the Messages area of the Confirm Download dialog:

Download and Complete Service Check results in a long 
running process. The duration will be proportional to 
the size of the module.

Using the Propagate command
The propagate command is a UNIX command line application used for 
making identical service data changes for several bundles in the same module.
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Using the propagate command is a two step process: first the propagation log 
file must be created from a Component Provisioning session and second the 
propagate command is used from the UNIX command line.

The propagation log file created in the Component Provisioning session must 
contain only one upload and download session. If the log file contains more 
than one, the propagate command will issue a message and fail.

When using the propagate command you are prompted for an NCS password 
only if NCS access was involved during the creation of the log file. In this case 
the destination and capability id are obtained from the propagation log file. 
The propagate command sends all its responses to stdout. It issues error 
messages or incorrect invocation of the command, missing or illegal 
responses to prompts, failure to provide a valid NCS password and provision 
of an unsuitable propagation log file.

When the propagate command has completed, you may exit or provide an 
upload and download mode to propagate more changes. If you continue from 
this point, the log file with the same NCS access information will be re-used.

The propagate command syntax is as follows:

/opt/MagellanNMS/bin/propagate [-h]

How to create a propagation log file
1 In the Preside MDM window, select Configuration -> DPN Devices -> 

Component Provisioing.

2 From the Options menu choose Change Upload Preferences... .

3 Select Propagation Logging.

4 Supply an filename for the propagation log file.

If no filename is specified, the system will create a default with a format 
of: MC.<identifier>.prop.

5 Upload the bundle.

6 Perform the service data changes.

7 Download the changed service data as a new bundle.
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The resulting propagation log file is ready to use with the propagate 
command.

How to use the propagate command
1 Open a UNIX xterm.

2 Invoke the propagate command, enter:

/opt/MagellanNMS/bin/propagate

3 Enter the propagation log file name.

4 Specify the upload and download mode.

The command assumes that the mode for uploading and downloading are 
the same. The default mode is the upload mode used during the creation 
of the propagation log file or dated if the upload mode was ACTIVE or 
COMMITTED.

5 Specify the Source upload key and Target download key.

The upload and download information is displayed on the screen. Any 
error messages and notes resulting from the propagate are displayed on 
the screen.

6 Respond to the prompt that appears after downloading: either exit or 
provide an upload and download mode (or accept the default) and repeat 
step 4.

Example 1
The following is an example of a successful keyed upload and download.

/opt/MagellanNMS/bin/propagate

Propagation log file = /usr/operator/MC.1234.1234.0.prop
Upload and download mode [(u)ser specified/(k)eyed/

(d)ated, default: (k)] = return
Source upload key= R07

Target download key [default: R07)] = R08

Upload location: DISK

Upload namsid: 7501

Download location: DISK

Download mode: COMPLETE

Download namsid: 7501
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NOTE: MCF MC.R0712.4034.0 uploaded

NOTE: MCF MC.R0800.4034.0 downloaded.

Exit [(x)] or

Upload and download mode [(u)ser specified/(k)eyed/

(d)ated: default (k)] = x

Example 2
The following is an example of a dated upload and download that results in 
an error message being produced. See “Dated algorithm” (page 45) for 
information on the date format.

/opt/MagellanNMS/bin/propagate
Propagation log file = /usr/operator/MC.1234.1234.0.prop

Upload and download [(u)ser specified/(k)eyed/(d)ated: 

default, (k)] = d
Source upload date = 930129
Target download date [default: (930129)] = 930129

Upload location: DISK

Upload namsid: 7501

Download location: DISK

Download mode: COMPLETE

Download namsid: 7501

NOTE: MCF MC.9201290.4034.0 uploaded.

_invoke_ID: 29

WARNING: CONMAND_SDA 0 ICON_SDA 1: At least one 

“\NCUG_Index” is required when “Preferred CUG” is 

“National: in the \”DNA_CUG” component.

NOTE: MCF MC.92032911.4034.0 downloaded.

Exit [x] or

Upload and download mode [(u)ser specified/(k)eyed/

(d)ated; default: (d)] = x
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Working with Context
Context allows different applications to communicate the status position of 
service data. For example, if a given application is working on a specific PE, 
it can broadcast the information for that PE using the Put context command. 
Other applications can then retrieve the information by using the Get context 
command.

Putting context
The Put context command is used to place a component name in the context 
buffer for another application. The Put context command is available in the 
Component, Subcomponents, and Modified components area menus. If you 
select a component from either one of these area menus, use the Put context 
command from the area in which the component is selected. For more 
information on Context, see 241-6001-011 Preside MDM Fault Management 
User Guide.

How to use the Put context command
1 Select the component you want to context. 

2 Press the mouse menu button on a component and choose Put context.

The component name is placed in the Context buffer where it can be 
retrieved by another application.

Getting context
The Get context command from the Component area menu is used to retrieve 
a component from the context buffer. This command is used when another 
application has placed a component in the context buffer. For example, when 
using the Surveillance tools you might notice that there is a problem with one 
of the components. If you suspect that the problem is a service data problem, 
you can place the component in the context buffer using the Put context 
command in the Surveillance tool. You can then open the Component 
Provisioning tool and retrieve that component using the Get context 
command.

How to use the Get context command
1 Place the pointer in the component area.

2 Press the mouse menu button and choose Get context.

The component is added to the Component area.
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Global Data Manager

The DPN Global Data Manager tool can be used to duplicate global service 
data components, or to update routing data in the MCF of one or more 
resource modules.

Note: An MCF must be converted to the latest service data level before 
trying to use Global Data Manager. If the MCF is not at the latest level, 
an error message will be generated. See “Service Data Conversion” 
(page 207) for instructions to convert service data.

Global Data Manager concepts and procedures
The GDM tool uses the following concepts to perform its tasks:

• Duplication of global data service components

See “Duplicating global service data components” (page 128)

• Partial or complete downloads

See “Complete or incremental downloads” (page 128)

• Using keywords

See “Acceptable keywords for global data components” (page 130)
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The GDM tool can be used to perform the following tasks:

• Global data mode-- using the GUI

See “Replacing selected global data components using the GUI” 
(page 141)

• Global data mode--using the Command line

See “Replacing selected global data components using the command line 
interface” (page 145)

• Running a log file from the GUI

See “Log file” (page 144)

• Using a command file to apply the transaction file to multiple RMs

See “Preferred service path data command file format” (page 157)

Duplicating global service data components
The Global Data Manager lets you to duplicate global service data 
components that are common to more than one packet module in a network 
from one master configuration file (MCF) into one or more MCFs in the 
network. The tool uploads a target MCF, replaces selected global data 
components in that MCF with service data from a global data MCF, and then 
downloads the newly updated target MCF. 

Complete or incremental downloads
When the Global Data Manager downloads a new version of a target MCF, it 
performs a complete download if one or all of the following conditions exists:

• the download location differs from the upload location

• the download NAMS ID differs from the upload NAMS ID

• the complete download option is chosen

Global Data Manager displays a warning message when a complete download 
is performed.
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If none of the above conditions exist, Global Data Manager performs an 
incremental download (just the differences between the MCFs). 
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Acceptable keywords for global data components
Global Data Manager understands keywords which map to a list of associated 
names. When a keyword is selected for update by Global Data Manager, the 
system processes the information with the list of category names. See table 
“Global Data Manager keyword mappings” (page 130) for a list of the 
keywords and category names.

Table 2 
Global Data Manager keyword mappings

Keyword Category name Category 
type

Network_Env Network_Env 1

Large_VC_Window_Env Large_VC_Window_Env 1

Accounting_Env Accounting_Env 1

ACR_RID_Redirection
ACR_Direct_Call_List

RID_Redirection
Acrd_Direct_Call_List

1
1

Access_To_NUI_Validation Anui_Direct_Call_List 1

Source_Call_Router SCR_Adjacent_NIDS
SCR_RPOA_Mnemonics
SCR_TNIC_NID_Group
SCR_RPOA_NID_Group
SCR_National_NID_Group
SCR_X121
SCR_E164
SCR_Dial_Out_Routing_DNAs

1
2
1
1
1
2
2
1

Gateway_Call_Router Gateway_Common_Data
Gateway_Source_Call_Router
GSCR_Primary_Routes
GSCR_Secondary_Routes
GSCR_Calling_Called_Prefixes
GSCR_NID_Mnemonic
SCR_ANID_To_SNRID_Mappings
GSCR_Loadsharing
Gateway_Destination_Call_Router

1
1
1
1
1
1
1
1
1

RID_Routing System_Attributes 1

ITI_Ntwk_Prof_Env ITI_Ntwk_Prof_Env 1

 (Sheet 1 of 2)
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When Call_Redirection_Server is selected, both REDMAN_SDA and the 
DnicRedirectionEnv are processed. Processing occurs as described 
below.

Type 1 Component:

1 Find FIRST match in source MCF.

2 If found in source MCF, find all matches in target MCF.

3 In target MCF, delete and re-add each as copy of component from
source MCF.

Type 2 Component:

1 Find FIRST match in source MCF. Get all matching siblings.

2 If found in source MCF, find FIRST match in target MCF.

3 In target MCF, delete all matching siblings and re-add siblings set as
copy from source MCF.

Opening the Global Data Manager
From the Preside MDM window, select ->Configuration -> DPN Devices -
> Global Data Manager.

ITI_Videotex ITI_Videotex_Menu

Call_Redirection_Server REDMAN_SDA
DnicRedirectionEnv

1
1

NDI_GMS_List GMS_FILE 1

NCS_Time_Of_Day_
Accounting

NCS_TODA 1

Table 2  (continued)
Global Data Manager keyword mappings

Keyword Category name Category 
type

 (Sheet 2 of 2)
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The DPN Global Data Manager window opens.

Figure 10
Global Data Manager main window
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The DPN Global Data Manager main window contains the following items:

• File menu

See “File menu” (page 54)

• Options menu

See “Options menu” (page 134)

• Security menu

See “Security menu” (page 55)

• Help menu

See “Help menu” (page 55)

• Application type

See “Application type area” (page 134)

• Target module

See “Target module data field” (page 134)

• Set Source Parameter button

See “Set Source Parameters button” (page 134).

• Target MCF upload parameters

See Chapter 5 Target MCF upload parameters area

• Target MCF download parameters

See “Target MCF download parameters area” (page 137)

• Selection list of GD components

See “Selected Global Data Components window” (page 138)

• Run button

See “Run button” (page 138)
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• Messages area

See “Messages area” (page 138)

Options menu
The Options menu contains the following commands:

• Run Command File allows you to enter the required information in order 
to run a restore command file. 

• Check Ownership is no longer used.

• Ignore Ownership is no longer used. 

Application type area
Enter the application mode (type) in this area. You may select one of the two 
following application modes.

• Global data replaces global data in one MCF with global data from 
another MCF. 

• Routing data substitutes routing data in one MCF with routing data 
information obtained from the routing data transaction file. 

Target module data field
Enter the target module in this area. The target module is the module to which 
the upload target MCF applies. It could be different from the module where 
the MCF is actually located. If the target module and the upload source are 
the same module, this field can be left blank. 

If you plan to use NCD on the downloaded MCF, and the MCF location and 
the target module differ, specify the target module here. 

Set Source Parameters button
This button opens the Select Global Data dialog if the Global Data 
application type is selected. It opens the Select Transaction File dialog if the 
application type is Routing Data. 
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Target MCF upload parameters area
Enter the upload mode and upload source information in this area. The 
parameters are used for uploading the target MCF, which is the MCF whose 
global data is to be updated with the global data from the global data MCF. 

Upload mode 
Upload mode indicates the search mode that the tool uses to find the name of 
the target MCF to be uploaded. The NAMS ID field is mandatory if uploading 
from the NMS_DISK. You may select one of five modes. 

• User specified allows you to specify the name of an MCF used to search 
for the MCF to be uploaded. Each time an upload takes place, you must 
specify the bundle (also the NAMS ID if uploading from the NMS_DISK) 
of the desired MCF. The search string used is: 
MC.<bundle>.<namsid>.0 
See also “Bundle data entry field” (page 136) and “NAMS ID data entry 
field” (page 136).

• Keyed allows you to specify the key used to search for the MCF to be 
uploaded. You must specify a key each time an upload takes place. See 
also “Key data entry field” (page 136).

• Dated allows you to specify the date used to search for the MCF to be 
uploaded. You must specify a date each time an upload takes place. See 
also “Date data entry field” (page 136).

• Committed uploads the committed MCF on the PM. 

• Active uploads the active MCF on the PM.

Upload source
Upload source indicates the method used to find the location of the target 
MCF. You may select one of two modes: 

• NMS disk searches for the target MCF in the workstation directory 
indicated by the PFA.cfg file. 

• PM searches for the target MCF on the PM named in the data entry field. 
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Key data entry field
This field appears only if the Keyed button has been selected. You must 
specify a key each time an upload or download takes place. The search string 
used is: MC.<key>nn.<namsid>.0, where nn ranges from 00-99. The MCF 
with the highest index (nn) is uploaded and a download searches for the 
highest key and creates a new key. 

Date data entry field
Enter the date if the Dated button has been chosen. If the Dated button has not 
been chosen, this field will not be visible. The date format is yymmdd. For 
example, 16 June, 1992 is expressed as 920616. Only valid dates are 
accepted. See “Dated algorithm” (page 45) for more information on the date 
format. 

A dated MCF has the format: MC.<yymmdd>nn.<namsid>.0, where nn 
ranges from 00-99. When uploading, using dated mode is the same as keyed 
mode if an exact match exists for that date. However, when an exact match 
does not exist, the most recent dated MCF, relative to that date, is uploaded; 
that is, the dated MCF with the latest date earlier than the given date. When 
downloading, using dated mode is the same as keyed mode except the 
activation date in the MCF is set to the given date. 

Bundle data entry field
This field appears only if the User Specified button is selected. The bundle is 
used to upload or download an MCF which has the format: 
MC.<bundle>.<namsid>.0. Bundles can be made up of letters, digits, and 
underscores. They cannot begin with an underscore, and they must be no 
more than eight characters long. 

NAMS ID data entry field
Enter the NAMS ID contained in the MCF name in this field. The NAMS ID 
must be a number between 256 and 49151 inclusive. 

PM data entry field
Enter the PM mnemonic in this field (including NCS routing information). 
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Target MCF download parameters area
This input field is used to specify the download mode and target for the newly 
synchronized MCF. If the download NAMS ID is not specified, the NAMS ID 
of the uploaded MCF will be used. If the download target is set to the Default 
destination, the MCF is downloaded to the location from which it is uploaded. 

Download mode
Download mode indicates the mode that the tool uses to name the newly 
updated target MCF. The download NAMS ID, when not specified, is 
assumed to be the same as the NAMS ID of the uploaded MCF. You may 
select either: 

• User specified allows you to specify the name of the MCF to be 
downloaded. Each time a download takes place, you must specify the 
bundle of the new target MCF. The following MCF is created: 
MC.<bundle>.<namsid>.0 

• Keyed allows you to specify the key to be used to name the new MCF to 
be downloaded. You must specify a key each time a download takes 
place. The following MCF is found: MC.<key>nn.<namsid>.0, where 
nn ranges from 00-99 and has the highest index (nn). A new target MCF 
with the next index in the sequence is created. The download fails if 
MC.<key>99.<namsid>.0 exists. 

• Dated specifies the date used to search for the MCF to be downloaded. 
You must specify a date each time a download takes place. A dated MCF 
has the format: MC.<yymmdd>nn.<namsid>.0, where nn ranges from 
00 to 99. The MCF with the highest index (nn) is found, and the next 
MCF in the sequence is created. The download fails if 
MC.<yymmdd>99.<namsid>.0 exists. See“Dated algorithm” (page 45) 
for more information on the date format.

Download type
Download type indicates whether downloads should be incremental or 
complete. 

• Incremental creates only the MCFs that have been modified. 

• Complete creates all MCFs supported by DPN. These MCFs will be 
named, based on what you have specified for Download Mode. 
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Download target
Download target indicates the mode that the tool uses to determine the 
destination for the new MCF. You may select one of three modes:

• Default destination downloads the MCF to the target location from 
which it was uploaded. This location could be either the NMS disk or a 
PM. 

• NMS disk downloads the MCF to the workstation directory indicated by 
the PFA.cfg file. 

• PM downloads the MCF to the PM. A data entry field will be displayed 
in which the mnemonic of the PM may be entered. 

Selected Global Data Components window
This window displays the set of available global data components. 

When the process is started, the components you have selected in this list are 
copied from the global data MCF to the target MCF. The target MCF’s old 
global data components are replaced. 

Run button
Click this button to start the replacement process. 

Messages area
This area is used to display informative messages on the current status of the 
application. The following commands are available:

• Select all selects all of the text in the message area. 

• Deselect deselects the selected text in the message area. 

• Copy copies selected text to a cut buffer. 

Component Information dialog
This dialog displays the FA category names associated with the global data 
component selected from the anchor window components list. These FA 
categories show which components are actually copied from the global data 
MCF to the download target MCF. Only expert users are likely to understand 
FA category names. 
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Command File
This dialog allows you to enter the name of the command file you wish to use. 
The file name can be entered directly into the Command file data entry field, 
or the Directories and Files lists can be used to find the desired command file. 

The dialog initially opens with the current directory entered. To change 
directories, either select a directory from the Directories list and then select 
the Change directory button, or double click the directory in the list. You can 
navigate a directory tree by successively moving through directories in the 
list. 

Once you are in the correct directory, the command file can be chosen either 
by selecting the command file in the Files list and then selecting the Run 
Command File button, or double clicking the command file in the list. 

• Run Command File uses the command file in the data entry field to 
control the service data replacement process. 

• Change directory moves from the current directory to the directory 
selected in the Directories list. 

• Cancel ignores any changes made in this dialog since it was popped up 
and returns to the main window. 

Global Data dialog
This dialog allows you to specify the Global Data parameters.

Global data MCF upload parameters
Enter the upload mode and source information in this area. The parameters 
will be used for uploading the global data MCF, which is the MCF that 
contains the global data needed to update the target MCF. 

Upload mode
Upload mode indicates the search mode that the tool uses to find the name of 
the global data MCF to be uploaded. You may select one of four modes. 

• User specified allows you to specify that the name of an MCF will be 
used to search for the MCF to be uploaded. Each time an upload takes 
place, you must specify the bundle and NAMS ID of the desired MCF. 
The search string used is:
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• MC.<bundle>.<namsid>.0 

• Keyed allows you to specify that a key will be used to search for the MCF 
to be uploaded. You must specify a key each time an upload takes place. 
The search string used is: 

• MC.<key>nn.<namsid>.0, where nn ranges from 00 to 99. The MCF 
with the highest index (nn) is uploaded. 

• Dated allows you to specify that a date will be used to search for the MCF 
to be uploaded. You must specify a date each time an upload takes place. 
A dated MCF has the format: 

• MC.<yymmdd>nn.<namsid>.0, where nn ranges from 00 to 99. 
See“Dated algorithm” (page 45) for information on the date format.

• Using date mode is the same as keyed mode if an exact match exists for 
the date. However, when an exact match does not exist, the most recent 
MCF, relative to the date, is uploaded; that is, the dated MCF with the 
later date earlier than the given date. 

• Committed uploads the committed MCF on the PM. 

• Active uploads the active MCF on the PM. 

Upload source
Upload source indicates the method used to find the location of the global 
data MCF. You may select one of two modes: 

• PM searches for the global data MCF on the PM named in the data entry 
field. 

• NMS disk searches for the global data MCF in the workstation directory 
indicated by the PFA.cfg file. 

Selected Global Data Components
This is the set of available global data components. 

When the process is started, the components you have selected in this list are 
copied from the global data MCF to the target MCF. The target MCF’s old 
global data components are replaced. 
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A pop-up menu can be opened for each global data component in the list. 

• Component Information opens the Component Information dialog for 
each component. 

• Select All selects all the components in the list. 

• Deselect All deselects all the components in the list. 

Transaction File dialog
This dialog allows you to enter the name of the Routing data transaction file 
you wish to use. The file name can be entered directly into the Routing data 
transaction file data entry field, or the Directories and Files lists can be used 
to find the desired Routing data transaction file. 

The dialog initially opens with the current directory displayed. To change 
directories, either select a directory from the Directories list and then select 
the Change directory button, or double click the directory in the list. You can 
navigate a directory tree by successively moving through directories in the 
list. 

Once you are in the correct directory, the Routing data transaction file can be 
chosen either by selecting the transaction file in the Files list and then 
selecting the Use Transaction File button, or double clicking the log file in the 
list. The following commands are available

• Use Transaction File uses the Routing data transaction file in the data 
entry field for the service data replacement process when the Run button 
on the main window is selected. 

• Change directory moves from the current directory to the directory 
selected in the Directories list. 

• Cancel ignores any changes made in this dialog since it was popped up 
and returns to the main window. 

Replacing selected global data components using the GUI
Global data components can be replaced using the graphical user interface 
(GUI) of the Global Data Manager tool. The GUI can be used with or without 
a command file. For more information on command files, see “Global data 
components command file” (page 150).
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Replacing selected global data components without a 
command file

1 In the DPN Global Data Manager window, in the Application type section 
select Global data.

2 As an option, you can enter a PM in the Target module area.

This PM indicates the module the MCFs apply to. If this option is 
specified, the Upload source in the Target MCF upload parameter section 
is optional.

3 Click Set Source Parameters.

The Global Data dialog is displayed.
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4 In the Global Data MCF Upload parameters section select an upload 
mode and an upload source.

5 Select the components you wish to replace.

6 Click OK.

The main window is displayed.

7 In the Target MCF upload parameters area select an upload mode and 
upload source.

If a PM has been specified in the Target module area, the Upload source 
is optional. 

8 In the Target MCF download parameters area select a download mode, 
download type and a download target.

9 Click Run.

Authentication is performed. If for any reason the authentication process 
fails, an error message appears in the message area. You can modify the 
authentication parameters by selecting Authenticate... from the Security 
menu. 

Replacing selected global data components using a 
command file

1 Using a UNIX editor such as vi, create a command file as described in 
“Global data components command file” (page 150).

2 On the GDM main window, in Application type section select Global data.

3 From the Options menu choose Run Command File... .
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The DPN Global Data Manager - Command file dialog is displayed. 

4 Select the directory and enter the name of the command file.

5  Click Run Command File.

Log file
A log file contains processing and error messages generated by the 
application. Logging can be enabled by means of the graphical user interface 
or command line.

Running a log file from the GUI
1 From the File menu choose Log to File... .
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The Log File dialog is displayed. 

2 Select the directory and enter the log file name.

The Log file data entry field is displayed with the default log file name.

3 Click Log to File.

How to stop logging
1 From the File menu choose Stop Logging.

The menu item will toggle to Log to File... .

Replacing selected global data components using the 
command line interface

Global data components can be replaced using the command line interface of 
the GDM tool. The command line can be used with or without a command 
file.

Enter the following command syntax as one continuous command.

Command line syntax without a command file
/opt/MagellanNMS/bin/gdm [<target_module>]

-gduploadmode <upload_mode> [<upload_bundle_date_key>
[<upload_NAMS ID>]]
-gduploadlocation <location_mode> [<pm_mnemonic>]
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[-component <component_name>...]
-uploadmode <upload_mode> [<upload_bundle_date_key>
[<upload_NAMS ID>]]
[-uploadlocation <location_mode> [<pm_mnemonic>]]
-downloadmode <download_mode>
[<download_bundle_date_key> [<download_NAMS ID>]]
-downloadlocation <location_mode>[<pm_mnemonic>]]
[-ncs <destination_mnemonic> <capability_id>
<password>] [-manual] [-overrideownership] 
[-log [<logfilename>]] [-downloadcomplete]

Command line syntax with a command file
/opt/MagellanNMS/bin/gdm -f <commandfilename>

-ncs <destination_mnemonic> <capability_id> <password>
[-log [<logfilename>]]

Note: Input is not case sensitive, except for <commandfilename> and 
<logfilename>.

where:

<target_module>

The module name which the target MCF applies to. Defaults to the 
upload location.

- gduploadmode <upload_mode> [<upload_bundle_date_key> 
[<upload_NAMSID>]]

Specifies the MCF to be uploaded that contains the global data 
components that are to replace components in other MCFs.

<upload_mode> Indicates the mode to be used for uploading the MCF. 
Valid: COMMITTED, ACTIVE, USER_SPECIFIED, KEYED, or 
DATED. Note that upload_location NMS_DISK is not valid in 
combination with upload_mode COMMITTED or ACTIVE. 
<upload_bundle_date_key> Indicates the bundle/key for the upload. 
If upload_mode = USER SPECIFIED, this is treated as a bundle.
If upload_mode = KEYED, this is treated as a key.
If upload_mode = COMMITTED or ACTIVE, the bundle_date_key 
cannot be present.
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If upload_mode = DATED, this is treated as a date key.
Valid: If a date, only valid dates in the format yymmdd. See “Dated 
algorithm” (page 45) for more information on the date format. If a key, 
1-6 (bundle 1-8) characters (letters, numbers and underscores).
<upload_NAMSID> Indicates the NAMS ID for the upload. 
Valid: Numeric 256-49151.

-gduploadlocation <location_mode> [<pm_mnemonic>]

Specifies the location of the MCF to be uploaded.

<location_mode> Indicates the type of location that contains the MCF. 
Valid: USER_SPECIFIED or NMS_DISK.
<pm_mnemonic> Provides a means of identifying the PM from which 
the MCF is to be uploaded. It may include routing information, for 
example, SUP TOR5-R99.

-component <component_name>

Optional parameter that specifies the name of a global data component to 
be replaced. If this parameter is not specified, all supported global data 
components are replaced. 
<component_name> The following global data components are 
supported: Network_Env, Large_VC_Window_Env, Accounting_Env, 
Access_To_Call_Redirection, Access_To_NUI_Validation, 
Source_Call_Router, Gateway_Call_Router, RID_Routing, 
ITI_Ntwk_Prof_Env, ITI_Videotex, Call_Redirection_Server, 
NDI_GMS_List

-uploadmode <upload_mode> [<upload_bundle_date_key> 
[<upload_NAMSID>]]

Specifies the MCF to be uploaded that contains the global data 
components to be replaced.

<upload_mode> Indicates the mode to be used for uploading an MCF. 
Valid: COMMITTED, ACTIVE, USER_SPECIFIED, KEYED, or 
DATED. Note that upload_location NMS_DISK is not valid in 
combination with upload_mode COMMITTED or ACTIVE. 
<upload_bundle_date_key> Indicates the bundle/key for the upload. 
If upload_mode = USER SPECIFIED, this is treated as a bundle.
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If upload_mode = KEYED, this is treated as a key.
If upload_mode = COMMITTED or ACTIVE, this cannot be present.
If upload_mode = DATED, this is treated as a date key.
Valid: If a date, only valid dates in the format yymmdd. See “Dated 
algorithm” (page 45) for more information on the date format. If a key, 
1-6 (bundle 1-8) characters (letters, numbers and underscores).
<upload_NAMSID> Indicates the NAMS ID for the upload. 
Valid: Numeric 256-49151.

-uploadlocation <location_mode> [<pm_mnemonic>]

Specifies the location of the MCF that contains components to be 
replaced.

<location_mode> Indicates the location of the MCF to be uploaded. 
Mandatory in routing data transaction file mode. Optional in global data 
mode. For upload, default is target_module. For download default is 
upload location. Valid: USER_SPECIFIED or NMS_DISK. Note that 
location_mode NMS_DISK is not valid in combination with 
upload_mode COMMITTED or ACTIVE.
<pm_mnemonic> Provides a means of identifying the PM. It may include 
routing information, for example, SUP TOR5-R99.

-downloadmode <download_mode> [<download_bundle_date_key> 
[<download_NAMSID>]]

Specifies the MCF into which replacement components are to be 
downloaded.

<download_mode> Indicates the mode to be used for downloading the 
MCF. Valid: USER_SPECIFIED or KEYED.
<download_bundle_date_key> Indicates the bundle/key for the 
download.
If upload_mode = USER SPECIFIED, this is treated as a bundle.
If upload_mode = KEYED, this is treated as a key.
If upload_mode = COMMITTED or ACTIVE, this cannot be present.
If upload_mode = DATED, this is treated as a date key.
Valid: If a date, only valid dates in the format yymmdd. See “Dated 
algorithm” (page 45) for more information on the date format. If a key, 
1-6 (bundle 1-8) characters (letters, numbers and underscores).
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<download_NAMS ID> Indicates the NAMS ID for the download. If the 
NAMS ID is not specified, the NAMS ID of the uploaded MCF is used. 
For example, if MC.MYBUNDLE.9999.0 is uploaded, and the 
download_NAMS ID is not specified, NAMS ID 9999 is used for the 
download. Valid: Numeric 256-49151

-downloadlocation [<location_mode> [<pm_mnemonic>]]

Specifies the location of the MCF into which the replacement 
components are to be downloaded.

<location_mode> Indicates the location of the MCF to download that 
contains the replacement components. Valid: USER_SPECIFIED or 
NMS_DISK. Note that upload_location NMS_DISK is not valid in 
combination with upload_mode COMMITTED or ACTIVE. 
<pm_mnemonic> Provides a means of identifying the PM. It may include 
routing information, for example, SUP TOR5-R99.

-ncs <destination_mnemonic> <capability_id> <password>

Mandatory option to use network control system (NCS) authentication.

<destination_menmonic> NCS mnemonic of the operations agent 
(OA) interface.
<capabilities> NCS capability id
<password> NCS capability password

-manual

Indicates manual NCS access mode. Authentication with NCS is 
bypassed if this option is specified.

-overrideownership

No longer used.
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-log [<logfilename>

Option to specify that messages are to be logged to a file.

<logfilename> Absolute or relative path name for the file to which the 
messages are to be added. If the log file already exists, any additional 
message information will be appended to the file. Default filename is 
gdm.log. The log file name is case sensitive.

-f <commandfilename>

Specifies the name of a command file that contains instructions for 
replacing global data components.

<commandfilename> The absolute path name for the file that contains 
the commands. The command file name is case sensitive.

Global data components command file
A command file can be used to replace selected data components. Using a 
UNIX editor such as vi, create a command file.

The following command line parameters are ignored if the command file (-f) 
option is specified: <target_module>, -gduploadmode, -gduploadlocation, 
-uploadmode, -uploadlocation, -downloadmode, -downloadlocation

Command file format
 A command file accepts three formats of records. These records may be in 
any order in the file. Each command file record is entered on one line in the 
command file.

• Global Data MCF record:

-gduploadmode <upload_mode> [<upload_bundle_date_key> 
 [<upload_NAMS ID>]] -gduploadlocation <location_mode>
 [<pm_mnemonic>]

If this record type is specified more than once, the last specification is 
used.
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• Target MCF record:

[<target_module>] -uploadmode <upload_mode>
 [<upload_bundle_date_key> [<upload_NAMS ID>]] 
 [-uploadlocation <location_mode> [pm_mnemonic>]] 
 -downloadmode <download_mode>
 [<download_bundle_date_key> [<download_NAMS ID>]] 
 [-downloadlocation <location_mode> [<pm_mnemonic>]]

• Miscellaneous parameters:

[-component <component_name>..] [-log [<logfilename>]]

If more than one <component_name> is specified, each 
<component_name> is added to the list of components to be processed. 
If <logfilename> is specified more than once, only the last <logfilename> 
specified is used.

Example 1
In the following example, the command file turns logging on and puts all 
logs in a file called cmd.log. It then uploads the master user data with key 
GLOBAL and NAMS ID 4034 (that is, MC.GLOBALxx.4034.0) from 
the NMS_DISK (n). It then states that the target to be updated has key 
KA and NAMS ID 4034 (that is, MC.KAxx.4034.0) and is from the 
NMS_DISK. Once the target is updated it downloads with key KA, using 
the same NAMS ID and location, that is, MC.KAxx.4034.0 to 
NMS_DISK.

########### Start of command file #############
#log to cmd.log
-log cmd.log

# use master with key=GLOBAL NAMS ID=4034 from NMS_DISK
-gduploadmode k global 4034 -gduploadlocation n

# update R34 with key=KIRK NAMS ID=4034 from NMS_DISK
# download with key=KA NAMS ID=4034 to NMS_DISK
r34 -uploadmode k kirk 4034 -uploadlocation n 
-downloadmode k kirk
########### End of command file #############
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Example 2
In the following example, the command file turns logging on so that all 
logs will go to the default log gdm.log. It indicates the only global 
component it wishes to upload is the network_env component. It will get 
the data it needs from the MCF with key Global and the default 
NAMSID. The MCF is residing on PM R34. Then MCFs with key KA 
and default NAMSID are targeted on PMs R30 through R37. In each case 
the MCF is found, the network_env data updated and the MCF 
downloaded to the respective PM. As a last step the MCF with bundle 
91WK44, default NAMS ID is uploaded from PM R34, the network_env 
data updated, and then updated MCF is downloaded with bundle 
91WK44XX, default NAMS ID, to the NMS disk. 

############# Start of command file ############
# log to default file 
-log 

# only update network_env
-component network_env

# use master with key=GLOBAL NAMS ID=default from PM 
R34
 
-gduploadmode k global -gduploadlocation user_spec r34

# update target with key=KIRK NAMS ID=default from PM
# download with key=KIRK NAMS ID=default to same PM

r30 -uploadmode k kirk -downloadmode k kirk
r31 -uploadmode k kirk -downloadmode k kirk
r32 -uploadmode k kirk -downloadmode k kirk
r33 -uploadmode k kirk -downloadmode k kirk
r34 -uploadmode k kirk -downloadmode k kirk
r35 -uploadmode k kirk -downloadmode k kirk
r36 -uploadmode k kirk -downloadmode k kirk
r37 -uploadmode k kirk -downloadmode k kirk

# update R34 with bundle=91WK44 NAMS ID=default from 
PM R34
# download with bundle=91WK44XX NAMS ID=default to 
NMS_DISK
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r34 -uploadmode user_specified 91WK44
 -downloadmode u 91WK44XX -downloadlocation n
 ########### End of command file ############# 

Example 3
In the following example, MC.BUNDLE1.9999.0 from PM CENTRAL 
is used as the master global data MCF. The command uploads 
MC.BUNDLE2.1234.0 from TOR1, updates it and downloads it as 
MC.MYKEYnn.1234.0 (where nn is next latest index) to TOR1. It 
attempts to update all supported components.

/opt/MagellanNMS/bin/gdm tor1 -ncs myoa mycapid
mypasswd -gduploadmode u bundle1 9999 
-gduploadlocation u CENTRAL -uploadmode u bundle2 1234
-downloadmode k mykey 

Example 4
The following example, MC.BUNDLE1.9999.0 from PM CENTRAL is 
used as the master global data MCF. This command uploads 
MC.MYKEYnn.1234.0 (where nn is latest index) from TOR1, updates it 
and downloads it as MC.MYKEYnn.1234.0 (where nn is next latest 
index) to NMS_DISK. It attempts to update only the NETWORK_ENV 
component. 

/opt/MagellanNMS/bin/gdm tor1 -ncs myoa mycapid
mypasswd -gduploadmode u bundle1 9999 
-gduploadlocation u CENTRAL -uploadmode k mykey 1234 
-component NETWORK_ENV -downloadmode k mykey 
-downloadlocation n

Updating preferred service path data using the command 
line interface

Preferred service path data in an RM with routing data from a transaction file 
can be updated by means of the command line interface of the GDM tool.

You can use the GDM tool with or without a command file. A command file 
is useful when you wish to apply the transaction file to more than one RM at 
a time. If you do not use a command file, you must enter a separate command 
for each RM whose service data you wish to update.
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For more information on command files see “Preferred service path data 
command file format” (page 157).

Enter the following command syntax as one continuous command.

Command line format without a command file
/opt/MagellanNMS/bin/gdm 

-uploadmode <upload_mode> [<upload_bundle_date_key>
[<upload_NAMS ID>]]
-uploadlocation <location_mode> [<pm_mnemonic>]
-downloadmode <download_mode>
[<download_bundle_date_key> [<download_NAMS ID>]]
[-downloadlocation <location_mode>[<pm_mnemonic>]]
-ncs <destination_mnemonic> <capability_id> <password>
[-log [<logfilename>]] [-overrideownership] 
[-downloadcomplete]

Command line format with a command file
/opt/MagellanNMS/bin/gdm 

-ncs <destination_mnemonic><capability_id><password>
[-log [<logfilename>]]
[-overrideownership] [-downloadcomplete]

Note: Input is not case sensitive, except for <commandfilename> and 
<logfilename>.

where:

-uploadmode <upload_mode> [<upload_bundle_date_key> 
[<upload_NAMS ID>]]

Specifies the MCF to be uploaded that contains the routing data to be 
updated.

<upload_mode> Indicates the mode to be used for uploading an MCF. 
Valid: COMMITTED, ACTIVE, USER_SPECIFIED, KEYED, or 
DATED. Note that upload_location NMS_DISK is not valid in 
combination with upload_mode COMMITTED or ACTIVE. 
<upload_bundle_date_key> Indicates the bundle/key for the upload. 
If upload_mode = USER SPECIFIED, this is treated as a bundle.
If upload_mode = KEYED, this is treated as a key.
If upload_mode = COMMITTED or ACTIVE, this cannot be present.
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If upload_mode = DATED, this is treated as a date key.
Valid: If a date, only valid dates in the format yymmdd. See “Dated 
algorithm” (page 45) for more information on the date format. If a key, 
1-6 (bundle 1-8) characters (letters, numbers and underscores).
<upload_NAMS ID> Indicates the NAMS ID for the upload. 
Valid: Numeric 256-49151.

-uploadlocation <location_mode> [<pm_mnemonic>]

Specifies the location of the MCF that contains components to be 
replaced.

<location_mode> Indicates the location of the MCF.
Valid: USER_SPECIFIED or NMS_DISK. Note that upload_location 
NMS_DISK is not valid in combination with upload_mode 
COMMITTED or ACTIVE. 
<pm_mnemonic> Provides a means of identifying the PM. It may include 
routing information, for example, SUP TOR5-R99.

-downloadmode <download_mode> [<download_bundle_date_key> 
[<download_NAMS ID>]]

Specifies the MCF into which replacement components are to be 
downloaded. 

<download_mode> Indicates the mode to be used for downloading the 
MCF. Valid: USER_SPECIFIED or KEYED 
<download_bundle_date_key> Indicates the bundle/key for the 
download.
If upload_mode = USER SPECIFIED, this is treated as a bundle.
If upload_mode = KEYED, this is treated as a key.
If upload_mode = COMMITTED or ACTIVE, this cannot be present.
If upload_mode = DATED, this is treated as a date key.
Valid: If a date, only valid dates in the format yymmdd. See “Dated 
algorithm” (page 45) for more information on the date format. If a key, 
1-6 (bundle 1-8) characters (letters, numbers and underscores).
<download_NAMS ID> Indicates the NAMS ID for the download. If the 
NAMS ID is not specified, the NAMS ID of the uploaded MCF is used. 
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For example, if MC.MYBUNDLE.9999.0 is uploaded, and the 
download_NAMS ID is not specified, NAMS ID 9999 is used for the 
download. Valid: Numeric 256-49151

[-downloadlocation [<location_mode> [<pm_mnemonic>]]

Specifies the location of the MCF into which the replacement 
components are to be downloaded. If not specified, the same download 
location is used as the upload location. 

<location_mode> Indicates the location of the MCF to download that 
contains the replacement components. Valid: USER_SPECIFIED or 
NMS_DISK. Note that upload_location NMS_DISK is invalid in 
combination with upload_mode COMMITTED or ACTIVE. 

<pm_mnemonic> Provides a means of identifying the PM. It may include 
routing information, for example, SUP TOR5-R99.

-ncs <destination_mnemonic> <capability_id> <password>

Mandatory option to use network control system (NCS) authentication.

<destination_menmonic> NCS mnemonic of the operations agent 
(OA) interface.
<capability_id> NCS capability id
<password> NCS capability password

[-overrideownership]

No longer used.

[-log [<logfilename>]

Specifies that you wish a file to be created and messages from the GDM 
tool added to that file. 

<logfilename> Absolute path name for the file to which the messages 
are to be added. The log file name is case sensitive.

[-downloadcomplete]

Optional, specifies that a complete download is to take place.
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Preferred service path data command file format
A command file can be used to apply the transaction file to more than one RM 
at a time. If you do not use a command file, you must repeat the procedure 
once for each RM whose preferred path service data you wish to update. The 
command file is created with a UNIX editor, for example, vi. A command file 
can be used from the GUI or command line interface.

Command file format
The command file used for updating preferred service path data accepts 
records in the following formats. Each command file format is entered on one 
line in the command file.

• Routing data transaction file record:

-routingtransactionfile
[<routing_data_transaction_file>]

• Target MCF record

-uploadmode <upload_mode> [upload_bundle_date_key 
[upload_NAMS ID]]
[-uploadlocation <location_mode> [pm_mnemonic]]
-downloadmode <downloadmode> 
[<download_bundle_date_key>]
[download_NAMS ID]]
[-downloadlocation <location_mode> [pm_mnemonic]]
[-downloadcomplete}

• Miscellaneous parameters

[- log [<logfilename>]
[-routingtransactionfile 
<routing_data_transaction_file>]

Note: If the -log option or the -routingtransactionfile option is specified 
in both the command file and the command line, the file specified in the 
command file will be used. That is, the command line is ignored.

Example 1
This command file turns on logging and adds all logs to the cmd.log file. 
It uses routing data information from the routing data transaction file 
<routing_data_transaction_file>. The routing data in the transaction file 
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is to be applied against the MCF which has the key called kirk, a NAMS 
ID of 4034, and is from NMS_DISK. Once the MCF is updated, it is 
downloaded with key kirk with the same NAMS ID and location.

########### Start of command file #############
# log to cmd.log
-log cmd.log

# routing data transaction file is in the user
# specified file named <routing_data_transaction_file>
-routingtransactionfile 
<routing_data_transaction_file>

# upload and download with key = kirk, NAMS ID = 4034 
from NMS_DISK
-uploadmode k kirk 4034 -uploadlocation n -
downloadmode k kirk

########### End of command file #############

Example 2
This command file turns on logging and adds all logs to the default 
cmd.log file. It uses routing data information from the routing data 
transaction file. The routing data in the transaction file is to be applied 
against the MCFs with the key called kirk, the default NAMS ID, and 
residing in PMs R30 through R37. In each case, the resulting MCF is 
downloaded to the PM from which the original MCF was uploaded.

 The last step in the command file uploads the MCF with bundle 
91WK44 and the default NAMS ID from PM R34 then downloads it with 
bundle 91WK44XX, and the default NAMS ID, to the NMS disk after the 
MCF is updated with the routing information.

########### Start of command file #############
# log to default file
- log

# transaction file is in the user specified file named
# <routing_data_transaction_file>

-routingtransactionfile 
<routing_data_transaction_file>
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# update target with key=kirk NAMS ID=default to same 
PM
-uploadmode k kirk -uploadlocation u r30 -downloadmode 
k kirk
-uploadmode k kirk -uploadlocation u r31 -downloadmode 
k kirk
-uploadmode k kirk -uploadlocation u r32 -downloadmode 
k kirk
-uploadmode k kirk -uploadlocation u r33 -downloadmode 
k kirk
-uploadmode k kirk -uploadlocation u r34 -downloadmode 
k kirk
-uploadmode k kirk -uploadlocation u r35 -downloadmode 
k kirk
-uploadmode k kirk -uploadlocation u r36 -downloadmode 
k kirk
-uploadmode k kirk -uploadlocation u r37 -downloadmode 
k kirk

# update target with bundle = 91WK44 NAMS ID = default 
from PM R34
# download with bundle = 91WK44 NAMS ID=default to 
NMS_DISK
-uploadmode user_specified 91WK44 -uploadlocation u 
r34
-downloadmode u 91WK44 -downloadlocation n

########## End of command file #########
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Chapter 6
Service Data Backup

The Service Data Backup tool is used to create backups for master 
configuration files (MCFs), either on an NMS or other backup disk, or on 
DPN modules. Backups are only created for a complete set of MCFs (those 
specified in the MCF directory file); the Backup tool will not create a backup 
for a single MCF. These backups can be created either automatically or 
manually.

Automatic or Manual backups
The Service Data Backup tool may be configured to perform a backup either 
automatically, whenever an MCF is downloaded, or manually, as the user sees 
fit. To determine whether manual or automatic backup is set, configure the 
AUTO_BACKUP parameter in the PFA.cfg file. See 241-6001-304 Preside 
MDM Configuration Management Administrator Guide for more 
information.

The Backup Directory is a PFAS configuration parameter. This directory is 
used when auto-backup is set in the PFAS configuration file. This directory 
can be the same as the NMS disk directory. 

Backup MCFs take the form: B_<MCF name>.

Backup to disk
The B_MCFs are sent to disk by PFAS directly, that is, without going through 
the DPN network. It is possible to have as many backup sites as workstations 
running PFAS or as few as a single backup site, by mounting the backup 
directory on each workstation running PFAS. The Backup disk can be local 
or nfs mounted.
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The Service Data Backup tool’s GUI
The Service Data Backup tool’s graphical user interface allows you to 
perform the following functions:

• authentication

See “Using the Connection Manager” (page 51)

• start up the Service Data Backup tool

See “Using the Service Data Backup tool” (page 166)

• connect to the DPN module

See “Connecting to modules” (page 167)

• retrieve a list of MCF directory files

See “Retrieving a list of MCFs” (page 167)

• create MCF backups

See “Creating MCF backups” (page 167)

• connect to a different module during the session

See “Connecting to a different module” (page 167)

• reconnect to a module

See “Reconnecting to a module” (page 168)

Data Backup GUI commands and fields
The Data Backup graphical user interface contains the following items:

• a menu bar that contains:

— a File menu

See “File menu” (page 173).

— a Security menu

See “Security menu” (page 173).
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— a Help menu

See “Help menu” (page 55).

• a SOURCE area that contains:

— a PM name field

See “PM name field” (page 173).

— an MCF field

See “MCF name field” (page 165).

— a Connect button

See “Connect PM button” (page 173).

— a List MCFs button

See “List MCFs button” (page 165).

• an MCFs list area that contains a scroll area and a Backup Selected MCFs 
button

See “List MCFs area” (page 165) and “Backup Selected MCFs” 
(page 165).

• a Messages area that contains a Verbose button.

See “Message area” (page 58) and “Verbose” (page 58).

See the figure “Service Data Backup tool” (page 164).
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Figure 11
Service Data Backup tool
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MCF name field
Enter the name of the master configuration file (MCF) here. You can enter the 
MCF name in either upper or lower case, since translation to upper case is 
automatic. 

The format for an MCF name is 

B_MC.<bundle_name>.<NamsId>.DIR 

For example, if the bundle name is BUNDLE01
the tool will look for the bundle

B_MC.BUNDLE01.<NamsId>.DIR

The default is 

B_MC.*.DIR 

List MCFs button
Click List MCFs to retrieve a list of backup MCFs on the backup system.

This button is enabled when a valid PM name is entered in the PM field.

List MCFs area
This scrolling area lists specified MCF sets on the DPN-100 module. From 
this area, the mouse buttons can be used to select or deselect list items. 

Backup Selected MCFs
Click the Backup Selected MCFs button to retrieve the directory for the 
selected MCF, and send a backup creation request for each MCF in this 
directory. If the backup already exists on the DPN-100 module, the tool 
continues to the next MCF. See “Creating MCF backups” (page 167) for the 
related procedure.

This button is enabled once a set of MCFs has been listed. 

Re-authentication dialog
This dialog asks you to confirm that you want to close the PM connection by 
performing an authentication. 
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Authentication will reset the MCF field to its default value (MC.*.DIR) and 
the MCF list will be reset to an empty list. 

Authentication Failed dialog
The Service Data Backup tool cannot communicate with NCS. Clicking the 
OK button will attempt to authenticate. If this doesn't solve the problem, 
restart the tool. If the problem persists, report it to the System Administrator. 

Confirm PM Change dialog
This dialog opens when the value in the PM field has changed. You are asked 
to confirm that you want to close the actual PM connection to open a new one. 

The MCF list will be reset to an empty list. 

Open Session Failed dialog
This dialog opens when a PM connection attempt failed. Verify the value of 
the PM field. Verify if you need re-authentication (not the same network 
destination). 

Confirm MCF Change dialog
This dialog opens when the value of the MCF field has changed and a list 
already exists. You are asked to confirm that you want to change the MCF 
field. Changing the MCF field has the effect of discarding the list and building 
a new one from the new value of the MCF field. 

Reset MCF List dialog
This dialog opens when the List MCFs button is pressed while a list already 
exists. You ares asked to confirm that you want to discard the list and build a 
new one. 

Using the Service Data Backup tool
1 From the Preside MDM window, select Configuration -> DPN Devices -> 

Administration -> Service Data Backup . 

The tool (see the figure “Service Data Backup tool” (page 164)) and the 
Authentication window are displayed.

2 In the Authentication window, fill in the Destination, User Id, and Password 
fields and click Authenticate.

 The user can now proceed as usual to perform the backup operation.
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Retrieving a list of MCFs
The List MCFs command is used to display a group of MCF directory files 
that are candidates for backup, on a particular packet module (PM).

1 Enter the PM mnemonic and click Connect or press Return to connect to 
the module. 

The List MCFs button is enabled when a connection is established with 
the PM displayed in the PM data entry field.

2 Enter the MCF directory pattern in the MCF data entry field if you wish to 
retrieve a list based on a particular search criterion other than the 
supplied default (MC.*.DIR). 

The specified pattern must begin with MC. and end with.DIR. A wildcard 
character * can be specified in the pattern, for example MC.AB*.DIR.

3 Click List MCFs. 

A list of MCF directory files is displayed in the MCFs on PM disk field. 

If you wish to retrieve a new list of MCF directory files, repeat steps 2 and 
3. A dialog appears asking you to confirm the List MCFs operation. 

Creating MCF backups
The MCF backup process creates a backup for each selected MCF on the 
module. The Backup Selected MCFs command is used to create an exact copy 
of the MCF on the module by prefixing B_ to the MCF name.

1 Select one or more MCF(s) from the MCFs on PM disk list.

The selected MCFs are displayed in reverse video.

2 Click Backup Selected MCFs.

A backup is created for each MCF directory selected. 

Connecting to modules
This section explains how to connect or reconnect to a module.

Connecting to a different module 
After performing operations on the connected module, you can connect to a 
different module on the same or different OA during the current session.
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How to connect to a different module on the same OA
1 Change the PM mnemonic in the PM data entry field and click Connect or 

press Return.

A dialog is displayed asking you to confirm the operation.

2 Click OK.

3 Follow the steps in “Retrieving a list of MCFs” (page 167).

How to connect to a module on a different OA
If the module resides on a different OA domain, authentication must be 
repeated.

1 Choose Authenticate... from the Security menu.

A dialog is displayed asking you to confirm the operation.

2 Click OK.

The Connection Manager dialog is displayed.

3 Enter the necessary information and click Authenticate.

If the authentication is successful, the Connection Manager dialog is 
closed.

4 Follow the steps in “Retrieving a list of MCFs” (page 167).

Reconnecting to a module 
When the X.25 connection to a module is disconnected, you can reconnect to 
the module at any time during the current session. 

The Reconnect PM menu item will become enabled indicating that the 
connection is down and action must be taken to continue. 

1 Choose Reconnect PM from the Security menu to re-establish the 
connection to a module.
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Service Data Restore

The Service Data Restore tool is an application that retrieves backup master 
configuration file (MCF) directory files from the Backup disk and restores the 
MCFs to the specified packet module (PM). The Service Data Restore tool 
lets you perform the following functions: 

• authentication

See “Using the Connection Manager” (page 51).

• start up the Service Data Restore tool

See “Using the Service Data Restore tool” (page 175).

• retrieve a list of MCF directory files from the Backup disk

See “Retrieving a list of MCFs from a Backup site” (page 175).

• restore selected MCF directory files

See “Restoring MCFs to a module” (page 176) or “Restoring MCFs to a 
different module” (page 176).

• keep selected MCF directory files

See “Deleting backup MCFs from a Backup site” (page 176).

• reconnect to a module

See “Reconnecting to a module” (page 177).
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Opening the DPN Service Data Restore tool
From the Preside MDM window, select Configuration -> DPN Devices -> 
Administration -> Service Data Restore.

The DPN Service Data Restore tool and the Authentication window open.

The Restore tool’s GUI
The DPN Service Data Restore tool’s graphical user interface (GUI) contains 
the following items:

• a Menu bar that contains:

— a File menu

See “File menu” (page 173).

— a Security menu

See “Security menu” (page 173).

— a Help menu

See “Help menu” (page 55).

• a TARGET area that contains:

— a PM name field

See “PM name field” (page 173).

— a Connect button

See “Connect PM button” (page 173).

• a SOURCE area that contains:

— a NAMSID field

See “NAMS ID field” (page 173).

— a Bundle name field

See “Bundle name field” (page 173).
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— a List MCFs button

See “List MCFs button” (page 174)

• an MCFs on backup site area that contains:

— a scroll area

See “List MCFs area” (page 174).

— a Restore Selected MCFs button

See “Restore Selected MCFs button” (page 175).

— a Keep Selected MCFs button

See “Keep Selected MCFs button” (page 175).

• a Messages area that contains a Verbose button

See “Message area” (page 58) and “Verbose” (page 58).

See the figure “Service Data Restore tool” (page 172).
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Figure 12
Service Data Restore tool

Bundle
Name

NAMS ID
241-6001-012   14.3RSUP   



Chapter 7 Service Data Restore   173
File menu
Exit terminates the Service Data Restore tool. 

Security menu
The Security menu contains the following commands:

• Authenticate opens the Integrated Connection Manager window. 

• Reconnect PM manually re-establishes a connection to the DPN-100 
module. It is enabled if a Virtual Circuit error is detected while you are 
performing normal operations. 

Target area
Specify the backup target in this area.

PM name field
Enter the name of the target DPN-100 module here.   You can enter the target 
PM name in either upper or lower case, since translation to upper case is 
automatic. 

Connect PM button
This button establishes a connection to the PM. Hitting Return while the 
keyboard focus is in the PM field will also establish a connection to the PM. 

Source area
Specify the backup source in this area.

NAMS ID field
Enter the NAMS-ID of the PM that dumps the backup MCFs to the Backup 
site. The NAMS-ID must be a numeric string. 

Bundle name field
Enter the full bundle name here. You can enter it in either upper or lower case, 
since translation to upper case is automatic. 

The format for a full bundle name is 

B_MC.<bundle_name>.<NamsId>.DIR 
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For example, if the bundle name is BUNDLE01
the tool will look for the bundle

B_MC.BUNDLE01.<NamsId>.DIR

The default is 

B_MC.*.DIR 

List MCFs button
Click List MCFs to retrieve a list of backup MCFs on the backup system. 

This button is enabled when a valid NAMS-ID is entered in the NAMS-ID 
field. Hitting Return will also retrieve a list of backup MCFs on the backup 
system.

MCFs on Backup Site area
This area displays the list of MCFs on the selected Backup site, including 
bundle name and NAMS ID.

List MCFs area
This scrolling area lists the specified MCF sets on the Backup disk. By 
placing the pointer in the list area, you can select or deselect any list items 
with the mouse buttons. 

For selection or deselection of any list items, place the pointer in the list area: 

Click and drag the left button does a multiple select

Control-left button adds one item to the selection

Shift-left button completes the selection up to the 
clicked item

Right button displays a menu where you can 
select or deselect all the items in the 
list.
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Restore Selected MCFs button
Click Restore Selected MCFs to restore the selected MCF sets to the 
TARGET-PM.

Keep Selected MCFs button
Click Keep Selected MCFs to clean up the storage for MCF backups 
associated with a specific NAMS ID. 

Note: Activating the Keep Selected MCFs button causes all the MCFs 
associated with a NAMS ID and MCFs that do not belong to the selected 
MCF sets to be deleted. 

This button is enabled once a list of MCFs is retrieved. 

Using the Service Data Restore tool
1 From the Preside MDM window, select Configuration -> DPN Devices -> 

Administration -> Service Data Restore.

 The tool and the Authentication window appear.

2 In the Authentication window, fill in the Destination, User Id, and Password 
fields and click Authenticate.

 The user can now proceed as usual to perform the restore operation.

Retrieving a list of MCFs from a Backup site
The List MCFs command is used to list the backup files that have been saved 
to Backup from the specified PM.

1 Enter the NAMS ID of the PM from which the backup MCFs were spooled 
and press Return.

2 Enter the Bundle directory pattern in the Bundle data entry field if you 
wish to retrieve a list based on a particular search criterion other than the 
supplied default (B_MC.*.DIR).

The specified pattern must begin with B_MC. and end with.DIR. A 
wildcard character * can be specified in the pattern, such as 
B_MC.AB*.DIR. 

3 Click List MCFs.

The list of MCFs from the Backup site appears in the MCFs on Backup 
Site field. 
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If you wish to retrieve a new list of MCF directory files, repeat steps 2 and 
3. A dialog appears asking you to confirm the List MCF operation.

Restoring MCFs to a module
The Restore Selected MCFs command is used to copy backup MCF directory 
files from the Backup site to the specified PM. 

1 Enter the PM mnemonic and click Connect PM or press Return.

2 Select one or more MCF directory files from the list. 

The selected MCFs are displayed in reverse video.

3 Click Restore Selected MCFs to retrieve all MCFs belonging to the 
selected MCF directory files. 

If a selected MCF already exists on the DPN-100 module, a warning 
message is displayed and the tool continues with the remaining MCFs.

Restoring MCFs to a different module
After performing a restore operation to the connected module, you can restore 
MCFs to a different module. This can be done by connecting to a different 
module on the same or on a different OA without closing the current session.

1 Change the PM mnemonic in the PM data entry field and click Connect 
PM or press Return.

A dialog appears asking you to confirm the operation.

2 Click OK.

Deleting backup MCFs from a Backup site
The Keep Selected MCFs command is used to tidy backup MCFs on the 
Backup site associated with a specific NAMS ID.

1 Repeat steps 1-3 in the procedure “Retrieving a list of MCFs from a 
Backup site” (page 175).

2 Select the MCFs you want to keep. All unselected MCFs will be deleted. 

If no MCFs are selected, they will all be deleted.

3 Click Keep Selected MCFs to delete the unselected MCFs.

A dialog appears asking you to confirm the deletion of all unselected 
MCFs, including the MCFs which are not listed.
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4 Click OK.

The deletion process starts. All errors and status responses are displayed 
in the Messages area.

MCFs on the Backup disk can also be managed using the UNIX command 
line commands bddeletemcf and dbtidymcf (see “MCF management” 
(page 281) for details).

Reconnecting to a module
When the X.25 connection to the module is disconnected, you can reconnect 
to the module at any time during the current session.

The Reconnect PM menu item will become enabled indicating that the 
connection is down and action must be taken to continue. 

1 Choose Reconnect PM from the Security menu in the DPN Service Data 
Restore window  to re-establish a connection to the module.
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Chapter 8
Software Distribution

The Software Distribution tool lets you copy or download software images 
from a remote download site (RDS) or a software download site (SDS) to a 
target packet module (PM). 

The tool is accessible by means of the graphical user interface or a command 
line interface from a UNIX shell. If you use the command line interface, 
necessary information is entered as command parameters or it can be kept in 
a command file. You can also save messages in a file by enabling logging. 

See also...

• “Software Distribution main window” (page 179)

• “Copying images” (page 183)

• “Downloading images” (page 183)

• “Using the graphical user interface” (page 183)

• “Command line” (page 185)

Software Distribution main window
See the following sections for information on the parts of the Software 
Distribution main window:

• “Menu bar” (page 181)

• “Image source area” (page 181)”

• “Image selection area” (page 181)

• “Target PM field” (page 182)
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• “Copy Images button” (page 182)

• “Message area” (page 58)

See the figure “Software Distribution tool” (page 180).

Figure 13
Software Distribution tool
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.

Menu bar
The menu bar is located at the top of the Software Distribution main window. 
See the following sections for information on the menu bar entries:

• “File menu” (page 54)

• “Options menu” (page 54)

• “Security menu” (page 55)

• “Help menu” (page 55)

Image source area
Images can be distributed from either the remote download site (RDS) or the 
software download site (SDS). Select the appropriate button. 

Image selection area
The image selection area is used to identify one or more images for 
distribution from the SDS or RDS to the target PM. The button choices for 
image selection are: 

• File of image names downloads all images named in the text file to the 
target PM. The file format is one image per line.

• Image downloads the single image named in the data entry field. Image 
names have the form: <image name>.<extension>.

For example, PELFF2.PIMG9035.

• Root MCF downloads all images referenced in the named Root MCF to 
the target PM. Root-MCF names have the following format: 
MC.<bundle>.<NAMS ID>.0.

For example, MC.2830.4034.0.
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• Keyed MCF downloads all images referenced in the latest MCF with the 
specified key. Keys can be made up of letters, digits, and underscores. 
They cannot begin with an underscore, and they must be no more than six 
characters long. 

For example, if you specify DPNNMS as a key, the Root-MCF that 
matches the following criteria is located by the tool:

MC.DPNNMS<nn>.<NAMS ID of the target PM>.0, where nn ranges 
from 00-99 and is the highest index of the key DPNNMS that exists on 
the target PM. 

• Dated MCF downloads all images referenced in the latest MCF with the 
specified date key. Valid dates have the format yymmdd. See “Dated 
algorithm” (page 45) for more information on the date format. 

For example, if you specify 991231 as a key, the Root-MCF that matches 
the following criteria is located by the tool:

MC.991231<nn>.<NAMS ID of the target PM>.0, where nn ranges from 
00-99 and is the highest index of the date 991231 that exists on the target 
PM. 

Target PM field
Type the mnemonic of the PM to which the images are to be copied. You can 
also type NCS routing information as part of the PM mnemonic. 

To download selected images on the SDS to the RDS for future distribution, 
type the PM mnemonic of the RDS in this field. 

Copy Images button
To begin the copying of images from the SDS or RDS to the target PM, click 
Copy Images. 
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Copying images
Images can be copied from the RDS to a PM in the network by specifying a 
specific image, a file of images, or by specifying the MCF that contains the 
information for the images it requires. If many images need to be copied, they 
can be specified in a command file and run from the GUI or from the 
command line. 

Downloading images
Images can be downloaded from the SDS to an RDS module using the GUI 
or command line. If a command file is used it must contain the -src option to 
specify where the source images reside. The software download server must 
be running on the SDS before images can be downloaded. 

See 241-6001-304 Preside MDM Configuration Management Administrator 
Guide for information on how to populate the SDS.

Using the graphical user interface
You can use the following procedures to copy or download images in the 
network depending on the Image source selected. When copying images the 
Image source must be RDS and when downloading images the Image source 
must be SDS.

Copying or downloading a file of image names
The download server must be running on the SDS workstation. To use a file 
of images in the /opt/MagellanNMS/cfg/dpn_img directory, the Software 
Distribution tool must be running on the SDS workstation or a workstation 
that mounts the SDS disk.

Using the RDS as the target PM is an easy way to move all the new images 
required for a release into the network. Access to /opt/MagellanNMS/cfg/
dpn_img/images.<generic> is provided in the tar file for this purpose.

1 Select the Image source. 

2 In the Image selection area select the File of image names button. 

The file selection box opens. The default directory displayed is usually /
opt/MagellanNMS/cfg/dpn_img. 

3 From the selection box, select the image file.
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4 Enter the PM mnemonic in the Target PM field. 

5 Click Copy Images. 

The Messages window displays any errors, warnings, or status 
messages, and indicates when the file transfer process is complete.

Copying or downloading a specific image
1 Select the appropriate Image source button 

2 In the Image selection area, select the Image button. 

The Image data entry field opens.

3 In the data entry field, enter the Image name.

4 In the Target PM field, enter the PM mnemonic.

5 Click Copy Images.

The Messages window displays any errors, warnings, or status 
messages, and indicates when the file transfer process is complete.

Copying or downloading images required for an MCF
Each MCF requires certain images. If you want to copy or download the 
images required to complete the service data for an MCF, perform the 
following:

1 Select the appropriate Image source button.

2 Select one of the Root MCF, Keyed MCF or Dated MCF buttons.

3 In the data entry field, enter the appropriate information.

4 In the Target PM field, enter the PM mnemonic.

5 Click Copy Images.

Authentication may take place at this time. A check is made of all the 
images referred to in the MCF. Any images referred to in the MCF that are 
not on the PM disk are copied from the RDS to the target PM.

Copying or downloading images using a command file
You can use a command file to copy download images. See “Command file 
dialog” (page 188) for the format of the command file.

1 From the Options menu select Run Command File... .

The Run Command File dialog opens. 
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2 Enter the name of the command file.

3 Click Run Command File.

The Messages window displays any errors, warnings, or status 
messages, and indicates when the file transfer process is complete.

Note:  There are no further steps necessary in the main window.

Command line
You can invoke the Software Distribution tool from a UNIX command line 
with or without a command file. The following is the format of the command 
and a description of the different parameters and options. To display online 
help for this command use the -h option.

Enter the following command syntax as one continuous command.

Command line format with a command file
/opt/MagellanNMS/bin/getimg -ncs <dest_mnemonic>

<capability_id> <password> -f <cmdfilename> 
[-log [<logfilename>]]

Command line format without a command file
/opt/MagellanNMS/bin/getimg [-src rds|sds]

-ncs <dest_mnemonic> <capability_id> <password>
-tm <pm_name> <mcf>|<key>|<date> ... 
-ti <pm_name> <images> ... 
[-tif <pm_name> <imglist_filename>...]
[-log [<logfilename>]]

where:

-src rds|sds

Specifies where the source images reside. If this option is not specified, 
as a default, the images are copied from the RDS.

rds  Copies images from the RDS to the target PM.
sds  Downloads images from the SDS to the target PM.
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-ncs <dest_mnemonic> <capability_id> <password>

Specifies the NCS security flag. The following parameters are used to log 
in to the target module:

<dest_mnemonic>  Destination mnemonic of the NCS OA. 
<capability_id>  NCS capability id. 
<password>  Password for the NCS capability id. 

-log [<logfilename>]

Specifies that messages are to be written to the log file. 

<logfilename>  The name of the log file. Default file name is 
getimg.log.

-f <cmdfilename>

Specifies that a command file is to be used.

<cmdfilename>  The name of the command file. 

-tm <pm_name> <mcf>|<key>|<date>...

Specifies the target PM-MCF flag. Use this option to copy or download 
all the images required to activate an MCF. The MCF can be identified 
by the root_MCF name, key or date.

<pm_name>  Mnemonic of the target DPN-100 module.
mcf|key|date. If this field begins with MC., it is treated as an MCF 
name, and the tool attempts to upload the MCF. If it is a valid date in the 
format yymmdd, it is treated a a date key and a dated upload is attempted. 
Otherwise, it is treated as a key. If it is a valid key, a keyed upload is 
attempted. See “Dated algorithm” (page 45) for more information on the 
date format.
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-ti <pm_name> <image>...

Specifies the target PM-image flag. Use this option to copy or download 
specific images.

<pm_name>  Mnemonic of the target DPN-100 module.
<image>  The load image name or NPM macro name.

-tif <pm_name> <imglist_filename>...

Use this option to copy or download specific images that are specified in 
a file.

<pm_name>  Mnemonic of the target DPN-100 module.
<imglist_filename>  The name of the control file that contains the 
image names. There is one image name specified per line and the 
filename format is images.<generic>. For example, 
PELFB1.PIMGRH45.

The following control files are sent as part of the AM/RM release: 
images.<generic>, npm.macros.nm.<generic> and 
npm.macros.rm.<generic>. These files are in the proper format to be used as 
the <imglist_filename>, and all files specified in the control file are either 
copied or downloaded.

The following example shows how an MCF is used to detect and copy 
missing images. In this example, a check is made for all the images required 
in the MCF MC.2588.4034.0, and any images in that MCF that are not on the 
R34 disk will be copied from the RDS. Errors, warnings, and any 
informational messages are displayed and saved in a log file called getimg.log 
(default).

/opt/MagellanNMS/bin/getimg -ncs lab0 iws mypsw 
-tm R34 MC.2588.4034.0 -log

The following example shows how to copy a specific image. This example 
copies L2LOADER.PIMGRJ15 from the RDS to R34 disk. Errors, warnings, 
and any informational messages are displayed and saved in a log file called 
mylog. 
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/opt/MagellanNMS/bin/getimg -ncs lab0 iws mypsw 
-ti R34 L2LOADER.PIMGRJ15 -log mylog

The following example shows how to download two specific images from the 
SDS to a module. This example downloads L2LOADER.PIMGRJ15 and 
PELFF2.PIMGRJ15 from the SDS to R34 disk.

/opt/MagellanNMS/bin/getimg -src sds -ncs lab0 iws 
mypsw -ti R34 L2LOADER.PIMGRJ15 PELFF2.PIMGRJ15

See also...

• “Command file dialog” (page 188)

• “Commands” (page 188)

• “NPM macros” (page 189)

• “Log file format” (page 189)

Command file dialog 
A command file is used to specify the required target parameters. You can run 
the command file from the graphical user interface (GUI) or from the 
command line. If you use the GUI, select Run Command File... from the 
Options menu and enter the name of the command file.

The dialog initially appears with $HOME/MagellanNMS as the default value. 
To change directories, either select a directory from the Directories list and 
then select the Change Directory button, or just double click the directory in 
the list. You can be easily navigate a directory tree by successively moving 
through directories in the list. 

Once you are in the correct directory, the command file can be chosen either 
by selecting the command file in the Files list and then selecting the Run 
Command File button, or by double clicking the command file in the list. 

Commands
The following commands are accessible from the Files menu:

• Run Command File uses the command file in the data entry field to 
control the software distribution operation. 
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• Change Directory moves from the current directory to the directory 
selected in the Directories list. 

• Cancel ignores any changes made in this dialog since it was popped up 
and return to the DPN Software Distribution main window. 

The command file uses the keywords -src, -tm and -tif, which match those 
supported on the command line interface. However, -ncs, -f and -log options 
cannot be specified in the command file. The following is the command file 
format: 

-src rds | sds
-tm <pm_name> <mcf>|<key>|<date>...
-ti <pm_name> <images>...
-tif <pm_name> <imglist_filename>...

See “Command line” (page 185) for parameter descriptions.

The following is an example of a command file named LOAD03 and the 
command that is used to execute it.

# get missing images for R34 based on MCF 
MC.2588.4034.0
-tm R34 MC.2588.4034.0
# get image for R70
-ti R70 L2LOADER.PIMGRJ15

The command would be:

getimg -f LOAD03 -ncs lab0 iwsa abab

NPM macros
With every AM/RM release there are two NPM macro control files that are 
sent: npm.macros.nm.<generic> and npm.macros.rm.<generic>. 

If an NPM macro is specified in an MCF or is used as the <image> parameter 
with the -ti option, Software Distribution copies or downloads all the NPM 
files specified in the control file to the target PM. 

Log file format
You can access the log file from the UNIX command line or from the Options 
menu on the graphical user interface.
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The Log file dialog provides for a number of keyboard shortcuts. See “Help 
on Keys” (page 58).

If you want to create a log file that contains processing and error information, 
you can specify the -log option on the command line. You can name this file 
by providing a log filename. If no name is given, the default filename 
getimg.log is used. If the log file already exists, any additional message 
information will be appended to the file.

The following command generates a log file called getimg.log (default).

/opt/MagellanNMS/bin/getimg -ncs lab0 iwsa <password> 
-tm R34 FACT -ti R34 RMOFF386.PIMGRJ15 -log

The log output is as follows:

16:34:29 DPN Software Distribution - Command line:
/opt/MagellanNMS/bin/getimg -ncs corencs iwsa #### 
-f getimgcommandfile -log upgradeimg.log by uibasher
16:34:30 NOTE: RDS is selected as a source. File(s) 
will be copied from the RDS to the target PM.
14:34:30 NOTE: Establishing a connection to PM Software 
Download (pfa swdld) Server at localhost.
16:34:30 NOTE: PM Software Download (pfa swdld) Server 
connection established.
16:34:31 NOTE: Start to process for PM:  A20
16:34:33 NOTE: Retrieve a list of image files on PM 
disk.
16:34:41 NOTE: Operation completed.
16:34:41 NOTE: Request PM to copy file PELFF2.PIMGRH45 
from RDS.
16:35:44 NOTE: Operation completed.
16:35:44 NOTE: Request PM to copy file SNAMUL.PIMGRH45 
from RDS.
16:36:51 NOTE: Operation completed.
16:36:51 NOTE: Request PM to copy file PELFG1.PIMGRH45 
from RDS.
16:37:48 NOTE: Operation completed.
16:37:48 NOTE: Request PM to copy file RAUTP.PIMGRH45 
from RDS.
16:39:55 NOTE: Operation completed.
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16:39:55 NOTE: Request PM to copy file 
AMOFF386.PIMGRH45 from RDS.
16:42:33 NOTE: Operation completed.
16:42:33 NOTE: Request PM to copy file 
L2LOADER.PIMGRH00 from RDS.
16:42:38 NOTE: Operation completed.
16:42:38 NOTE: Request PM to copy file 
L3LOADER.PIMGRH40 from RDS.
16:42:42 NOTE: Operation completed.
16:42:42 NOTE: Close the existing PM session.
16:42:42 NOTE: Software Distribution completed.
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Software Substitution

The DPN Software Substitution tool allows you to update the loader file fields 
within an MCF with new image names and then copy those new images 
to the PMs that require them. Downloads from the Software Substitution tool 
are always complete; incremental downloads are never performed. 

Note 1:  The images must be located on the RDS. If they are not, use the 
software distribution command getimg to download the images. See 
“Software Distribution” (page 179) for how to use this tool.

Note 2:  An MCF must be converted to the latest service data version 
before using Software Substitution; otherwise, an error message is 
generated. See “Service Data Conversion” (page 207) for how to convert 
service data.

Software Substitution tool
This tool allows you to use the following procedures and concepts:

• Using the software substitution graphical user interface (GUI)

See “Using the software substitution GUI” (page 197)

• Downloading NPM macros

See “NPM macros” (page 198)

• Using the software substitution command line

See “Command syntax” (page 204)
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• Module names file

See “Module names file” (page 199)

• Module Names File dialog

See “Module Names File dialog” (page 196)

• Loader mapping file

See “Loader mapping file” (page 200)

• Using the loader mapping file GUI

See “Using the loader mapping file GUI” (page 203)

• Customizing the loader mapping file

See “Customizing the loader mapping file” (page 201)

Software Substitution GUI
To open the Software Substitution tool, in the Preside MDM window, select 
Configuration -> DPN Devices -> Administration -> Software Substitution. 
See the figure “Software Substitution tool window” (page 195).

It provides the following functionality:

• File

See “File menu” (page 195).

• Options

See “Options menu” (page 195).

• Security

See “Security menu” (page 55)

• Help

See “Help menu” (page 55)
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• Module Names File.

See “Module Names File button” (page 196).

• Loader Mapping File ...

See “Loader Mapping File button” (page 196).

• Upgrade Images

See “Upgrade Images button” (page 196).

Figure 14
Software Substitution tool window

File menu
The File menu contains the following commands:

• Select Log file opens the Log File dialog and allows you to enter the name 
of the log file in which to record output from the DPN Software 
Substitution tool. Output is always logged. 

• Exit closes the DPN Software Substitution tool. 

Options menu
Set Options opens the Options dialog. 
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Options dialog
This dialog allows you change the No Substitution and No Distribution 
options. Items in this dialog are:

• No Substitution uploads MCFs and reads the current image names but 
does not download any changes. 

• No Distribution does not distribute new images to PMs. 

Module Names File button
Click this button to display a dialog that allows you to select the module 
names file that you want. See also “Module Names File dialog” (page 196).

Loader Mapping File button
Click this button to display a dialog that allows you to create a loader mapping 
table for image migration. See also “Loader Mapping File dialog” (page 201).

Upgrade Images button
Click this button to initiate the migration from the old set of software images 
to the new set. 

Module Names File dialog
This dialog allows you to enter the name of the module names file you wish 
to use. The file name can be entered directly into the Module names file data 
entry field, or the Directories and Files lists can be used to find the desired 
module names file. 

The dialog initially appears with the default directory displayed. To change 
directories, either select a directory from the Directories list and then select 
the Change Directory button, or just double click the directory in the list. A 
directory tree can be easily navigated by successively moving through 
directories in the list. 
241-6001-012   14.3RSUP   



Chapter 9 Software Substitution   197
Once you are in the correct directory, the module names file can be chosen 
either by selecting the module names file in the Files list and then selecting 
the Use button, or by double clicking the module names file in the list. The 
following commands are available:

• Use uses the module names file in the data entry field as the list of upload 
and download locations and modes. 

• Change Directory moves from the current directory to the directory 
selected in the Directories list. 

• Close closes the dialog window. 

Substituting software
Software substitution can be performed from the UNIX command line or 
from the graphical user interface (GUI).

Using the software substitution GUI
Complete the following steps to perform software substitution using the 
graphical user interface.

1 In the Preside MDM window, select Configuration -> DPN Devices -> 
Administration -> Software Substitution.

The DPN Software Substitution tool opens.

2 The Connection Manager is displayed over the main window. Enter the 
appropriate authentication parameters (see “Connection Manager 
authentication” (page 48) for further information).

3 From the DPN Software Substitution window, click Module Names File... .

The DPN Software Substitution Module Names File dialog opens. The 
module names file must already exist. To create a module names file, see 
“Module names file” (page 199).

4 Select the required module names file name. 

Selecting the module names file can be done two ways: select the 
directory, click Change Directory and then select a file, or double click the 
directory and then select a file. 

5 Click Use. 

The Module Names File dialog is closed.

6 Click Loader Mapping File... in the DPN Software Substitution window.
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The Loader Mapping File dialog is displayed.

7 Select the loader mapping file name.

Selecting the loader mapping file can be done two ways, select the 
directory and click Change Directory and then select a file, or double click 
the directory and then select a file. 

8 To add the files to the list, Click Add to List or double click the file name. 

The images names appear in the list below. Add and delete images as 
appropriate.

9 Click Use Mapping.

The Loader Mapping File dialog is closed.

Steps 10 to 14 are optional. System defaults will be used unless otherwise 
specified.

10 Substitution is performed by default. If substitution is not required, choose 
Set Options... from the Options menu and click No substitution.

The No substitution toggle button will be highlighted.

11 Distribution is performed by default. If distribution is not required, choose 
Set Options... from the Options menu and click No distribution.

The No distribution toggle button will be highlighted.

12 Logging is always performed. If you would like the log file saved to a file 
other than upgradeimg.log, choose Select Log File... from the File menu.

The Log File dialog is displayed.

13 Select the directory and log file name. 

The directory and file name will appear in the Log file data entry field. 

14 Click Use.

The Log File dialog is closed.

15 On the main window click Upgrade Images.

A processing dialog appears over the main window until the substitution 
is complete. To stop the substitution, click Stop in the processing dialog. 
All error messages will appear in the Messages area on the main window.

NPM macros
16 After the software substitution process has completed, the NPM macros 

must be downloaded. Run the Software Distribution tool using the -tif 
option specifying the npm.macros.rm.<generic> and 
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npm.macros.nm.<generic> files. This will download all of the macro files 
within these control files.

Module names file
Each line in the module names file specifies the name of a target module, an 
associated MCF to be uploaded and the MCF to be downloaded. Any type of 
Preside Multiservice Data Manager (MDM) supported upload (user specified, 
keyed, dated, active or committed) and download (user specified, keyed or 
dated) may be used. An MCF may be uploaded from a module or from the 
disk, but the modified MCF must be downloaded to a target module. The 
download location may be omitted if it is the same as the upload location. The 
module names file must be created before using the graphical user interface. 

Comments can be included in the module names file by adding a # character 
as the first non-blank character on the line. Blank lines are ignored.

The following is the format of the module names file.

-uploadlocation nms_disk|user_specified <pm_mnemonic>
-uploadmode active | committed | keyed <key>| 
   dated <date_key> | user_specified <bundle> [<namsid>]
[-downloadlocation nms_disk | 
user_specified <pm_mnemonic>]
-downloadmode user_specified <bundle> | keyed <key> |
   dated <date_key> | [<namsid>]   

Option parameters are case sensitive.

The following is the minimum character required for the following keywords:

COMMITTED = c
ACTIVE = a
USER_SPECIFIED = u
KEYED = k
NMS_DISK = n
DATED = d

where:

-uploadlocation

indicates where to upload the MCF from.
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-uploadmode

indicates how to construct the name of the MCF to be uploaded. For a 
dated MCF, see “Dated algorithm” (page 45) for information on the date 
format.

-downloadlocation

indicates the download target PM mnemonic. If this option is not 
specified, the uploadlocation is assumed to be the intended download 
location.

-downloadmode

indicates how to construct the bundle of the new MCF to be downloaded. 
For a dated MCF, see “Dated algorithm” (page 45) for information on the 
date format.

The following example is uploading the active MCF on module RM1 and 
downloading it using a date key.

-uploadlocation u RM1 -uploadmode a -downloadmode d 
930101

The following example is uploading a keyed MCF on module AM1 and 
downloading it in keyed mode.

-uploadlocation u AM1 -uploadmode k newest 
-downloadmode k newest

Loader mapping file
The loader mapping file, subst.all.<release>, contains a mapping of Old 
Image names to New Image names. For the Old Image name, only the part of 
the name before the period (.) is required. For the New Image name, the entire 
image name is required. 

The following example maps image names PELFG1 and RAUTP to new 
image names. All other image names are not mapped and therefore will not 
have new images retrieved for them.
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PELFG1 PELFG1.PIMGRJ15
RAUTP RAUTP.PIMGRJ15

Customizing the loader mapping file
Loader mapping files can be customized using the graphical user interface 
(GUI) or a text editor. Make a copy of the existing loader mapping file before 
making any changes. 

The GUI allows you to select one or more mapping files. When more than one 
mapping file is selected, each file is merged into the existing list of images so 
that there is only one mapping for each Old Image. If an Old Image entry 
exists in both the table and the selected loader mapping file, the entry from 
the file whose <release> value is greater appears in the table after the merge. 
For example, subst.all.G3403 contains the mapping FRELAY 
FRELAY.PIMGRH45 and subst.all.G3404 contains the mapping FRELAY 
FRELAY.PIMGRH46. Both loader mapping files are selected and added to 
the loader mapping table. FRELAY FRELAY.PIMGRH46 is the mapping in 
the table after the merge.

The loader mapping file can be customized to substitute images. For example 
Image A becomes Image B. These mapping files are not provided and must 
be created using a text editor.

Loader Mapping File dialog
This dialog allows you to create a loader mapping table to use for image 
migration. The top portion of the dialog consists of a file selection box used 
to enter the name(s) of the loader mapping file(s) you wish to use to create the 
table. Each loader mapping file name can be entered directly into the Loader 
mapping file data entry field, or the Directories and Files lists can be used to 
find the desired file. 

See the figure “DPN Software Substitution - Loader Mapping File dialog” 
(page 202).
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Figure 15
DPN Software Substitution - Loader Mapping File dialog

The middle portion of the dialog is the loader mapping table. Each table entry 
includes the Old Image name, the New Image name, the file Extension of the 
New Image filename, and the Extension Release level of the New Image. The 
bottom portion of the dialog contains the dialog action buttons.

The dialog initially opens with the default directory in the file selection box. 
To change directories, either select a directory from the Directories list and 
then select the Change Directory button, or double click the directory in the 
list. You can navigate the directory tree by successively moving through 
directories in the list. 
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Once you are in the correct directory, a loader mapping file can be chosen 
either by selecting that mapping file in the Files list and then selecting the Add 
to List button, or by double clicking the loader mapping file in the list. When 
this is done, the entries in the file are merged with the entries already in the 
list. This merge is performed in such a way that each Old Image name is 
unique in the list, that is, there is only one mapping for each old image, and 
in the case where an Old Image entry exists in both the list and the selected 
loader mapping file, the entry from the file with the highest release level is the 
entry that appears in the list after the merge. 

Individual list entries can be deleted using the Delete entry on the popup 
menu on the item or by using the Delete Selected Item button. The entire list 
can be deleted by selecting the Delete All Items button. 

Use Mapping uses the current loader mapping table in the migration process. 
A working file containing the loader mapping table entries is created in the /
tmp directory. This file is transfered to the upgrading process as a command 
line parameter. 

Using the loader mapping file GUI
This procedure describes the steps required to customize a loader mapping 
file using the GUI.

1 From the Software Substitution main window, click Loader Mapping File... 

The DPN Software Substitution - Loader Mapping File dialog is displayed.

2 Select the loader mapping file to be used in the substitution.

Selecting the loader mapping file can be done two ways, select the 
directory and click Change Directory and then select a file, or double click 
the directory and then select a file. 

3 To add the files to the list, Click Add to List or double click the file name. 

4 To substitute more than one release at a time, perform steps 2 and 3 
again and select other mapping files. 

This will merge each new file into the existing list of images.

5 To delete an individual image, select the image and choose Delete 
Selected Item.

The image will be removed from the list.

6 To delete all the images, click Delete All Items.
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All the images will be removed from the list. 

7 To save a customized mapping file, click Save As... .

The Save As dialog is displayed. This mapping file may be used in future 
substitution processes. 

8 Once all files have been selected, click Use Mapping. 

The Software Substitution main window is displayed. 

Command syntax
The following is the command syntax for the Software Substitution tool. 
Enter the following command syntax as one continuous command.

/opt/MagellanNMS/bin/upgradeimg -ncs <dest_mnemonic>
<capability_id> <password> -mf <module_names_file> 
-lf <loader_mapping_file> [-logfile <log_file>] 
[-nosub] [-nodist] [-h]

where:

-ncs <dest_mnemonic> <capability_id> <password>

NCS security flag. The following parameters are used to log in to the 
target module:

<dest_mnemonic> is the address to which the NCSCOM process will 
log on.
<capability_id>  is the dest_mnemonic capability id.
<password> is the capability id password.

-mf <module_names_file>

Modules names file flag, where <module_names_file> is the name of the 
file which specifies the target module and associated MCF names for 
upload and download.

-lf <loader_mapping_file> 

The name of the file which specifies the mapping between current image 
names and new image names.
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-logfile <log_file>

Flag used to indicate that a logfile other than the default is to be used. 
Logging is always on. The default file name is upgradeimg.log.

-nosub

The no substitution option. Software Substitution runs but only looks 
through listed MCFs, determining which images will be required and 
then distributes those images to the modules. The modified MCFs are not 
downloaded. This option could be used to trial the substitution process 
and to prepare the modules for real substitution by having the Software 
Substitution tool download the necessary images to the modules ahead of 
time.

-nodist

The no distribution option. Stops Software Substitution from running 
Software Distribution automatically. However, modified MCFs are still 
downloaded. This may be used if all the necessary images are known to 
be on the module.

-h

Display command syntax and descriptions.

In the following example, for each service data view in toronto.mfile the 
new images required are determined by the mappings in the 
subst.all.g3203 file. The new images are then distributed to the module 
but are not downloaded to a new bundle. All messages are output to a file 
called toronto.log

/opt/MagellanNMS/bin/upgradeimg -ncs oa id mypwd 
-mf toronto.mfile -lf /localdisk/dpn_img/
subst.all.g3203 -logfile toronto.log -nosub

In the following example, for each service data view in toronto.mfile, the 
new images required are determined by the mappings in the 
subst.all.g3203 file. The new images are not distributed to the module, 
but a new bundle is created and downloaded based on the new images. 
All messages are output to a file called toronto.log.
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/opt/MagellanNMS/bin/upgradeimg -ncs oa id mypwd 
-mf toronto.mfile -lf /localdisk/dpn_img/
subst.all.g3203 -logfile toronto.log -nodist
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Service Data Conversion

The DPN Service Data Conversion tool allows you to convert service data 
from one version to the latest service data version, one MCF at a time, or in 
batches using a command file.

Service data conversion is required when:

• a new main release of Preside Multiservice Data Manager (MDM) is 
deployed

• a module is entirely provisioned or has components provisioned by DPN 
Devices configuration .

An MCF must be converted to the latest service data level before the 
following DPN Devices configuration applications can use the service data:

• Global Data Manager

• Network Reporting System

• Component Provisioning

• Software Substitution

Each of the above applications will detect an MCF that has not been converted 
and issue a message that service data conversion is required.

Service data converted with the conversion tool is compatible with all 
supported DPN-100 generic software releases without service impact.
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Service data conversion supports all methods of service data upload 
(ACTIVE, COMMITTED, KEYED, DATED, USER_SPECIFIED) and 
download (KEYED, DATED, USER_SPECIFIED). In the case of 
incremental downloads, only the components changed by the conversion are 
downloaded. Incremental downloads are allowed, however complete 
downloads are highly recommended to synchronize the MCFs with the new 
DPN Devices configuration release.

Service Data Conversion GUI
The graphical user interface (GUI) can be opened from the UNIX shell or by 
selecting Configuration -> DPN Devices -> Administration -> Service Data 
Conversion from the DPN Devices configuration toolset. This tool supports 
cut and paste from the Messages area. 

Re-authentication can be done by selecting Authenticate from the Security 
menu. Note, that authentication is not performed when the parameters are 
entered, but when the actual conversion is started. If the authentication 
parameters are incorrect, the conversion will fail. 

A log file and command file can also be run from the GUI but the command 
file must have been previously created from the UNIX window. When 
Verbose mode is selected, all information specific to each change in the 
service data is displayed in the Messages area or the log file

The Service Data Conversion tool’s main window displays four pull-down 
menus, an Upload Parameters area, a Download Parameters area, and a 
Messages area. See the figure “DPN Service Data Conversion tool window” 
(page 210).

For more information, see the following sections:

• Menu bar

— “File menu” (page 210)

— “Options menu” (page 54)

— “Security menu” (page 55)

— “Help menu” (page 55)

• Target MCF upload parameters
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— “Upload mode buttons” (page 211)

— “Bundle data entry field” (page 213)

— “Namsid data entry field” (page 213)

— “Upload source buttons” (page 211)

• Target MCF download parameters

— “Download mode buttons” (page 212)

— “Bundle data entry field” (page 213)

— “Namsid data entry field” (page 213)

— “Download type buttons” (page 212)

— “Download target buttons” (page 213)

• Messages area

— “Message area” (page 58)

— “Verbose” (page 58)

Use the Service Data Conversion Tool to do the following:

• Convert selected service data

See “Converting service data using the GUI” (page 214).

• Use the command line

See “Command line” (page 214)

• Run a command file from the GUI

See “Command file” (page 217).

• Run a log file from the GUI

See “Log file” (page 218).
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Figure 16
DPN Service Data Conversion tool window

File menu
The File menu contains the following commands:

• Log to File... allows you to specify a log file. 

• Stop logging stops recording output from the tool to the log file. 

• Exit closes the DPN Service Data Conversion tool. 
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Target MCF Upload Parameters area
Enter the upload mode and upload source information in this area. The 
parameters are used in uploading the MCF to the old version. 

Upload mode buttons
Upload mode indicates the search mode that the tool uses to find the name of 
the target MCF to be uploaded. The NAMS ID field is mandatory if uploading 
from the NMS_DISK. You may select one of five modes:

• User specified enables you to specify that the name of an MCF will be 
used to search for the MCF to be uploaded. Each time an upload takes 
place, you must specify the bundle (also the NAMS ID if uploading from 
the NMS_DISK) of the desired MCF. The search string used is: 
MC.<bundle>.<namsid>.0 

• Keyed enables you to specify that a key will be used to search for the 
MCF to be uploaded. You must specify a key each time an upload takes 
place. The search string used is:
 MC.<key>nn.<namsid>.0, where nn ranges from 00 to 99. The MCF 
with the highest index (nn) is uploaded. 

• Dated enables you to specify that a date will be used to search for the 
MCF to be uploaded. You must specify a date in the format yymmdd each 
time an upload takes place. A dated MCF has the format 
MC.<yymmdd>nn.<namsid>.0 where nn ranges from 00 to 99. Using 
date mode is the same as keyed mode if an exact match exists for the date. 
However, when an exact match does not exist, the most recent MCF, 
relative to the date, is uploaded; that is, the dated MCF with the later date 
earlier than the given date. See “Dated algorithm” (page 45) for more 
information on the date format.

• Committed uploads the committed MCF on the PM. 

• Active uploads the active MCF on the PM. 

Upload source buttons
Upload source indicates the method used to find the location of the target 
MCF. You may select one of two modes: 

• NMS disk searches for the target MCF in the workstation directory 
indicated in the PFA.cfg file. 
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• PM searches for the target MCF on the PM named in the data entry field.

 

Target MCF Download Parameters area
Enter the download mode and target information in this area. The parameters 
will be used in downloading the target MCF, which is the newly converted 
MCF. 

Download mode buttons
Download mode indicates the mode that the tool uses to name the newly 
updated target MCF. The download NAMS ID, when not specified, is 
assumed to be the same as the NAMS ID of the uploaded MCF. You may 
select one of three modes: 

• User specified enables you to specify the name of the MCF to be 
downloaded. Each time a download takes place, you must specify the 
bundle of the new target MCF. The following MCF is created:
MC.<bundle>.<namsid>.0 

• Keyed enables you to specify the key to be used to name the new MCF to 
be downloaded. You must specify a key each time a download takes 
place. The following MCF is found: MC.<key>nn.<namsid>.0, where 
nn ranges from 00-99 and has the highest index (nn). A new target MCF 
with the next index in the sequence is created. The download fails if 
MC.<key>99.<namsid>.0 exists. 

• Dated enables you to specify that a date will be used to search for the 
MCF to be downloaded. You must specify a date in the format yymmdd 
each time a download takes place. A dated MCF has the format: 
MC.<yymmdd>nn.<namsid>.0, where nn ranges from 00-99. The MCF 
with the highest index (nn) is found, and the next MCF in the sequence 
is created. The download fails if MC.<yymmdd>99.<namsid>.0 exists. 
See “Dated algorithm” (page 45) for more information on the date 
format. 

Download type buttons
You can select one of the following types:

• Incremental creates only the MCFs that have been modified. 

• Complete creates all MCFs supported by DPN. These MCFs will be 
named based on what you have specified for Download Mode. 
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Download target buttons
Download target indicates the mode that the tool uses to determine the 
destination for the new MCF. You may select one of three modes:

• Default destination is used to download the MCF to the target location 
from which it was uploaded. This location could be either the NMS disk 
or a PM. 

• NMS disk is used to download the MCF to the workstation directory 
indicated in the PFA.cfg file. 

• PM is used to download the MCF to the PM. A data entry field will be 
displayed in which the mnemonic of the PM may be entered. 

Convert button
Click this button to begin converting the service data to the new version. 

Bundle data entry field
Enter the bundle number of the MCF in this field. Bundles can be made up of 
letters, digits, and underscores. They cannot begin with an underscore, and 
they must be no more than 8 characters long. 

Key data entry field
Enter the key of the MCF in this field. Keys can be made up of letters, digits, 
and underscores. They cannot begin with an underscore, and they must be no 
more than six characters long. 

Date data entry field
Enter the date key of the MCF in this field. Valid date keys must have the 
format yymmdd. See “Dated algorithm” (page 45) for more information on 
the date format.

Namsid data entry field
Enter the NAMS ID contained in the MCF name in this field. NAMS IDs must 
be numbers between 256 and 49,151 inclusive. 

PM data entry field
Enter the PM mnemonic in this field (including NCS routing information). 
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Converting service data using the GUI
1 From the Target MCF Upload Parameters area, select the Upload Mode 

and the Upload Source.

This specifies the name and location of the MCF to be converted.

2 From the Target MCF Download Parameters area, select the Download 
Mode, and Download target.

This specifies the mode and target destination to download the new MCF.

3 Click Convert.

All errors, warnings or informational messages will be displayed in the 
Messages area.

Command line
The UNIX command for service data conversion is found in the /opt/
MagellanNMS/bin directory. It is recommended that if several PMs are being 
converted, that the command line be run as a background process with a 
command file. 

Enter the following command syntax as one continuous command.

Command syntax with a command file
/opt/MagellanNMS/bin/sdconv -f <commandfilename>

[-ncs <destination mnemonic> <capability id>
<password>] [-log [<logfilename>]] [-terse] [-manual]
[-h]

Command syntax without a command file
/opt/MagellanNMS/bin/sdconv -uploadmode <mode> [<bundle/

key/date> [<upload_namsid>]] 
-uploadlocation <location_mode> [<location_value>]
-downloadmode <mode> <bundle/key/date>
[<download_namsid>]
[-downloadlocation <location_mode> [<location_value>]]
-ncs <destination mnemonic> <capability id> <password>
[-downloadincremental] [-log [<logfilename>] [-terse]
[-manual] [-h]

Note 1:  Input is not case sensitive, except for <commandfilename> and 
<logfilename>
241-6001-012   14.3RSUP   



Chapter 10 Service Data Conversion   215
Note 2:  The following is the minimum character required for the 
following keywords:

COMMITTED = C
ACTIVE  = A
USER_SPECIFIED = U
KEYED = K
NMS_DISK = N
DATED = D

where:

-downloadincremental

Indicates that an incremental download is required. A complete 
download is forced when upload_location and download_location are 
different, or when the upload_namsid and download_namsid are 
different.

-downloadlocation <location_mode> [<location_value>]

Option to indicate where the converted service data is to be stored. By 
default, if not specified, this location is the same as the upload location.

<location_mode>  Must be User_specified or NMS_DISK. 
<location_value>  Represents the PM where the MCF is stored. Used 
only when location_mode is User_specified.

-downloadmode <mode><bundle/key/date> [<download_namsid>]

Mandatory option to indicate the mode to be used for storing the 
converted service data. It is the way of expressing the MCF file name.

<mode>  Must be one of: User_specified, Keyed or Dated
<bundle/key/date>  The bundle/key/date of the converted MCF. This 
parameter is to be used with the User_specified, Keyed or Dated.
<download_namsid>  The NAMS ID for download. If not specified, 
NAMS ID of upload MCF is used. Valid: numeric 256-49151.
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-f <commandfilename>

Indicates that the MCFs to be converted are in the command file. When 
this option is specified, only -ncs, -log and -terse are valid on the 
command line.

-log [<logfilename>]

Option to specify that diagnostic messages are to be logged to a file. The 
name of the log file must be specified if other than sdconv.log.

-ncs <destination mnemonic> <capability id> <password>

Mandatory option to use NCS authentication. The following parameters 
must be specified:

<destination mnemonic>  NCS mnemonic of the OA interface
<capability id>  NCS capability id
<password>  NCS capability id password

-uploadlocation <location_mode> [<location_value>]

Indicates the location where service data to be converted currently 
resides. 

<location_mode>  Must be User_specified or NMS_DISK. 
Location_mode = NMS_DISK is invalid in combination with 
upload_mode is Committed or Active.
<location_value>  Represents the PM where the MCF is stored. Used
only when location_mode is User_specified.

-uploadmode <mode> [<bundle/key/date> [<upload_namsid>]]

Mandatory option to indicate the mode to be used for uploading. It is the 
way of expressing the MCF file name. 

<mode>  Must be one of: Committed, Active, User_specified, Keyed or 
Dated
<bundle/key/date>  The bundle/key/date of the MCF to be converted. 
This parameter is to be used with the User_specified, Keyed or Dated.
<upload_namsid>  The NAMS ID for upload. If the upload_mode is 
NMS_DISK this option is mandatory. Valid: numeric. 
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-terse

Indicates that the information specific to the conversion action must not 
be displayed or logged.

-manual

Indicates the manual NCS access mode. Authentication with NCS is 
bypassed if this option is specified.

-h

Option to request the display of the Help information. When no 
parameters are specified on the command line, the Help information is 
displayed.

Command file 
The command file allows you to perform multiple MCF conversions at one 
time. The command file can be run through the graphical user interface or the 
UNIX command line. Comment and blank lines are allowed, but a comment 
line must start with a # character and strings with embedded blanks must be 
in quotes. Every line that is not a comment is a service data conversion 
request. The following is the syntax for lines in a command file.

-uploadmode <mode> [<bundle_or_key_or_date>
[<upload_namsid]]
-uploadlocation <location_mode> [<location_value>]
-downloadmode <mode> <bundle_or_key_or_date>
[<download_namsid>] 
[-downloadlocation <location_mode> [<location_value>]] 
[-downloadincremental]

The following is an example of a command file.

#This is a sample sdconv command file
#First request
-uploadmode dated 930323 -uploadlocation U R34 
    -downloadmode dated 930324
#Second request
-uploadmode CoMMit -uploadlocation NMS_DISK -
downloadmode K New
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Running a command file from the GUI
If you wish to use an existing command file from the GUI, perform the 
following steps from the anchor window.

1 From the Options menu choose Run Command File... .

The DPN Service Data Conversion - Command File dialog is displayed.

Note:  Parameters do not need to be specified in the anchor window as 
they are contained in the command file.

2 Select the directory and enter the name of the command file.

3 Click Run Command File.

All errors, warnings or informational messages will be displayed in the 
Messages area.

Log file
The log file contains log messages that are produced during a service data 
conversion. When logging is turned on, the default file name is sdconv.log; it 
can be changed if necessary. If a log file already exists, the new logs will be 
appended to the file. The log file is locked when in use and if the file is 
currently locked, the service data conversion aborts.

A log file contains the following information:

• The date and time the conversion was started.
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• The user command.

• The name and location of the service data file to be converted and the 
time the service data was uploaded.

• The service data level of the uploaded MCF and the service data level that 
this MCF is going to be converted to.

• The field and envelopes that are impacted by the service data conversion. 
If terse mode has been selected, this information is not displayed.

• Indication that the service data conversion has completed, and details 
when it hasn’t.

• The name and location of the converted service data files.

The following is an example of a log file.

NOTE: Conversion initiated by uibasher on 1997-11-25 
13:33:48.
User command: sdconv -uploadmode KEYED CONVER 
-uploadlocation USER_SPECIFIED R34
-downloadmode KEYED MYKEY -ncs CORENCS IWSA XXXX
NOTE: Successful upload of MC.CONVER00.1234.0 from 
R34.
NOTE: Converting from SD_version: 4 to SD_version: 5.
NOTE: The Component PE 1 PI 1 PO 1 UTP 9 UTPLINK 0 
HIGHUTILLEVEL:80 has been added.
NOTE: The Component PE 1 PI 1 PO 1 UTP 0 UTPLINK 0 
TIMEINTLOWUTIL:2 has been added.
NOTE: The Component PE 1 PI 1 PO 1 UTP 0 UTPLINK 0 
TIMINTHIGHUTIL:5 has been added.
NOTE: The Component PE 1 PI 1 PO 1 UTP 0 UTPLINK 0 
THMETRICHANGE:15 has been added.
NOTE: The Component PE 1 PI 1 PO 0 UTP 0 UTPLINK 0 
DELAYOVERRIDE: Undefined has been added.
NOTE: An invisible field has been added under the 
component PE 1 PI 1 PO 1 UTP 0 UTPLINK 0.
NOTE: Conversion completed.
NOTE: Successful download of MC.MYKEY00.1234.0 to R34.

Running a log file from the GUI
1 From the File menu choose Log to File... .
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The Log File dialog is displayed. The menu item will toggle to Stop 
Logging.

2 Select the directory and enter the name of the log file.

3 Click Log to File. 

How to stop logging
1 From the Options menu choose Stop Logging.

The menu item will toggle to Log to File... .
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Envelope Editor

The Envelope Editor tool is used to view, modify, create, or delete service data 
envelopes. See the figure “DPN Envelope Editor main window” (page 222).

You must be familiar with the service data format before using the Envelope 
Editor tool, as it does not provide service data validation. See 241-2001-340 
DPN-100 Envelope Definitions, for acceptable service data values.

The Envelope Editor is used to edit envelopes for a particular packet module 
and for a particular Root MCF. Use the following procedures for editing 
envelopes:

• identify the DPN-100 module on which the service data resides

See “Retrieving data” (page 228).

• identify the Root MCF that contains the envelopes to be edited

See “Root MCF name” (page 225).

• identify the envelope to be edited, then edit it using the commands 
available from the File menu

See “Manipulating service data” (page 229).

• continue identifying and editing envelopes (or adding new envelopes) for 
the specified Root MCF until you are done

See “Locating envelopes” (page 231).
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• send your changes to the specified PM using the Download command

See “Downloading service data” (page 232).

All changes made are stored in a temporary buffer until they are downloaded 
to the DPN module or the Discard command is chosen. See “Discarding 
service data” (page 232).

Figure 17
DPN Envelope Editor main window
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The Envelope Editor main window
The Envelope Editor main window provides the following specific 
functionality:

• File menu

See “File menu” (page 224).

• Mode

See “Provisioning mode” (page 225).

• Format

See “Format pull-down menu” (page 225).

• PM

See “PM name” (page 225).

• Root MCF

See “Root MCF name” (page 225).

• Envelope

See “Envelope name” (page 226).

• Header

See “Service Data Header editing area” (page 227).

• Body

See “Service Data Body editing area” (page 227).

• Clear display fields

See “Main Window Clear button” (page 227).
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File menu
This menu accesses the basic functions of the Envelope Editor: 

• Retrieve envelope retrieves the specified SDA or envelope and displays it 
in the Header and Body areas. 

• Add envelope adds a new service data envelope or SDA header. Select the 
Add envelope function only after you have filled in both the service data 
identification area and the service data display area. 
Adding new envelopes must be done in a “top down” fashion. This means 
that when you are adding service data for connected components (for 
example, PE, PI, PO), you must add the service data for a PE before the 
PI(s) on that PE. Likewise, you must add the service data for a PI before 
you add it for a PO(s) on that PI, and so on down the service data 
hierarchy. See also “Adding service data” (page 229).

• Replace envelope replaces a specific service data envelope or SDA 
header with either an edited version, or with another existing service data 
envelope or SDA header. The contents of the envelope are displayed in 
the header and body areas and can be edited. See also “Replacing service 
data” (page 230).

• Delete envelope removes the specified service data envelope or the SDA 
from the Root MCF. If an SDA is deleted, all service data envelopes and 
SDAs within that SDA are also deleted. See also “Deleting service data” 
(page 231).

• List envelopes... displays a list of the envelopes and SDAs that match the 
wildcarded description in the Envelope field. All envelope field 
parameters must be entered in multiples of two. For example, if the 
parameter is PI 1 * you must add a * to make the number of parameters 
an even number. See also “Locating envelopes” (page 231).

• Download downloads all service data changes that have taken place since 
the last download or discard operation to the DPN-100 module. This 
command is not enabled unless changes have been made that may be 
downloaded. See also “Downloading service data” (page 232).

• Discard discards all service data changes since the last download or 
discard operation. This command is not enabled unless changes have 
been made that may be discarded. 

• Exit exits the Envelope Editor tool.
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Provisioning mode
The Mode pull-down menu area in the main window allows you to change the 
mode of a session to one of the following:

• Edit This mode (the default) allows changes to the service data and 
downloading of the modified view.

• View You will only be able to view the service data. No service data 
modifications or downloads can be performed in this mode.

Note: If an attempt is made to change the Mode during a session, a dialog 
will be displayed asking you to confirm the mode change. If Yes is 
selected, the uploaded provisioning data will be cleared regardless of any 
changes made to the current session.

Format pull-down menu
The Envelope Editor can display Service data in two formats: 

• Binary format displays service data in lines of two words each. The bits 
of each word are displayed from high bit to low bit (bit 15 to bit 0). Bits 
are displayed in groups of four. Each group of bits is separated from other 
groups by a space. 

• Hexadecimal format displays service data in lines of eight words each. 
Each word is made up of four hexadecimal digits. The most significant 
digit is displayed first, followed by the least significant digit. Words are 
separated from each other by a space. 

PM name
Enter the name of the target DPN-100 module here. All editing operations 
will be done on the service data for this module. 

Root MCF name
Enter the name of the target master configuration file here. All editing 
operations will be done on a copy of the service data contained in this MCF.
Valid MCF names have the form: MC.<bundle>.<namsid>.0 

For example: MC.XYZ01.1234.0 
Preside MDM Configuration Management for DPN User Guide   14.3RSUP



226   Chapter 11 Envelope Editor
Envelope name
Enter the full name of the target service data area (SDA) or envelope here. If 
you do not know the exact name of the SDA or envelope that you wish to edit, 
use the wildcard (*) character. 

Data Values
The SDA or envelope name must be specified in hierarchical order (e.g. PI 
then PO then envelope). The component, number, and envelope must be 
separated from each other by spaces. The complete envelope name must 
consist of name-number pairs; if a name usually has no associated number, 
use 0 (zero) instead. Examples of valid entries are: 

PI 1 
PI 2 PO 1 ITI 0 HARDWARE_ENV 0 
PI 1 PO 4 ITI 0 ITIDNACUG 123456789012345

Using the wildcard character

Caution: When you generate a list of envelopes, envelopes named 
UNKNOWN may appear in the list. An UNKNOWN envelope is one with a 
type that the Envelope Editor does not understand. Envelopes with a type of 
UNKNOWN are still valid envelopes and may be retrieved, modified, added, 
or deleted just like any other envelope. However, caution is necessary when 
modifying the header of an UNKNOWN envelope, since altering the header 
may change the actual envelope type. 

To have the Envelope Editor provide you with a list of SDAs or envelopes 
within a given SDA: 

• In the Envelope field, enter the wildcard character (*) as the SDA number 
or envelope name. Examples of valid entries are: 

• Choose List envelopes from the File menu. A dialog appears prompting 
you to select one of the SDAs or envelopes that are listed. 

* * list all top level SDAs and envelopes
PI * list all PIs
PI 3 PO * list all POs on PI 3
PI 3 PO 1 * * list service of PO 1 
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• From the List envelopes dialog, select an SDA or envelope and press the 
mouse menu button, and choose Add to name. The name of the selected 
SDA or envelope is placed in the Envelope field. 

• You can now retrieve the envelope, and as desired, perform any of the 
editing operations. 

Service Data Header editing area
This scrolling text field is used for creating or modifying headers for SDA and 
envelopes. The editing commands that are available are: 

• Cut cuts selected text from the window and places it in a buffer.

• Copy copies selected text to a buffer.

• Paste pastes the content of the buffer at the cursor location.

• Delete deletes selected text.

• Select all selects all the text in the window.

• Deselect all deselects the selected text.

Service Data Body editing area
This scrolling text field is used for creating or modifying service data bodies 
for SDA and envelopes.   The same commands as described under “Service 
Data Header editing area” (page 227) are available.

Main Window Clear button
Click this button to discard the service data currently in the Header and Body 
areas.

List window
The SDAs and envelopes within the SDA identified in the Envelope field are 
listed in this window. The following commands are available:

• Add to name adds the selected SDA or envelope name to the current 
contents of the Envelope field. 

• Add to name and List envelopes... adds the selected SDA or envelope 
name to the current contents of the Envelope field, and lists the SDAs and 
envelopes contained in the SDA or envelope. 
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• Cancel click this button to close the list window without performing a 
List envelopes operation. 

Download Confirmation dialog
This dialog window shows that the download operation has successfully 
completed. The name of the new master configuration file (MCF) is shown in 
the window. 

Click the OK button to close the download confirmation window. 

Download window
To continue with the download of service data to a new MCF, enter the bundle 
number for the new MCF in the New bundle field and click OK. 

Click the OK button to download the service data changes to a new MCF. The 
new MCF will have the bundle number entered in the New bundle field. 

Click the Cancel button to cancel the download operation and close the 
download window. 

Retrieving data
The Retrieve envelope command is used to retrieve specific service data 
envelopes. The retrieved service data is placed in the Header and Body areas 
on the main window.

The SDA or envelope name must be specified in hierarchical order, for 
example, PI then PO then envelopes. The component, number, and envelope 
must be separated by a space. The complete envelope name must consist of 
name-number pairs; if a name has no associated number, use 0 (zero) instead. 
The following are examples of valid entries:

PI 1
PI 2 PO 1 ITI 0 HARDWARE_ENV 0
PI 1 PO 4 ITI 0 DNACUG X12345678901234

Retrieving a service data envelope
1 Enter the PM, Root MCF on the PM, Envelope or SDA name.

2 From the File menu choose Retrieve envelope.
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The service data for the specified envelope appears in the Header and 
Body areas.

Manipulating service data
This section explains how to perform all the essential service data operations, 
including 

• adding service data

See “Adding service data” (page 229).

• replacing service data

See “Replacing service data” (page 230).

• deleting service data

See “Deleting service data” (page 231).

• locating envelopes

See “Locating envelopes” (page 231).

• downloading service data

See “Downloading service data” (page 232).

• discarding service data

See “Discarding service data” (page 232).

• clearing fields

See “Clear display fields command” (page 232).

Adding service data
You can use the Add envelope command to create a new service data envelope 
or SDA header for a DPN module; for example, to add a new port to a DPN 
module. See 241-2001-340 DPN-100 Envelope Definitions for service data 
envelope values.
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Adding a service data envelope
1 Specify the envelope you wish to add and the location.

2 Place the cursor in the Header or Body area. Enter the new service in 
hexadecimal or binary format.

3 From the File menu choose Add envelope.

The Header and Body areas are cleared of information. The service data 
is copied to the location specified in the service data identification area 
only after a Download is performed.

or

1 Retrieve the service data envelope.

2 Edit the information in the Header or Body areas.

3 Change the name and location of the envelope in the Envelope area.

4 From the File menu choose Add envelope.

The Header and Body areas are cleared of information. The service data 
is copied to the location specified in the service data identification area 
only after a Download is performed.

Replacing service data
The Replace envelope command is used to make changes to a particular 
service data envelope or SDA header. You can use the Replace envelope 
command to edit service data or to overwrite service data with existing 
service data.

Replacing a service data envelope
1 From the File menu choose Retrieve envelope.

The service data specified appears in the Header and Body areas. 

2 Edit the Header and Body information as appropriate.

3 Change the name and location of the envelope in the Envelope area.

4 When you have completed the changes, choose Replace envelope from 
the File menu. 

The Header and Body areas are cleared of information. The changes are 
implemented after a download is performed.
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Deleting service data
The Delete envelope command allows you to remove specific service data 
envelopes or SDAs from an MCF.

Deleting a service data envelope
1 From the File menu choose Retrieve envelope.

The service data specified appears in the Header and Body areas. 

2 From the File menu choose Delete envelope.

A dialog appears asking you to confirm the delete operation.

3 Click OK to complete the delete operation.

Locating envelopes
The List envelopes command allows you to list envelopes and SDAs within a 
specified wildcarded SDA. The wildcard is used in the Envelope area in place 
of an envelope or SDA name. There must be an even number of variables in 
the Envelope field when specifying a wildcard. For example, * *, PI * or PO 
2 * *. 

Note: See also “Using the wildcard character” (page 226).

Listing service data envelopes
1 Enter the wildcard character (*) in the Envelope area in place of an SDA 

or envelope name.

2 From the File menu choose List envelopes.

The Envelope Editor list dialog appears with a list of SDAs or envelopes 
that are available.

3 Select the item you wish to list.

4 Press menu and choose Add to name and list envelopes.

An Envelope Editor list dialog re-appears with the contents of the 
specified item. 

5 Select the item you wish to add. 

6 Press menu and choose Add to name. 

This replaces the * with the added item.

7 From the File menu choose Retrieve envelope.

The service data specified appears in the Header and Body areas.
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Downloading service data
The Download command downloads all service data changes since the last 
download. This command becomes enabled only when a change has been 
made to service data. You must perform the download operation before you 
make any changes to another MCF, such as adding, replacing and deleting.

1 From the File menu choose Download.

The download dialog appears.

2 Enter the bundle number of the modified service data.

3 Click OK.

A download completed dialog appears when the download operation is 
complete.

Discarding service data
The Discard command is used to discard any changes that have not been 
saved. The Discard command becomes enabled only when a change has been 
made to the service data.

1 From the File menu choose Discard.

A dialog appears asking you to confirm whether you wish to discard all 
service data changes that have not been downloaded.

2 To complete the discard operation, click OK.

Clear display fields command
The Clear display fields button is used to clear the Header or Body text fields. 
This command does not affect any previous changes to service data, such as 
the add and replace commands; it provides a clear area for entering service 
data in the service data header and body area.

Clearing text fields
You have called up service data that now appears in the Header and Body 
areas of the Envelope Editor main window. You wish to clear this information 
and call up some new service data.

1 Click Clear display fields.

The service data is cleared from the text fields. You can now either view 
more service data or exit from the Envelope Editor.
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Unknown envelopes and unknown SDAs
Envelopes or SDAs that the Envelope Editor does not recognize, may be 
retrieved, added, replaced, or deleted like any other envelope or SDA.

Unknown envelopes or SDA headers must follow the format described in 
241-2001-340 DPN-100 Envelope Definitions.
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Network Activation

The Network Activation Tool (NAT) simplifies and automates the activation 
process for multiple modules in a network. The activation and commit 
operations can be performed interactively or in batch mode.

For DPN modules, the NAT can be used to: 

• download MCFs from an NMS Disk

• distribute the software images used by an MCF from a Software 
Distribution Site (SDS) or from a Remote Download Site (RDS)

• activate MCFs

• commit MCFs

• commit loaders

For Passport modules, the NAT can be used to 

• activate a View

• commit a View

There are two interfaces for the NAT:

• a graphical user interface

See “Network Activation window” (page 237).

• a command line interface

See “Network Activation Tool command line interface” (page 273).
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For network activation procedures associated with the Network Activation 
Tool, see “Using the Network Activation tool” (page 261).

The module type, module name, MCF or View names, and actions for 
network activation are stored in a Network Activation File (NAF). The 
graphical user interface lets you create or modify the NAF. To reduce the 
possibility of error, we strongly recommend that you use the graphical user 
interface for creating or modifying a NAF instead of using an editor like vi.

For a description of the fields in a NAF, see “Network Activation File (NAF)” 
(page 269).

Special benefits of using the Network Activation Tool for 
DPN

Configuring a DPN module usually involves the following steps:

1 Configure the MCF with the Component Provisioning Tool.

2 Download the MCF to the DPN module now, or save the MCF on NMS 
disk and download it later (see “Component Provisioning” (page 61)).

3 Distribute the necessary images for the MCF with the Software 
Distribution Tool (see “Software Distribution” (page 179)).

4 Activate and commit the MCF with the Command Console Tool.

If several DPN modules are involved, you need to repeat these steps for each 
module in the network. The Network Activation Tool (NAT) lets you 
automate all the steps that follow step 1, thereby saving time and reducing the 
risk of errors caused by data entry mistakes.

For an illustration of the Network Activation Tool, see the figure “Network 
Activation window” (page 237)
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Figure 18
Network Activation window

Network Activation window
The Network Activation window contains a menu bar, a working area, and a 
Messages area. The working area displays a list of Network Activation (NA) 
records and contains three buttons for rearranging the order of records in the 
list and for executing them. The Messages area is used to display status or 
error information.

For information about items in the Network Activation Window, see the 
following sections:

• “Menu bar” (page 238)

• “Working area” (page 240)

• “Messages area” (page 245)
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Menu bar
The menu bar contains the menus described in the following sections:

• “File menu” (page 238)

• “Edit menu” (page 238)

• “Options menu” (page 239)

• “Security menu” (page 239)

• “Help menu” (page 239)

File menu 
The File menu contains the following commands:

• Load... loads records from a network activation file (NAF) into the record 
list. This command opens the Load NAF dialog in which you specify the 
NAF to load. If the record list has any records displayed in it, a 
confirmation dialog opens and prompts for permission to clear the list 
before loading the NAF.

• Save... saves new or modified records to a NAF. If there are no additions 
or changes in the record list to be saved, or if you have not loaded a NAF, 
this command is disabled (grayed out).

• Save As... saves records to a specified NAF. This command opens the 
Save NAF dialog for specifying the full path name of the NAF. If there 
are no entries in the record list, this command is disabled.

• Exit closes all windows and closes the tool.

Edit menu 
The Edit menu contains the following commands: 

• Add DPN Record... adds a DPN record to the record list. This command 
opens the DPN Edit dialog for entering the data. The new record is added 
after the record that is being pointed at (the record that is surrounded by 
the box with a dashed line).

• Add Passport Record... adds a Passport record to the record list. This 
command opens the Passport Edit dialog for entering the data. The new 
record is added after the record that is being pointed at (the record 
surrounded by the box with a dashed line).
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• Clear removes all records from the record list. If the list has been 
modified but not saved, a confirmation dialog opens to obtain 
confirmation of the clear.

Options menu
The Options menu contains the following commands:

• DPN Preferences opens the DPN Preference dialog. This dialog is used 
for entering the preferred values for a new DPN record.

• Passport Preferences opens the Passport Preference dialog. This dialog 
is used for entering the preferred values for a new Passport record.

• Save Preferences saves, for future sessions, any changes you made in the 
DPN Preference or Passport Preference dialogs.

Security menu 
The Security menu contains the following commands:

• Group Authenticate... opens the Passport Group Authentication dialog to 
perform authentication for accessing a group of Passport modules. 
Although you can authenticate with more than one group, only the last 
group you authenticated with is active. 

• NCS Authenticate... opens the DPN Authentication dialog to perform 
authentication for accessing DPN modules that are managed by one OA. 
Although you can authenticate with more than one OA, only the last OA 
you authenticated with is active.

Help menu
The Help menu contains the following commands: 

• On Context lets a user obtain help information for an item in the NAT 
main window. Choosing this command changes the cursor to a question 
mark. Moving the question mark to an item in the window and clicking 
the select button provides help information about the item selected.

• On Help displays help text about how to use the help facility. 

• On Window displays help text about the application main window and its 
general contents. 
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• On Keys displays help text about the function keys, mnemonics, and 
keyboard accelerators. The accelerators are as follows:

Ctrl + L = Load...

Ctrl + S = Save

Ctrl + A= Save As...

Ctrl + E = Exit

Ctrl + G = Group Authenticate...

Ctrl + N = NCS Authenticate...

Working area
The working area of the Network Activation Tool (NAT) contains a Network 
Activation (NA) record list that uses color indicators to indicate the status of 
network activation. The record list also supports a pop-up menu and contains 
three action buttons. For descriptions of these items, see:

• “NA record list” (page 240)

• “Color indicators” (page 242)

• “Pop-up menu” (page 243)

• “Up and down arrow buttons” (page 243)

• “Execute button” (page 244)

NA record list
The NA record list displays Network Activation (NA) records. The content of 
the records and their order in the list can be modified using commands and 
action buttons. See also:

• “Pop-up menu” (page 243)

• “Up and down arrow buttons” (page 243)

• “Execute button” (page 244)
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You can select a set of records in the NA record list for execution. While 
execution is in progress, fields in the records change color to indicate the 
execution status. See also: “Color indicators” (page 242).

The NA record list contains the following fields:

• CR indicates (YES|NO) whether the MCF/View is critical. 

Critical records are executed first, one at a time, in the order in which they 
appear in the list. Then the non-critical records are executed. If a critical 
record cannot be executed, the tool stops and does not execute the next 
record.

• Module displays the module name in the format PM/<PM name> for 
DPN modules or EM/<Passport name> for Passport modules.

• MCF/View Mode indicates the method used for accessing the MCF or 
View. The mode is one of:

K access with a key

D access by date

U access according to a user-specified information

• MCF/View Name indicates the name of the key, the date, the bundle_id 
(for DPN), or the View (for Passport) used for activation or committing.

• NMS Disk indicates whether an MCF is to be downloaded from an NMS 
disk to a DPN module. For a Passport module, this field is not applicable 
and is always set to “-”.

• RDS/SDS indicates whether the software images used by an MCF are to 
be distributed to a DPN module from a Remote Distribution Site (RDS) 
or a Software Distribution Site (SDS). For a Passport module, this field 
is not applicable and is always set to “-”.

• Date Verify indicates whether date verification is to be performed on an 
MCF or a View that is to be activated by date. When Date Verify is set to 
YES, the date of the MCF or View is checked against the date of the active 
MCF or View. If the MCF or View has a dated key that predates the active 
MCF or View, activation fails and the record turns red. 
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• MCF/View Act indicates whether the MCF or View is to be activated.

• MCF/View Commit indicates whether the MCF or View is to be 
committed.

• Loaders Commit indicates whether the loaders are to be committed for a 
DPN module. For a Passport, this field is not applicable and is always set 
to ‘-’.

The NA record list is a multi-select list, which means you can select more 
than one record at a time. 

The NA record list also supports double-clicking. Double-clicking on a 
record that has not been executed selects the record and opens a dialog for 
viewing or editing the record. Double-clicking on a record that has been 
executed selects the record and opens a dialog that displays log information 
about execution of the record.

Color indicators
Different colors are used to indicate the status of the NA records. The colors 
and their meanings are as follows:

• No color means the record is ready for execution.

• Blue means the record has been executed successfully.

• Green means execution is in progress. When a specific action is being 
performed, the corresponding field turns from blue to green. If the action 
completes successfully, the field turns from green to blue and the next 
field turns green. When all actions on a record are completed 
successfully, the entire record turns blue. If an action fails, the entire 
record turns red or yellow, according to the severity of the error.

• Yellow means that a minor error was found during execution or that 
execution was interrupted by the user.

• Red means a major error was found during execution. This record can 
only be re-executed if the user resets the state manually. 

After execution is complete, a user can reset the color of the records back to 
no color in preparation for re-execution by means of the Reset command. This 
command is available in the record list pop-up menu.
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Pop-up menu
The record list is equipped with a pop-up menu that contains the following 
commands:

• Edit opens the DPN Edit dialog or the Passport Edit dialog for viewing 
or editing a record that is selected in the record list. The module name 
cannot be changed during the edit.

• Use Preferences applies values that were pre-defined in the DPN 
Preference dialog or in the Passport Preference dialog to records that are 
selected in the record list.

• Add DPN Record... opens the DPN Edit dialog for entering a new DPN 
record. The new record is added after the highlighted record.

• Add Passport Record... opens the Passport Edit dialog for entering a new 
Passport record. The new record is added after the highlighted record. 

• Delete deletes records that are selected from the NA record list. A 
confirmation dialog opens and prompts for permission to perform the 
deletion.

• Show Status opens a dialog that shows execution information for a record 
that is selected in the NA record list. This command is only enabled if the 
record has been executed.

• Reset changes the state of selected records bask to their initial state then 
deselects the records. This allows the records to be re-selected and re-
executed, regardless of their previous state.

• Select All selects all records in the NA record list.

• Deselect All deselects all selected records.

Up and down arrow buttons
The up arrow button moves records that are selected in the NA records list 
upwards towards the top of the list. The down arrow button moves them 
downwards. You can select more than one record at a time to move up or 
down.

The up and down arrows are especially useful for rearranging records to 
change their execution order, or for reducing the number of times you need to 
authenticate to execute all of the records in the record list.
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Critical records in the record list are always executed first, one at a time, in 
the order in which they appear in the list, followed by the non-critical records. 
You can rearrange the critical records with the arrows to specify the order in 
which the critical records, followed by the non-critical records, are executed.

With the Network Activation Tool, you can only execute records for DPNs 
managed by one OA or for Passports in one Passport group at a time. On 
occasion, records may apply to modules that are managed by different OAs 
or that belong to different Passport groups. To execute all of the records, you 
need to authenticate with the OAs or Passport groups as needed. You can use 
the arrows to group all the records for one OA or Passport group together, 
minimizing the number of times you need to authenticate.

The up and down arrows are disabled unless at least one record is selected in 
the list.

Execute button
The Execute... button executes the records that are selected in the NA record 
list.

When you click Execute..., a confirmation dialog opens and displays the list 
of modules on which the actions are to be performed, prompting for 
confirmation. For more information, see “Network Activation - confirmation 
dialog” (page 260).

Clicking OK in the confirmation dialog opens an Execution dialog for 
specifying the parameters for the execution. Once you have set up the 
execution parameters in the Execution dialog, clicking on the Execute button 
starts execution of the records. For more information, see “Execution dialog” 
(page 256). 

When execution of a record begins, the entire record turns blue. Then, as each 
step in the execution takes place, the field associated with the step turns from 
blue to green. If the step is successful, the field turns from green to blue, and 
the next field turns green. If all steps in are executed successfully for a record, 
the entire record turns blue. If a step fails, the entire record turns red or yellow, 
according to the severity of the failure.
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While execution is underway, the Execute... button is replaced by a Stop 
button that can be used to halt execution. Halting execution turns the record 
in which execution was halted to yellow.

Records in the record list are executed as follows:

• Red, yellow, or blue color records are not executed.

• Critical records are executed first, one at a time, in the order in which they 
appear in the record list.

• Non-critical records are executed after critical records, also in the order 
in which they appear in the list.

• If execution of a critical MCF or View fails, the tool stops and does not 
execute the next record.

• Records are only executed for the Passport group or OA whose 
authentication is currently active. That is, the group or OA that has most 
recently been authenticated by selecting Group Authenticate... or NCS 
Authenticate... from the Security menu.

Messages area
The Messages area displays execution status information and error messages. 

Dialogs
For information about dialogs for the NAT, see the following:

• “Network Activation - Load NAF dialog” (page 246)

• “Network Activation - Save NAF dialog” (page 247)

• “Network Activation - DPN Edit dialog” (page 248)

• “Network Activation - Passport Edit dialog” (page 252)

• “DPN Preference dialog” (page 256)

• “Passport Preference dialog” (page 256)

• Group Authentication dialog, see 241-6001-023 Preside MDM 
Configuration Management for Passport User Guide

• NCS Authentication dialog, see “Authentication dialog” (page 50)

• “Execution dialog” (page 256)
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• “Processing dialog” (page 259)

• “Network Activation - confirmation dialog” (page 260)

• “Network Activation - log information dialog” (page 260)

• “Error dialog” (page 261)

• “Warning dialog” (page 261)

Network Activation - Load NAF dialog
The Network Activation - Load NAF dialog lets you specify the name of a 
NAF file that contains records to be loaded into the NA record list.See the 
figure “Network Activation -Load NAF dialog” (page 247).

The dialog contains the following items:

• a Filter field for specifying the path to the directory that is to be used as 
a starting point for finding the NAF to load

The subdirectories of the directory specified in this field are displayed in 
the Directories panel of the dialog when you enter a carriage return in 
this field, or when you click the Filter button.

• a Directories panel for displaying the available subdirectories of the 
directory specified in the Filter field

• a Files panel for displaying the available files of the directory selected in 
the Directories panel

• a Network Activation File field for specifying the full path name of the 
NAF to be loaded

You can specify the name of a NAF to be loaded in one of two ways: by 
entering its full path name in this field; or, by entering information in the 
Filter field, selecting a directory in the Directories panel, and selecting a 
file in the Files panel.

• a Load button for loading the NAF specified in the Network Activation 
File field into the NA record list

• a Filter button for updating the Directories panel, the Files panel, and the 
Network Activation File field according to the pathname entered in the 
Filter field
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• a Cancel button for aborting the load and closing the dialog

• a Help button for displaying help information about the dialog

Figure 19
Network Activation -Load NAF dialog

Network Activation - Save NAF dialog
The Network Activation - Save NAF dialog lets you specify the full path name 
of a NAF in which to save new or modified records from the NA record list. 
See the figure “Network Activation - Save NAF dialog” (page 248).
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Fields, panels, and buttons in the dialog are similar to those in the Network 
Activation - Load NAF dialog. See also “Network Activation - Load NAF 
dialog” (page 246).

Figure 20
Network Activation - Save NAF dialog

Network Activation - DPN Edit dialog 
The Network Activation - DPN Edit dialog lets you specify information and 
actions for a new DPN record that is to be added to the NA record list, or to 
modify an existing DPN record that is selected in the NA record list. 
Information in the dialog applies to one MCF. See the figure “Network 
Activation - DPN Edit dialog” (page 252).

Double-clicking on an existing DPN NA record opens the DPN Edit dialog 
that contains the data from the record. From this dialog, you can change any 
parameters and actions, except the module name displayed in the PM field.
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If you select Add DPN Record... from the Edit menu or from the NA record 
list pop-up menu, the DPN Edit dialog opens and displays the preferences 
defined in the DPN Preference dialog. The PM field is empty. If no 
preferences have been set, the following defaults are used: 

The DPN Edit dialog contains the following items:

• a PM data entry field for specifying the DPN module name

If you are editing an existing record, the PM field displays the DPN 
module name associated with the record you are editing. You cannot 
modify this name while editing the record.

• a DPN MCF Parameters panel for specifying parameters associated with 
the target MCF, which consists of: 

PM data entry field Empty

Critical check NO

MCF Mode User specified

MCF Mode Data entry field Empty

Check against active MCF NO

Download MCF from NMS disk NO

Software Distribution NO

Activate NO

Commit NO

Timeout (in minutes) 50

Commit Loaders NO

Comments Empty
Preside MDM Configuration Management for DPN User Guide   14.3RSUP



250   Chapter 12 Network Activation
— a Critical check button to indicate whether the action to be 
performed is critical or non-critical

— a set of radio buttons labelled Keyed, Dated, or User specified, and a 
data entry field

If you select Keyed, the label of the data entry field changes to Key
and you need to enter a valid key for the MCF.

If you select Dated, the label changes to Date and you need to enter
a date for the MCF in the format yymmdd. If Dated is selected as a
preference in the DPN preference dialog, the current date appears in
the field. However, if Date is not selected as a preference and you
click Dated, the Date field appears but is blank. To put the current
date into the Date field, click the Dated radio button again. See
“Dated algorithm” (page 45) for more information on the date
format.

If you select User specified, the label changes to Bundle and you
need to enter a valid bundle name for the MCF.

— a check button labelled Check against Dated MCF to specify 
whether the date is to be verified against the date of the current MCF 
before activating or committing it

If you select this button, the date of the MCF is verified against the
date of the active MCF. If the date specified is earlier than that of the
active MCF, execution of the record fails.

This check button is only enabled when the Dated mode is selected.

— a set of check buttons labelled Activate, Commit, and Commit 
Loaders for specifying whether activate and/or commit actions are 
to be performed for the MCF

If you click the Commit Loaders button, the L2 Loader and L3
Loader entry fields are enabled and you need to enter valid L2 and
L3 loader names in these fields.

— a data entry field labelled Timeout (in minutes) for specifying the 
activation timeout period
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• a Download panel for specifying the location of the MCF to be 
downloaded and the source of software associated with the MCF

This panel consists of:

— a check button to select Downloading MCF from NMS disk

If you click this button, a set of radio buttons for the source MCF
mode and its associated data entry fields are enabled. These are
Keyed, Dated, and User specified.

— a check button labelled Download Software From

If you click this button, two radio buttons for specifying the source
of images associated with the MCF (RDS, SDS) are enabled.

• a text area labelled Comments for adding user comments

• a text area labelled Messages for displaying messages about attempts to 
add or modify information in the dialog

• an OK button that is used to add or replace the record in the list and close 
the dialog

If you fail to enter information in a required field, an error icon (X) 
appears beside the corresponding field in the dialog and a message 
indicating the error appears in the Messages area. You need to enter the 
correct information in the field before the dialog will close and the record 
can be added or saved.

• a Cancel button that closes the dialog without saving additions or 
changes that made in the dialog

• a Help button that displays help information about the dialog
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Figure 21
Network Activation - DPN Edit dialog

Network Activation - Passport Edit dialog 
The Network Activation - Passport Edit dialog lets you specify the 
information and actions for a new Passport record that is to be added to the 
NA record list, or to modify an existing Passport record that is selected in the 
NA record list. Information in the dialog applies to one View. See the figure 
“The Network Activation - Passport Edit dialog” (page 255).

Double-clicking on an existing Passport record opens the Passport Edit dialog 
that contains the data from the record. From this dialog, you can change any 
parameters and actions, except the module name displayed in the EM field.
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If you select Add Passport Record... from the File menu or from the NA 
record list pop-up menu, the Passport Edit dialog opens with the data defined 
in the Passport Preference dialog and the EM field empty. If no preferences 
have been set, the following defaults are used

The Passport Edit dialog contains the following items:

• an EM data entry field for specifying the Passport module name 

If you are editing an existing record, the EM field displays the Passport 
module name associated with the record you are editing. You cannot 
modify this name while editing an existing record.

• a Passport View Parameters panel for specifying parameters associated 
with the target Passport View, which consists of:

— A Critical check button to indicate whether the action to be executed 
is critical or non-critical

EM data entry field Empty

Critical NO

Keyed NO

Dated NO

User Specified YES

Data entry field Empty

Check against current view NO

Activate NO

Commit NO

Timeout (in minutes) 50

Comments Empty
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— a set of radio buttons labelled Keyed, Dated, and User specified, and 
a data entry field, which together specify the View access mode

If you select Keyed, the label of the data entry field changes to Key
and you need to enter the name of a valid key for the Passport view.

If you select Dated the label changes to Date and you need to enter
a date for the Passport view in the format yymmdd. If Dated is
selected as a preference in the Passport preference dialog, the
current date appears in the field. However, if Date is not selected as
a preference and you click Dated, the Date field appears but is blank.
To put the current date into the Date field, click the Dated radio
button again. See “Dated algorithm” (page 45) for more
information on the date format.

If you select User specified, the label changes to View and you need
to enter a valid View name.

— a check button labelled Check against current view for specifying 
whether the date is to be verified against the date of the current View 
before activating or committing

If you select this button, the date of the View is verified against the
date of the active View. If the date specified is earlier than that of the
active View, execution of the record fails.

This check button is only enabled when the Dated mode is selected.

• a set of check buttons labelled Activate and Commit for specifying 
whether activate and/or commit actions are to be performed

• a data entry field labelled Timeout (in minutes) for specifying the 
activation timeout period

• a text area labelled Comments for adding user comments

• a text area labelled Messages for displaying messages about attempts to 
add or modify information in the dialog
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• an OK button that is used to add or replace the record in the list and close 
the dialog

If you fail to enter information in a required field, an error icon (X) 
appears beside the corresponding field in the dialog and a message 
indicating the nature of the error appears in the Messages panel. You 
need to enter the correct information in the field before the dialog will 
close and the record can be added or saved.

• a Cancel button that closes the dialog without saving any additions or 
changes

• a Help button that displays help information about the dialog

Figure 22
The Network Activation - Passport Edit dialog
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DPN Preference dialog 
The DPN preference dialog lets you specify:

• the default data to be used for adding a new DPN record to the record list

• the values to apply to DPN NA records that are selected in the record list 
when you choose the Use Preferences command from the record list pop-
up menu

The DPN preference dialog is identical to the DPN Edit dialog, except that:

• The PM field and the Comments and Messages text fields are absent.

• The OK button sets the preferences values for the current session and 
closes the dialog.

See also “Network Activation - DPN Edit dialog” (page 248).

Passport Preference dialog 
The Passport preference dialog lets you specify:

• the default data to be used for adding a new Passport NA record to the 
record list

• the values to apply to Passport records that are selected in the record list 
when you choose the Use Preferences command from the record list pop-
up menu

The Passport preference dialog is identical to the Passport Edit dialog, except 
that:

• The EM field and the Comments and Messages text fields are absent.

• The OK button sets the preferences values for the current session and 
closes the dialog.

See also “Network Activation - Passport Edit dialog” (page 252).

Execution dialog
The Execution dialog lets you specify parameters such as the working 
directory and the number of processes for executing NA records. See the 
figure “Execution dialog” (page 259).
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The Execution dialog contains the following items:

• a Working Directory field for specifying the directory for storing working 
files that are created while the tool is running. 

• a Number of Processes field for specifying the number of non-critical 
records in the list on which execution can be performed simultaneously. 
The default is 1.

The number to specify depends on the amount of memory available on 
the workstation. The higher the number, the more memory is used.

This parameter only applies to non-critical records. For critical records, 
only one record is executed at a time, regardless of the number you 
specify for this parameter.

• a Log to File check button for specifying whether information about the 
execution is to be captured in a log file

If this button is not selected the panels, fields, and buttons in the log file 
specification area are disabled (grayed out). The default is no log file.

• a Log File specification area that is used to specify the full path name of 
a log file for log messages that are produced during the execution. 

The log file specification area consists of the following items:

— a Filter field for specifying the path to the directory that is the 
starting point for choosing the directory in which to store the log file

The subdirectories of the directory specified in this field are
displayed in the Directories panel when you enter a carriage return
in this field or when you click the Filter button.

— a Directories panel for displaying the available subdirectories of the 
directory specified in the Filter field

— a Files panel for displaying the available files of the directory 
selected in the Directories panel
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— a Log File Name field for specifying the full path name of the log file 
to be stored

You can specify the name of a log file in two ways: by entering its
full path name in this field; or, by entering information in the Filter
field, selecting a directory in the Directories panel, and selecting a
file in the Files panel. The default is nat.log in the user’s home
directory.

— a Filter button for updating the Directories panel, the Files panel, 
and the Log File field according to the pathname entered in the Filter 
field

• an Execute button for executing the action based on the information

• a Defaults button that resets all items in the dialog back to their default 
values

• a Cancel button that closes the dialog without performing the execution 
or saving the execution parameters

• a Help button that displays help information about the dialog
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Figure 23
Execution dialog

Processing dialog
The Processing dialog opens if you click on the Stop button in the Network 
Activation Tool window while execution is underway. This dialog displays 
the message Stopping all execution processes, please wait to indicate that no 
further user action is permitted until all execution software processes are 
terminated, at which time the dialog closes.
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Network Activation - confirmation dialog
The confirmation dialog prompts you for confirmation before the software 
takes the next step:

• When you click Execute in the Network Activation Tool (NAT) window, 
the dialog displays information about the records to be processed and 
asks you for permission to continue.

• When you select Delete from the record list pop-up menu, the dialog 
prompts for confirmation to remove the selected record.

• When you select Exit without saving new DPN or Passport records to a 
Network Activation File (NAF), the dialog asks if you really want to exit 
without saving.

Buttons in the dialog are as follows:

• OK continues the execution.

• Cancel closes the dialog without performing the execution.

• Help displays information about the dialog.

See the figure “Network Activation -sample confirmation dialog” (page 260).

Figure 24
Network Activation -sample confirmation dialog

Network Activation - log information dialog
The log information dialog displays status information for a record that has 
been executed. See the figure “Sample log information dialog” (page 261).
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To display the information, double-click on an executed record in the record 
list; or, select the log in the record list and choose Show Status... from the 
record list pop-up menu.

Figure 25
Sample log information dialog

Error dialog
The Network Activation error dialog displays a message to indicate why an 
action cannot be performed. Once you have read the message, click OK to 
close the dialog. Then, correct the source of the error and try the action again.

Warning dialog
The Network Activation warning dialog displays a message to indicate the 
consequences of the action you are about to take. This dialog also prompts 
you for confirmation of the action.

Buttons in the dialog are as follows:

• OK closes the dialog continues the action.

• Cancel closes the dialog without performing the action.

• Help displays information about the dialog.

Using the Network Activation tool
For procedures to use the Network Activation tool (NAT) see the following:

• “Starting the Network Activation tool” (page 262)
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• “Loading a Network Activation File” (page 262)

• “Adding new NA records” (page 263)

• “Modifying NA records” (page 263)

• “Deleting records” (page 265)

• “Saving to a Network Activation File” (page 265)

• “Executing a Network Activation File from the GUI” (page 266)

• “Executing a Network Activation File using the command line” 
(page 269)

Starting the Network Activation tool
1 In the Preside MDM window, select Configuration ->DPN Devices -> 

Administration ->Network Activation Tool.

The Network Activation window opens.

Loading a Network Activation File
1 From the File menu, choose Load...

The Network Activation - Load NAF dialog opens. See also: “Network 
Activation - Load NAF dialog” (page 246).

If there are any records displayed in the record list, a confirmation dialog 
opens and prompts you for permission to clear entries in the record list 
before loading the Network Activation File (NAF).

2 Specify the Network Activation File to load in one of the two following 
ways:

• Enter the full path of the file in the Network Activation File field.

• In the Filter field, enter the full path of the directory to be used as the 
starting point for finding the NAF to load. In the Directories panel, 
click on the name of the appropriate subdirectory. In the Files panel, 
click on the name of the NAF to load. The name of the file you have 
selected appears in the Network Activation File field.

3 Click Load.

The Network Activation - Load NAF dialog closes and the records from 
the NAF are loaded into the record list.
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Adding new NA records
1 If the record list is empty, go to step 4.

2 Click on a record.

The entire record becomes highlighted to indicate that it is selected. Any 
new record is added immediately below the record that is selected 
(highlighted).

3 If the record needs to be inserted after a different record from the one that 
is currently selected, click the up or down arrow in the NAT window to 
select the record immediately above where the new record is to be 
inserted.

4 To add a new DPN NA record, choose Add DPN Record... from the Edit 
menu or from the record list pop-up menu.

To add a new Passport NA record, select Add Passport Record... from the 
Edit menu or from the record list pop-up menu.

If you select Add DPN Record..., the DPN Edit dialog opens. See 
“Network Activation - DPN Edit dialog” (page 248). 
If you select Add Passport Record..., the Passport Edit dialog opens. See 
“Network Activation - Passport Edit dialog” (page 252).

5 Enter the module name, target MCF or View, and specify the actions to 
be performed.

6 Click OK to add the new record to the record list.

The new record appears after the currently selected record in the NAT 
window.

7 Repeat this procedure, once for each new record to be added to the 
record list.

You are now ready to save the records to a NAF or to execute the NA records 
in the record list.

Modifying NA records
Use the following procedures to modify existing DPN or Passport NA records 
in the record list. You can modify a single record at a time using the Edit DPN 
or Edit Passport dialogs, or you can modify several records at once using the 
DPN Preference or Passport Preference dialogs.
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If you choose to modify several records by means of the preferences dialogs, 
you can change all the information, except the module name. If you wish to 
change the module name, you need to edit each record individually.

Modifying a single record
1 Double-click on the record to be modified; or, select the record and 

choose Edit from record list pop-up menu.

The DPN Edit dialog opens if the record is a DPN NA record or the 
Passport Edit dialog opens if the record is a Passport NA record.

2 Modify the data in the record.

For more information, see “Network Activation - DPN Edit dialog” 
(page 248) or “Network Activation - Passport Edit dialog” (page 252).

3 Click OK to apply the changes.

Modifying several records using the DPN Preference or Passport 
Preference dialogs
1 Choose DPN Preferences... or Passport Preferences... from the Options 

menu.

The DPN Preference dialog or the Passport Preference dialog opens.

2 Change the appropriate preferences and click OK.

For more information, see “DPN Preference dialog” (page 256) or 
“Passport Preference dialog” (page 256).

3 If you want to preserve these preferences for future use, choose Save 
Preferences from the Options... menu.

4 In the NA record list, click on each of the records to which the preferences 
are to be applied. 

Each record becomes highlighted to indicate that it is selected.

5 From the record list pop-up menu, choose Use Preferences.

All the selected records now have the same data values as defined in the 
DPN Preference dialog or Passport Preference dialog. 

You are now ready to save the changes to a Network Activation File (NAF) or 
to execute the NA records in the record list.
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Deleting records
Use the following procedures to remove records from the record list. There 
are two ways to do this: clear all records from the record list, or delete 
individual records from the record list.

Clearing all records from the record list
1 From the Edit menu, select Clear.

A dialog opens prompting you to confirm that you wish to remove all of the 
records from the record list.

2 Click OK.

The confirmation dialog closes and all records are cleared from the record 
list.

Deleting individual records from the record list
1 In the record list, click on each record that you wish to delete.

Each record becomes highlighted to indicate that it is selected.

2 From the record list pop-up menu, select Delete.

A dialog opens prompting you to confirm that you wish to remove the 
selected records from the record list.

3 Click OK.

The confirmation dialog closes and the selected records are deleted from 
the record list.

You are now ready to save the changes to a Network Activation File (NAF) or 
to execute the NA records in the record list.

Saving to a Network Activation File
Use the following procedures to save records in the record list to a Network 
Activation File (NAF). Two commands are available for saving new or 
modified records from the record list to a NAF: Save and Save As... The 
command to use depends on whether you loaded a NAF and whether you 
want to save the record list to an existing NAF or to a new NAF.

Saving records to a NAF that is loaded into the record list
1 Select Save from the File Menu.

Note:  The Save command is disabled if you haven’t loaded a NAF or if 
no changes have been made to the record list.
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The changes are saved to the NAF you loaded.

Saving records to a NAF when you haven’ t loaded one, or to a 
NAF other than the one you loaded
1 Select Save As... from the File menu.

The Save NAF dialog opens. See “Network Activation - Save NAF dialog” 
(page 247).

2 Specify the NAF file name in one of the two following ways:

• Enter the full path of the file in the Network Activation File field.

• In the Filter field, enter the full path of the directory to be used as the 
starting point for saving the NAF. In the Directories panel, click on the 
name of the appropriate subdirectory. In the Files panel, click on the 
name of the NAF to save the file as. The name of the file you have 
selected appears in the Network Activation File field.

3 Click OK.

The dialog closes and the contents of the record list are saved to the 
specified NAF.

Executing a Network Activation File from the GUI
Executing a Network Activation File (NAF) from the GUI involves the 
following steps:

• loading a NAF, if you wish to execute records from an existing NAF

• making any required modifications to the NA records

• rearranging records so that they appear in the record list in the desired 
execution order

• selecting the records to execute in the record list

• authenticating with the NCS destination or the Passport group that is the 
target for the MCF or View

• clicking on Execute... to open the Execute dialog

• setting up parameters for the execution in the Execute dialog

• clicking OK in the execution dialog to execute the records
241-6001-012   14.3RSUP   



Chapter 12 Network Activation   267
Blue, yellow, or red records are not executed. If both critical and non-critical 
records are selected, the critical records are always executed sequentially 
before non-critical records. If the activation of a critical MCF or View fails, 
the tool will not process the next record.

If records apply to Passports in more than one group or to DPNs that are 
managed by more than one OA, you need to authenticate with each group or 
OA to execute all records. To minimize authentication, use the up and down 
arrows to group records according to the managing OA or Passport group 
before you execute them.

To execute a NAF using the graphical user interface of the NAT, do the 
following:

1 If you wish to execute an existing NAF, load the NAF into the records list 
as described in “Loading a Network Activation File” (page 262).

Note:  You do not need to load a NAF to execute NA records. You can 
create new records in the record list and execute them, and if desired, 
save them to a NAF later.

2 If desired:

• Add any new records as described in “Adding new NA records” 
(page 263).

• Modify existing records as described in “Modifying NA records” 
(page 263).

• Delete undesired records as described in “Deleting records” 
(page 265).

3 Re-arrange the execution records into the desired execution order.

To move a record, click on the record to select it, then click the up arrow 
or the down arrow to move the record up or down in the list.

If records apply to DPNs that are managed by more than one OA or to 
Passports that belong to more than one Passport group, we recommend 
you group records according to the OA or the Passport group.

Note 1:  You can select and move more than one record at a time.

Note 2:  All critical records are executed first, one at a time, followed by 
the non-critical records.

4 In the NAF window, select the records to be executed by clicking on them.
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Only select records that are managed by the same OA or that belong to 
Passports in the same Passport group.

The records become highlighted to indicate that they are selected.

5 If you have selected DPN NA records to execute, go to step 6.

If you have not selected any DPN records to execute, go to step 9.

6 Select NCS Authenticate... from the Security menu.

The DPN Authentication Dialog opens. For more information, see 
“Authentication dialog” (page 50).

7 Enter or select an NCS destination mnemonic, and enter a valid userid 
and password for the destination.

Click OK to authenticate and close the dialog if authentication is 
successful.

8 If you have selected Passport NA records to execute, go to step 9. 

If you have not selected Passport NA records to execute, go to step 11.

9 Select Passport Group Authenticate... from the Security menu.

The Passport Group Authentication Dialog opens. For more information, 
see  241-6001-023 Preside MDM Configuration Management for 
Passport User Guide.

10 Enter or select the Passport group name, and enter a valid userid and 
password for the group.

11 Click OK to authenticate.

Authentication takes place. If authentication is successful, the dialog 
closes.

12 In the NAF window, click Execute...

The Execution dialog opens.

13 In the Execution dialog, specify:

• the working directory, if desired

• the number of processes to a number other than 1, if required

• the name of a log file to be used for execution information

For more information, see “Execution dialog” (page 256).

14 Click Execute to begin executing the selected records.
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Execution begins and colors of fields and records change as execution 
progresses. Information about the execution is written into the log file you 
specified in the Execution dialog.

As each process (download from NMS disk, load software from RDS/
SDS, and so on) is performed, the corresponding field in the record turns 
from blue to green.

If the action completes successfully, the field turns from green to blue and 
the next field turns green. When all actions on a record are completed 
successfully, the entire record turns blue. If an action fails, the entire 
record turns red or yellow according to the severity of the error.

15 If there are records to execute for DPNs that are managed by another OA 
or for Passports in another Passport group, go back to step 4, to select 
these records, re-authenticate, then execute them.

16 If you wish to execute the records again, select the records to be 
executed, choose Reset from the record list pop-up menu, then start back 
at step 12 to re-execute the records.

Executing a Network Activation File using the command line 
To execute a Network Activation File (NAF) from the command line, do the 
following:

1 Create the NAF. You can do this with the GUI of the NAT or with an editor 
such as vi. To reduce the possibility of error, we recommend that you use 
the GUI instead of an editor for performing this task. 

For information about the structure of a NAF, see “Network Activation File 
(NAF)” (page 269).

2 Execute the NAF from a Unix window, by running the natcmd command 
to process the NAF.

See “Network Activation Tool command line interface” (page 273) for the 
syntax of the natcmd utility.

Network Activation File (NAF)
The Network Activation file (NAF) is used as the input file for both the 
command line and the GUI. Nortel Networks recommends that you use the 
GUI to edit the NAF, in order to ensure its syntactic and logical correctness 
(although it can be edited using any editor).
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Each NA record in the NAF is defined in a single line. Each record specifies 
the module type, module name, the target MCF/View, a set of actions, and 
associated parameters. The syntax of a record in a NAF is as follows:

-[pm | em] <module_name> 
-sdfile <mode> <name> 
[-critical]
[-activate] 
[-commit] 
[-timeout <minutes>]
[-loader <L2Loader> <L3Loader>] 
[-verify_date] 
[-download <mode> <name> <namsid>] 
[-rds_swd | -sds_swd] 
[# comments]

Note: Although we have presented the fields on different lines in this 
document, all of the fields in a NAF record are part of the same line. 

where:

-pm

indicates an NA record for a DPN module.

-em

indicates an NA record for a Passport module.

<module_name>

is the name of the DPN or Passport module.

-sdfile

is the keyword for specifying the MCF or View name. When specified, 
this keyword needs to be followed by the <mode> and <name> 
parameters.

<mode> 

is one of keyed, dated, or user-specified.
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<name>

is the name of a valid key, a valid date in the format yymmdd, or a bundle-
id (for DPN) or a View name (for Passport).

-critical

indicates that the MCF or View is critical.

-activate

indicates that the MCF or View is to be activated.

-commit

indicates that the MCF or View is to be committed.

-timeout

indicates the activation timeout period. When specified, this keyword 
needs to be followed by the <minutes> parameter. When not specified, 
the timeout period defaults to 50 minutes.

-loader

is the keyword to specify that the DPN loaders are to be committed. This 
action is only valid for DPN modules. When specified, this keyword 
needs to be followed by the <L2Loader> and <L3Loader> parameters.

<L2Loader>

is the L2 Loader name.

<L3Loader>

is the L3 Loader name.

-verify_date

specifies that date verification is to be performed.

When this option is specified, the date of the MCF or view is verified 
before activation to ensure that the date is later than that of the current 
MCF or View. The current MCF or View also needs to be assigned the 
Dated mode of activation. 
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-download

is the keyword to specify that the MCF is to be downloaded to DPN.

When specified, the MCF from the NMS disk is downloaded to the DPN 
module. This keyword needs to be followed by the <mode>, <name>, 
and <namsid> parameters.

<namsid>

is the NAMSID of the DPN module.

-rds_swd

specifies that DPN software associated with the MCF is to be distributed 
to the DPN module software distribution from the RDS.

When this option is specified, the sds_swd option cannot be specified.

-sds_swd

specifies that DPN software associated with the MCF is to be distributed 
to the DPN module software distribution from the SDS.

When this option is specified, the rds_swd option cannot be specified.

<#comments>

are comments applicable to the record.

Anything after a pound (#) sign is treated as a comment.

Sample of a Network Activation File
The following is a sample NAF:

-pm PM1 -sdfile dated 960605 -verify -activate -loader 
L2LOADER.PIMG4044 L3LOADER.PIMG4044

-pm PM2 -sdfile dated 960605 -activate -commit -loader 
L2LOADER.PIMG5004 L3LOADER.PIMG5004

-pm PM3 -sdfile dated 970707 -download keyed west 1234 
-rds_swd -activate -commit

-em PP1 -sdfile dated 960605 -activate
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-em PP2 -sdfile keyed West1 -critical -activate -commit 
#Western region

Note: Although records 2, 3 and 5 are split into two lines in this 
document, each record is actually one line in the NAF.

Network Activation Tool command line interface
The Network Activation Tool (NAT) provides the user a command line to 
process the NAF. It can be invoked from a UNIX window. The syntax of the 
command is as follows:

/opt/MagellanNMS/bin/natcmd -f <NAF_filename> \
[-auth <passport_group_name> <userid> <password>] \
[-ncs <dest_name> <capability_id> <password>] \
[-logfile [<log_filename>]] \
[-np <number_of_processes>] \
[-wd <working_dir>] \
[-quiet]
[-h]

where:

-f 

is the keyword to specify a Network Activation File (NAF).

This keyword needs to be followed by the <NAF_filename> parameter.

<NAF_filename>

is the full path name of the NAF file that contains the records to be 
executed.

-auth

is the keyword to specify Passport group authentication.

This keyword needs to be specified if the NAF contains Passport NA 
records. When specified, this keyword needs to be followed by the 
<group_name>, <userid>, and <password> parameters.
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<group_name> <userid> <password>

is the name of the Passport group, the userid, and the password to log on 
to switches in the Passport group.

-ncs

is the keyword to specify NCS authentication.

This keyword needs to be specified if the NAF contains DPN NA records. 
When specified, this keyword needs to be followed by the <dest_name>, 
<capability_id>, and <password> parameters.

<dest_name> <capability_id> <password>

are the destination mnemonic, the NCS capability_id, and the password 
to log in to the NCS.

-logfile

is the keyword to specify that log information is to be written to a log file.

If this keyword is specified without the <log_filename> option, log 
information is written to the file $HOME/
nat<pid>.<yy><mm><dd>_<hh><mm><ss>.log 
For example: /u/thawkes/nat106.970311_110201.log. 
See “Dated algorithm” (page 45) for more information on the date 
format.

<log_filename>

specifies the full pathname of the log file.

-np

is the keyword to indicate the number of processes to run.

When specified, this keyword needs to be accompanied by the 
<number_of_processes> parameter.
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<number_of_processes>

specifies the number of records that can be executed simultaneously.

The default is 1. The number to specify depends on the amount of 
memory available on the workstation. The higher the number, the more 
memory is used.

-wd

is the keyword to specify the working directory for storing the default log 
file and other intermediate working files.

When specified, this keyword needs to be accompanied by the 
<working_dir> parameter.

working_dir

specifies the full path name of the working directory for storing the 
default log file and other intermediate working files.

-quiet

specifies that records in the NAF are to be executed without producing 
messages or storing execution log information in a log file.

[-h]

provides help information for the natcmd.

Cron job
Because the Network Activation tool (NAT) command line starts up all the 
session servers (cmcfun and CM), you can invoke the NAT command line by 
using the Unix cron facility.

To set up a cron:

• You need to set a value for the EDITOR environment variable. If none is 
set, we suggest setting it to vi by entering the command setenv EDITOR 
vi.

• If file /etc/cron.d/cron.allow exists, the root user account needs to be 
listed in it.
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• The root user account cannot be listed in file /etc/cron.d/cron.deny.

To set up a cron, do the following:

1 Open the crontab file for editing, with the default editor set with 
environment variable EDITOR:

crontab -e

The current crontab file opens for editing.

2 Add an entry in the following form to the file:

<minute> <hour> <day> <month> \ /opt/MagellanNMS/bin/
natcmd <parameters>

where:

<minute> is a value from 0 to 59.

<hour> is a value from 0 to 23.

<day> is a value from 1 to 31.

<month> is a value from 1 to 12.

<parameters> are parameters of the natcmd as described in “Network 
Activation Tool command line interface” (page 273).

3 Save the crontab file and exit from it. If your editor is vi, press Esc and 
enter the following command:

:wq!

The file is now saved and is ready to be executed automatically.

The following entry in the crontab file executes a NAF called mynaf in 
the root (/) directory, at 0200 hours (2 AM), March 11, 1997. Because the 
NAF only contains Passport NA records applicable to a Passport group 
called west, the command includes the Passport group name, userid, and 
password needed to log on to Passport switches in the group. The 
command also outputs the logs in file /tmp/mylogfile.

00 2 11 3 /opt/MagellanNMS/bin/natcmd -f /mynaf -auth
west myid xys2 -logfile /tmp/mylogfile 
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MCF Directory Merge

The master configuration file (MCF) directory merge program is a UNIX 
command line application used to merge a selected number of MCF directory 
files into a new MCF directory file. See the figure “MCF Directory merge 
data flow” (page 278). This operation is activated by the mcfdirmerge 
command, in which you specify the directory files to be merged. The new 
directory file is copied to the DPN-100 module leaving the original files 
unaltered. The MCF directory files that are merged must exist on the same 
DPN-100 module.

In order to understand the purpose of the MCF directory merge command, 
you must first understand how the tidy command works on a DPN-100 
module. After having performed several downloads from the Preside 
Multiservice Data Manager (MDM) workstation, you may be left with more 
than three bundles (MCF directories and associated files). You may want to 
keep three or more bundles on the DPN-100 module.

The mcfdirmerge command allows you to keep more than three bundles on 
the DPN-100 module after the tidy command has been activated. When you 
use the tidy command, all bundles (MCF directories and associated MCFs) 
are deleted except for three: the bundle containing the committed or activated 
MCF and the two bundles containing the two directories specified in the tidy 
command. The tidy command limits a maximum of three bundles on your 
module. The mcfdirmerge command allows you to overcome this limitation 
by merging two or more bundles into a single directory which looks like an 
MCF directory to the tidy command. In other words, using mcfdirmerge 
command, you can keep more than three bundles on your module even after 
you have used the tidy command.
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Figure 26
MCF Directory merge data flow

MCF directory merge command arguments
Enter the following command syntax as one continuous command.

/opt/MagellanNMS/bin/mcfdirmerge <node-name> <mcfdir>... 
[to <bundle>] [-s <oa_interface_name> <op_id>
<password>] [-t] [-e]

where:

<node-name>

The mnemonic of the DPN-100 module where the files to be merged 
reside.

<mcfdir>...

The MCF directory files which are to be merged. At least two files must 
be specified for this command. File names must be no longer than 32 
characters.

MCF Directory 
Merge

DPN-100
Module

Directory
File
dnn

Directory
File
dnn

Directory
File
dnn

Directory
File
dnn
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to <bundle>

A separator used to indicate the end of the list of directory files that are 
to be merged.

The <bundle> option is the 7 character string included in the MCF 
directory file name. The new MCF directory file name is in the following 
format: MC.C<bundle>.0.DIR. 

If this parameter is omitted, the contents of the MCF directory files 
<mcfdir> is reported. If more than one is specified, the last bundle is 
used.

-s <oa_interface_name> <op_id> <password>

The -s option is used when an operator id and password are required to 
interface with the OA. Along with -s you must enter the following:

<oa_interface_name>  NCS OA mnemonic. 
<op_id>  The operator identification.
<password>  The password for the op-id.

-e

Option to send all messages to the standard output device instead of to 
the standard error device.

-t

Turn debugging trace ON. By default, trace is turned OFF.

In the following example, an MCF directory merge is performed on three 
MCF directory files. The following command is entered:

/opt/MagellanNMS/bin/mcfdirmerge MTLAM-1
MC.23.3062.0.DIR MC.27.3062.0.DIR MC.79.3062.0.DIR to 
comp23 
-s <oa_interface_name> <op_id> <password>
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where:

MTLAM-1

The mnemonic of the DPN-100 module where the files to be merged are 
resident.

MC.23.3062.0.DIR

One of the MCF directory files that is to be merged. At least two files 
must be specified for this command.

MC.27.3062.0.DIR

One of the MCF directory files that is to be merged.

MC.79.3062.0.DIR

One of the MCF directory files that is to be merged.

to

A mandatory separator used to indicate the end of the list of directory 
files that are to be merged.

comp23

The 7 character string included in the MCF directory filename, referred 
to as the bundle_id. The string is specified by the user. With comp23 
specified, the new MCF directory filename is 
MC.CCOMP23.3062.0.DIR. The new MCF directory filename is in the 
following format: MC.C<new_bundle_id>.0.DIR.
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MCF management

This chapter contains the commands used to manage MCFs on PMs, NMS 
Backup disk, and NMS disk.

MCF management on PMs
The PM Delete MCF and PM Tidy MCF tools are used to manage MCFs on 
PM disks. 

The PM Tidy MCF tool can be used to automate the management of MCFs 
on the PM disk. The PM Delete MCF tool can be used to delete specific 
MCFs.

PM Delete MCF tool
The PM Delete MCF tool is used to delete specific MCFs and the software 
images from a PM disk. This tool supports incremental MCFs since it does 
not delete the MC files and software images that are referenced by the MCFs 
that are not being deleted. This tool does not allow the deletion of the 
ACTIVE and COMMITTED MCFs. 

Note: This tool does not delete L2LOADER and L3LOADER software 
images.

It is recommended that this tool be run when specific MCFs must be deleted. 

At least one MCF must be specified. This can be done by using the -mcffile 
option or by specifying MCFs on the command line. Both can be specified at 
the same time.
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For return codes, see the table “PM Delete MCF return codes” (page 284).

Command syntax
The following is the command syntax for the PM Delete MCF command. 
This command can be executed from the NCS command console, remote 
NCS, or a UNIX command line. 

Enter the following command syntax as one continuous command.

/opt/MagellanNMS/bin/pmdeletemcf <PM> [<MCF1>
[<MCF2>...]] [-ncs <destination mnemonic> 
<capability id> <password>] [-mcffile <file of MCFs>]
[-deletesoftware] [-log [<log file name>]] [-quiet] [-h]

where:

<PM>

The PM mnemonic to be deleted. This parameter is not case sensitive.

<MCFx>...

One or more MCF(s) to be deleted. The MCF must be in format: 
MC.<bundle>.<namsid>.0. This parameter is not case sensitive.

-ncs <destination mnemonic> <capability id> <password>

Option to use NCS authentication. The following parameters are not case 
sensitive.
<destination mnemonic> NCS mnemonic of the MDI interface
<capability id> NCS capability id
<password>   NCS capability id password

If this option is not specified, the tool assumes that an NCS connection 
already exists as is the case when calling the tool from the NCS 
command console or from remote NCS.

-mcffile <file of MCFs>

Option used to specify a file containing a list of MCFs to be deleted. The 
<file of MCFs> is a file containing a list of MCFs, one per line. The MCF 
must be in the format: MC.<bundle>.<namsid>.0. The MCFs are not 
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case sensitive but the file name is. For example, /localdisk/admin/
mcf.list. Comment and blank lines are permitted, but comment lines must 
start with a # character.

-deletesoftware

Option used to specify that software images only referenced by MCFs 
being deleted are to be deleted.

-log [<log file name>]

Option to have the messages recorded in a log file. If the <log file name> 
is not specified, the default file name is pmdeletemcf.log.

-quiet

Option to suppress the generation of information messages.

-h

Option to display command syntax and examples.

The following is an example of a pmdeletemcf session.

/opt/MagellanNMS/bin/pmdeletemcf a0301 MC.TEST.301.0
MC.451.301.0 -ncs mdi id pw

09:29:18 NOTE: The pmdeletemcf tool is starting. Date: 
1994-03-12.
09:29:18 NOTE: Following are the configuration 
options:
NCS parameters:   MDI ID XXXXXXXX.
PM:   A0301.
Delete software:No.
09:29:19 NOTE: Establishing the NCS connection to MDI.
09:29:27 NOTE: The following 2 MCFs will be deleted:
MC.TEST.301.0  MC.451.301.0
09:29:27 NOTE: Generating MC file list for the 18 MCFs 
on PM A0301.
..................
09:31:41 NOTE: Starting to delete the MCF(s)
09:32:00 NOTE: MCF(s) deleted successfully.
09:32:02 NOTE: The pmdeletemcf tool has completed 
successfully.
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Command output
The PM Delete MCF tool directs command output to standard error and 
optionally to a log file.

All progress and error messages are directed to standard error. A progress 
message is displayed at the beginning to notify the user that the tool is 
starting. The list of MCFs that will be deleted is displayed and a progress 
message is displayed after every five MCFs deleted. Error messages are 
printed as they occur and a termination message is displayed. 

The log file contains all the messages that are printed to standard error.

PM Tidy MCF tool
The PM Tidy MCF tool is used to clean-up a PM disk by removing MCFs and 
software images that are no longer required. This tool supports incremental 
MCFs since it does not delete the MC files and software images that are 
referenced by the MCFs that are not being deleted.

Note: This tool does not delete L2LOADER and L3LOADER software 
images.

For return codes, see the table “PM Tidy MCF return codes” (page 291)

This command ensures that some basic time synchronization is present on the 
PMs. It ensures that, for the MCFs where it is relevant, none of them have a 
file system date earlier than 19800101 and greater than the current date plus 
one day. If this occurs, an error is reported for that PM and the PM is left 
unprocessed.

Table 3 
PM Delete MCF return codes

Return code Description

0 Success. The MC files and software images that were 
no longer needed have been deleted.

1 Error. Problems were found and error messages have 
been generated.

2 User requested termination. A termination signal 
(Control-C) was received by the tool. 
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Before describing the rules used when determining the MCFs to keep, the 
concept of a stream must be defined.

For Dated MCFs, all the MCFs with the same date are part of the same stream. 
For Keyed MCFs, all the MCFs with the same key are part of the same stream. 
For User Specified MCFs, each MCF represents a different stream. The latest 
MCF in a stream is the one with the highest index. The latest MCF in a stream 
is used when determining if the stream is before or after the delete date. For 
Dated MCFs, the bundle date is used when comparing delete dates not the file 
system date. The file system date is used for all other MCFs.

It is recommended that this tool be run periodically when only necessary 
MCFs should be kept. 

The following rules are used to determine which MCFs are kept on the PM.

1 The specified MCF(s), if any, is kept.

2 The COMMITTED MCF is kept.

3 The ACTIVE MCF is kept.

4 The MCFs that are associated with a different PM, MCFs with a 
different NAMS ID, are kept.

5 For streams of Dated MCFs with a bundle date older than the 
specified delete date, the highest MCF of the highest <n> streams are 
kept. Numeric comparison of the dated key is used to rank the MCFs.

6 For streams of Keyed MCFs with a file system date older than the 
specified delete date, the highest MCF of the highest <n> streams are 
kept. ASCII comparison of the key is used to rank the MCFs.

7 For streams of User Specified MCFs with a file system date older than 
the specified delete date, the highest MCF of the highest <n> streams 
are kept. ASCII comparison of the bundle name is used to rank the 
MCFs.
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In the above rules, the delete date, <n> and <m> can be specified on the 
command line using the -deletedate, -paststreams, and -mcfsperfuturestream 
options respectively.

The table “PM Tidy MCF example” (page 286) illustrates examples of the 
above rules. The table shows which MCFs would be kept and which would be 
deleted if using the tool on the same MCFs but with three different delete 
dates. In all three cases, a past stream of 2 and an MCF per future stream of 1 
is used. The COMMITTED and ACTIVE MCF is MC.94021535.1234.0.

8 For streams of dated MCFs with a bundle date later than the specified 
delete date, the highest <m> MCFs of each stream are kept.

9 For streams of keyed MCFs with a file system date later than the 
specified delete date, the highest <m> MCFs of each stream are kept.

10 For streams of user specified MCFs with a file system date later than 
the specified delete date, the highest <m> MCFs of each stream are 
kept.

Table 4 
PM Tidy MCF example

MCF File system 
date
(yymmdd)

Delete date 
931231
(yymmdd)

Delete date 
940215
(yymmdd)

Delete date 
940401
(yymmdd)

MC.94020700.1234.0 940204(*) delete (rule 9) delete (rule 5) delete (rule 5)

MC.94020701.1234.0 940204(*) delete (rule 9) delete (rule 5) delete (rule 5)

MC.94020702.1234.0 940205(*) keep (rule 9) keep (rule 5) delete (rule 5)

MC.94021535.1234.0 940210(*) keep (rule 2) keep (rule 2) keep (rule 2)

MC.94021536.1234.0 940210(*) keep (rule 9) keep (rule 9) keep (rule 5)

MC.94033000.1234.0 940320(*) keep (rule 9) keep (rule 9) keep (rule 5)

MC.TEST.1234.0 940110 keep (rule 11) keep (rule 7) keep (rule 7)

MC.TEST2.1234.0 940111 keep (rule 11) keep (rule 7) keep (rule 7)

MC.ABCD.1234.0 940213 keep (rule 11) delete (rule 7) delete (rule 7)
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Command syntax
The following is the command syntax for the PM Tidy MCF command. This 
command can be executed from the NCS command console, remote NCS, a 
UNIX command line or a cron job.

Enter the following command syntax as one continuous command.

/opt/MagellanNMS/bin/pmtidymcf [<MCF1>] [<MCF2>...]] 
[-ncs <destination mnemonic> <capability id>
<password>]
[-pm <PM> | -f <file of PMs>]] [-mcffile <file of MCFs>]
[-deletedate <date>] [-paststreams <number of streams>]
[-mcfsperfuturestream <number of MCFs>] 
[-deletesoftware] [-noconfirm] [-log [<log file name>]]
[-quiet] [-h]

MC.GHIJ.1234.0 940323 keep (rule 11) keep (rule 11) delete (rule 7)

MC.M56100.1234.0 940131 keep (rule 10) keep (rule 6) delete (rule 6)

MC.M57100.1234.0 940331 keep (rule 10) keep (rule 10) delete (rule 6)

MC.WK0600.1234.0 940213 delete (rule 10) delete (rule 6) delete (rule 6)

MC.WK0601.1234.0 940214 keep (rule 10) keep (rule 6) keep (rule 6)

MC.WK0800.1234.0 940210 delete (rule 10) delete (rule 10) delete (rule 6)

MC.WK0801.1234.0 940223 keep (rule 10) keep (rule 10) keep (rule 6)

MC.94021200.9999.0 940331 keep (rule 4) keep (rule 4) keep (rule 4)

MC.TEST.9999.0 940331 keep (rule 4) keep (rule 4) keep (rule 4)

Note: (*) Remember that the file system date is irrelevant for DATED MCFs. The date in the MCF 
name is used instead. 

Table 4  (continued)
PM Tidy MCF example

MCF File system 
date
(yymmdd)

Delete date 
931231
(yymmdd)

Delete date 
940215
(yymmdd)

Delete date 
940401
(yymmdd)
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where:

<MCFx>

One or more MCF(s) to be kept. The MCF must be in format: 
MC.<bundle>.<namsid>.0. This parameter is not case sensitive.

-ncs <destination mnemonic> <capability id> <password>

Option to use NCS authentication. The following parameters are not case 
sensitive.
<destination mnemonic> NCS mnemonic of the MDI interface
<capability id> NCS capability id
<password>  NCS capability id password

If this option is not specified, the tool assumes that an NCS connection 
already exists as is the case when calling the tool from the NCS 
command console or from remote NCS.

-pm <PM>

Option to specify one PM to perform the tidy against. This parameter is 
not case sensitive.

-f <file of PMs>

Option to specify a list of PMs to perform the tidy against. The <file of 
PMs> is a file containing a list of PM mnemonics, one per line. These 
mnemonics are not case sensitive but the file name is. For example, 
/localdisk/admin/pm.list. Comment and blank lines are permitted, but 
comment lines must start with a # character.

-mcffile <file of MCFs>

Option used to specify a file containing a list of MCFs to be kept. The 
<file of MCFs> is a file containing a list of MCFs, one per line. The MCF 
must be in the format: MC.<bundle>.<namsid>.0. The MCFs are not 
case sensitive but the file name is. For example, /localdisk/admin/
mcf.list. Comment and blank lines are permitted, but comment lines must 
start with a # character.
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-deletedate <date>

Option to specify a date to use when selecting the MCFs to keep. The 
<date> must be valid and in the format yymmdd. See “Dated algorithm” 
(page 45) for more information on the date format. This date determines 
which streams are considered future or past. If this option is not 
specified, the current date is used.

-paststreams <number of streams>

Option used to specify the number of Dated, Keyed, and User Specified 
streams older than the delete date that are kept. The <number of 
streams> indicates the number of streams to keep. The value must be 
from 1 - 10000. If this option is not specified, one stream is kept for each 
stream type.

-mcfsperfuturestream <number of MCFs>

Option used to specify the number of MCFs to keep per future stream. 
The <number of MCFs> indicates the number of MCFs to keep. The 
value must be from 1 - 100. If this option is not specified, all future MCFs 
are kept.

-deletesoftware

Option used to specify that software images only referenced by MCFs 
being deleted are to be deleted.

-noconfirm

Option used to delete the MCFs without asking the user for confirmation.

The -noconfirm option is implied when executing the tool from the NCS 
command console or from remote NCS. This option must be specified 
when executing the tool from cron.

-log [<log file name>]

Option to have the messages recorded in a log file. If the <log file name> 
is not specified, the default file name is pmtidymcf.log.

-quiet

Option to suppress the generation of information messages.
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-h

Option to display command syntax and examples.

If the -f and -pm options are not specified, all the PMs reporting to the NCS 
OA represented by the <destination mnemonic> parameter or reporting to any 
OA that exists in the hierarchy of the NCS OA are considered. 

The following is an example of a pmtidymcf session. 

/opt/MagellanNMS/bin/pmtidymcf -pm a1234 -ncs mdi id 
pw -deletedate 940215 -paststreams 2 
-mcfsperfuturestream 1

16:44:27 NOTE: The pmtidymcf tool is starting. Date: 
1994-04-06.
16:44:27 NOTE: Following are the configuration 
options:
NCS parameters: MDI ID XXXXXXXX.
PM selection mode: PM A1234.
Delete software: No.
Delete date: 940215.
Past streams: 2.
MCFs per future stream: 1.
Confirm deletion: Yes.

16:44:28 NOTE: Establishing the NCS connection to MDI.
16:44:28 NOTE: Processing PM A1234.
16:44:41 NOTE: The following 13 MCF(s) will be kept:
MC.94020702.1234.0 MC.94021535.1234.0
MC.94021536.1234.0 MC.94033000.1234.0 MC.GHIJ.1234.0
MC.M56100.1234.0 MC.M57100.1234.0 MC.TEST.1234.0 
MC.TEST2.1234.0 MC.WK0601.1234.0 MC.WK0801.1234.0 
MC.94021200.9999.0 MC.TEST.9999.0
16:44:44 NOTE: The following 5 MCF(s) will be deleted:
MC.94020700.1234.0 MC.94020701.1234.0 MC.ABCD.1234.0
MC.WK0600.1234.0 MC.WK0800.1234.0

Delete the MCF(s)? [y,n] (y): 
16:44:44 NOTE: Generating MC file list for the 21 MCFs 
on PM A1234.
.....................
16:45:28 NOTE: Starting to delete the MCF(s).
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16:45:29 NOTE: Still 5 MCF(s) to be deleted.
16:50:37 NOTE: MCF(s) deleted successfully.
16:50:38 NOTE: The pmtidymcf tool has completed 
successfully.

Command output
The PM Tidy MCF tool directs command output to standard error and 
optionally to a log file.

All progress and error messages are directed to standard error. A progress 
message is displayed at the beginning to notify the user that the tool is 
starting. The list of PMs being processed is also displayed. For each PM, the 
list of MCFs to be kept and deleted is displayed. A progress message is 
displayed after every five MCFs deleted. Error messages are printed as they 
occur and a termination message is displayed. 

The log file ontains all the messages that are printed to standard error.

MCF management on Backup disks
The Backup Delete MCF and Backup Tidy MCF tools are used to manage 
MCFs on the NMS Backup disk.

Table 5 
PM Tidy MCF return codes

Return code Description

0 Success. The MC files and software images that were 
no longer needed have been deleted.

1 Error. Problems were found during parameter 
validation.

2 User requested termination. A termination signal 
(Control-C) was received by the tool.

11, 12, ... Partial success. The tool completed but some PMs 
were not tidied successfully. The number of PMs where 
the tidy was not successful is <return code> minus 10. 
For example, if the return code is 12, then the tidy was 
not successful on 2 PMs.
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The Backup Tidy MCF tool can be used to automate the management of 
backup MCFs. The Backup Delete MCF tool can be used to delete specific 
backup MCFs. 

Backup Delete MCF tool
The Backup Delete MCF tool is used to delete specific backup MCFs from 
the NMS Backup disk. This tool does not delete the MCFs that are referenced 
by the backup MCFs that are not being deleted (supports incremental MCFs).

At least one backup MCF must be specified. This can be done by using the 
-mcffile option or by specifying backup MCFs on the command line. Both can 
be specified at the same time.

For return codes, see the table “Backup Delete MCF return codes” 
(page 294).

Command syntax
The following is the command syntax for Backup delete MCF(bddeletemcf). 
This tool can be executed from a UNIX command line. This command should 
be executed from the root user. 

Enter the following command syntax as one continuous command.

/opt/MagellanNMS/bin/bddeletemcf [<B_MCF1> 
[<B_MCF2> ...]] [-mcffile <file of backup MCFs>] 
[-log [<log file name>]] [-quiet] 
[-backupdir <backup directory>] [-h]

where:

<B_MCFx>

One or more backup MCF(s) to be deleted. The backup MCFs must be 
in format B_MC.<bundle>.<namsid>.0. This parameter is not case 
sensitive.

-mcffile <file of backup MCFs>

Option used to specify a file containing a list of backup MCFs to be 
deleted. The <file of backup MCFs> is a file containing a list of backup 
MCFs, one per line. The backup MCFs are not case sensitive but the file 
name is. For example: /localdisk/admin/mcf.list. Comment and blank 
lines are permitted, but comment lines must start with a # character.
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-log [<log file name>]

Option to have the messages recorded in a log file. If the <log file name> 
is not specified, the default file name is bddeletemcf.log.

-quiet

Option to suppress the generation of information messages.

-backupdir <backup directory>

Option to specify the directory containing the backup MCFs. By default, 
the directory is determined by looking for the value of variable 
UNIX_BACKUP_DIR in the /opt/MagellanNMS/cfg/PFA.cfg 
configuration file.

-h

Option to display command syntax and examples.

The following is an example of an bddeletemcf session.

/opt/MagellanNMS/bin/bddeletemcf B_MC.TEST.301.0.301 
B_MC.WK0601.301.0

09:29:18 NOTE: The bddeletemcf tool is starting. Date: 
1994-03-12.
09:29:18 NOTE: Following are the configuration 
options:
Backup directory: /opt/MagellanNMS/data/BACKUP_MCF.
09:29:23 NOTE: The following 2 backup MCFs will be 
deleted:
B_MC.TEST.301.0 B_MC.WK0601.301.0
09:29:41 NOTE: Starting to delete the backup MCF(s) for 
NAMS ID 301.
09:30:00 NOTE: Backup MCF(s) deleted successfully.
09:30:01 NOTE: The bddeletemcf tool has completed 
successfully.
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Command output
The Backup Delete MCF tool directs command output to standard error and 
optionally to a log file.

All progress and error messages are directed to standard error. A progress 
message is displayed at the beginning to notify the user that the tool is 
starting. The list of backup MCFs that will be deleted is displayed and a 
progress message is displayed after every five backup MCFs deleted. Error 
messages are printed as they occur and a termination message is displayed. 
These messages are not generated when the -quiet option is specified.

The log file contains all the messages that are printed to standard error.

Backup tidy MCF tool
The Backup Tidy MCF tool is used to clean up Backups for one or more PMs 
by removing backup MCFs that are no longer required. This tool does not 
delete the MC files that are referenced by the backup MCFs that are not being 
deleted (supports incremental MCFs).

Before describing the rules used when determining the backup MCFs to keep, 
you need to understand the concept of a stream.

For Dated backup MCFs, all the backup MCFs with the same date are part of 
the same stream. For Keyed backup MCFs, all the backup MCFs with the 
same key are part of the same stream. For User Specified backup MCFs, each 
backup MCF represents a different stream. The latest backup MCF in a 
stream is the one with the highest index. The latest backup MCF in a stream 

Table 6 
Backup Delete MCF return codes

Return code Description

0 Success. The MC files that were no longer needed 
have been deleted.

1 Error. Problems were found and error messages have 
been generated.

2 User requested termination. A termination signal 
(Control-C) was received by the tool. 
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is used when determining if the stream is before or after the delete date. For 
Dated backup MCFs, the bundle date is used when comparing delete dates not 
the file system date. The file system date is used for all other backup MCFs.

It is recommended that this tool be run periodically when only necessary 
backup MCFs should be kept. 

The following rules are used to determine which backup MCFs are kept on 
the PM.

1 The specified backup MCF(s), if any, are kept.

2 The MCF presently COMMITTED on the PM, if present in the NMS 
Backup disk, is kept.

3 The MCF presently ACTIVE on the PM, if present in the NMS 
Backup disk, is kept.

4 The backup MCFs that are for a different PM (backup MCFs with a 
different NAMSID) are kept.

5 For the streams of Dated backup MCFs with a bundle date older than 
the specified delete date, the highest backup MCF of the highest <n> 
streams are kept. Numeric comparison of the dated key is used to rank 
the backup MCFs.

6 For the streams of Keyed backup MCFs with a file system date older 
than the specified delete date, the highest backup MCF of the highest 
<n> streams are kept. ASCII comparison of the key is used to rank the 
backup MCFs.

7 For the streams of User Specified backup MCFs with a file system 
date older than the specified delete date, the highest backup MCF of 
the highest <n> streams are kept. ASCII comparison of the bundle 
name is used to rank the backup MCFs.
Preside MDM Configuration Management for DPN User Guide   14.3RSUP



296   Chapter 14 MCF management
In the above rules, the delete dates <n> and <m> can be specified on the 
command line using the -deletedate, -paststreams and -mcfperfuturestream 
options.

For return codes, see the table “Backup Tidy MCF return codes” (page 301).

The table “Backup Tidy MCF example” (page 296) illustrates examples of 
the above rules. The table shows which backup MCFs would be kept and 
which would be deleted if using the tool on the same backup MCFs but with 
three different delete dates. In all three cases, <n> is 2 and <m> is 1. The 
COMMITTED and ACTIVE MCF on the module is MC.94021535.1234.0.

8 For the streams of Dated backup MCFs with a bundle date later than 
the specified delete date, the highest <m> backup MCFs of each 
stream are kept.

9 For the streams of Keyed backup MCFs with a file system date later 
than the specified delete date, the highest <m> backup MCFs of each 
stream are kept.

10 For the streams of User Specified backup MCFs with a file system 
date later than the specified delete date, the highest <m> backup 
MCFs of each stream are kept. 

Table 7 
Backup Tidy MCF example

MCF File system 
date
(yymmdd)

Delete date 
931231
(yymmdd)

Delete date 
940215
(yymmdd)

Delete date 
940401
(yymmdd)

B_MC.94020700.1234.0 940204 delete (rule 9) delete (rule 5) delete (rule 5

B_MC.94020701.1234.0 940204 delete (rule 9) delete (rule 5) delete (rule 5)

B_MC.94020702.1234.0 940205 keep (rule 9) keep (rule 5) delete (rule 5)

B_MC.94021535.1234.0 940210 keep (rule 2) keep (rule 2) keep (rule 2)

B_MC.94021536.1234.0 940210 keep (rule 9) keep (rule 9) keep (rule 5)

B_MC.94033000.1234.0 940320 keep (rule 9) keep (rule 9) keep (rule 5)
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Command syntax
The following is the command syntax for the Backup Tidy MCF command. 
This tool can be executed from a UNIX command line or from a cron job. This 
command should be executed from the root user. 

Enter the following command syntax as one continuous command.

/opt/MagellanNMS/bin/bdtidymcf [<B_MCF1> [<B_MCF2> ...]]
-ncs <destination mnemonic> <capability id> <password>
[-pm <PM> | -f <file of PMs>]
[-mcffile <file of backup MCFs>]
[-deletedate <date>] [-paststreams <number of streams>]
[-mcfsperfuturestream <number of backup MCFs>]
[-noconfirm] [-log [<log file name>]] [-quiet]
[-backupdir <backup directory>] [-h]

B_MC.TEST.1234.0 940110 keep (rule 11) keep (rule 7) keep (rule 7)

B_MC.TEST2.1234.0 940111 keep (rule 11) keep (rule 7) keep (rule 7)

B_MC.ABCD.1234.0 940213 keep (rule 11) delete (rule 7) delete (rule 7)

B_MC.GHIJ.1234.0 940323 keep (rule 11) keep (rule 11) delete (rule 7)

B_MC.M56100.1234.0 940131 keep (rule 10) keep (rule 10) delete (rule 6)

B_MC.M57100.1234.0 940331 keep (rule 10) keep (rule 10) delete (rule 6)

B_MC.WK0600.1234.0 940213 delete (rule 10) delete (rule 6) delete (rule 6)

B_MC.WK0601.1234.0 940214 keep (rule 10) keep (rule 6) keep (rule 6)

B_MC.WK0800.1234.0 940210 delete (rule 10) delete (rule 10) delete (rule 6)

B_MC.WK0801.1234.0 940223 keep (rule 10) keep (rule 10) keep (rule 6)

B_MC.94021200.9999.0 940331 keep (rule 4) keep (rule 4) keep (rule 4)

B_MC.TEST.9999.0 940331 keep (rule 4) keep (rule 4) keep (rule 4)

Table 7  (continued)
Backup Tidy MCF example

MCF File system 
date
(yymmdd)

Delete date 
931231
(yymmdd)

Delete date 
940215
(yymmdd)

Delete date 
940401
(yymmdd)
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where:

<B_MCFx>

One or more backup MCF(s) to be kept. The backup MCFs must be in 
format B_MC.<bundle>.<namsid>.0. This parameter is not case 
sensitive.

-ncs <destination mnemonic> <capability id> <password>

Option to use NCS authentication. The following parameters are not case 
sensitive.
<destination mnemonic>  NCS mnemonic of the MDI interface. 
<capability id>  NCS capability id. 
<password>  NCS capability id password. 

-pm <PM>

Option to specify one PM to perform the tidy against. This parameter is 
not case sensitive.

-f <file of PMs>

Option to specify a list of PMs to perform the tidy against. The <file of 
PMs> is a file containing a list of PM mnemonics, one per line. These 
mnemonics are not case sensitive but the file name is. For example, 
/localdisk/admin/pm.list. Comment and blank lines are permitted, but 
comment lines must start with a # character.

-mcffile <file of backup MCFs>

Option used to specify a file containing a list of backup MCFs to be kept. 
The <file of backup MCFs> is a file containing a list of backup MCFs, 
one per line. The backup MCFs must be in format 
B_MC.<bundle>.<namsid>.0. The backup MCFs are not case sensitive 
but the file name is. For example, /localdisk/admin/mcf.list. Comment 
and blank lines are permitted, but comment lines must start with a # 
character.
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-deletedate <date>

Option to specify a date used when determining if backup MCFs are in 
the future or in the past.This date determines which streams are 
considered future or past. The <date> must be valid and in the format 
yymmdd. See “Dated algorithm” (page 45) for more information on the 
date format. This command should be executed from the root user. 

-paststreams <number of streams>

Option used to specify the number of Dated, Keyed, and User Specified 
streams older than the delete data that are kept. The <number of 
streams> indicates the number of streams to keep. The value must be 
from 1 - 10000. If this option is not specified, one stream is kept for each 
stream type.

-mcfsperfuturestream <number of backup MCFs>

Option used to specify the number of backup MCFs to keep per future 
streams. The <number of MCFs> indicates the number of backup MCFs 
to keep per future stream. The value must be from 1 - 100. If this option 
is not specified, all future backup MCFs are kept. 

-noconfirm

Option used to delete the backup MCFs without asking for confirmation. 
This option must be specified when executing the tool from cron.

-log [<log file name>]

Option to have the messages recorded in a log file. If the <log file name> 
is not specified, the default file name is bdtidymcf.log.

-quiet

Option to suppress the generation of information messages.

-backupdir <backup directory>

Option to specify the directory containing the backup MCFs. By default, 
the directory is determined by looking for the value of variable 
UNIX_BACKUP_DIR in the /opt/MagellanNMS/cfg/PFA.cfg 
configuration file.
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-h

Option to display command syntax and examples.

If the -f and -pm options are not specified, all the PMs reporting to the NCS 
OA represented by the <destination mnemonic> parameter or reporting to any 
OA that exists in the hierarchy of the NCS OA are considered. 

The following is an example of an bdtidymcf session.

/opt/MagellanNMS/bin/bdtidymcf -pm a1234 -ncs mdi id
pw -deletedate 940215 -paststreams 2 
-mcfsperfuturestream 1

16:44:27 NOTE: The bdtidymcf tool is starting. Date: 
1994-04-06.
16:44:27 NOTE: Following are the configuration 
options:
NCS parameters: ID XXXXXXXX.
PM selection mode: PM A1234.
Delete date: 940215.
Past streams: 2.
MCFs per future stream: 1.
Confirm deletion: Yes.
Backup directory: /opt/MagellanNMS/data/BACKUP_MCF.
16:44:28 NOTE: Establishing the NCS connection to MDI.
16:44:28 NOTE: Processing PM A1234.
16:44:41 NOTE: The following 13 backup MCF(s) will be 
kept:
B_MC.94020702.1234.0 B_MC.94021535.1234.0
B_MC.94021536.1234.0 B_MC.94033000.1234.0
B_MC.GHIJ.1234.0 B_MC.M56100.1234.0
B_MC.M57100.1234.0 B_MC.TEST.1234.0
B_MC.TEST2.1234.0 B_MC.WK0601.1234.0
B_MC.WK0801.1234.0 B_MC.94021200.9999.0
B_MC.TEST.9999.0
16:44:44 NOTE: The following 5 backup MCF(s) will be 
deleted:
B_MC.94020700.1234.0 B_MC.94020701.1234.0
B_MC.ABCD.1234.0 B_MC.WK0600.1234.0
B_MC.WK0800.1234.0
241-6001-012   14.3RSUP   



Chapter 14 MCF management   301
Delete the backup MCF(s)? [y,n] (y): 
16:45:28 NOTE: Starting to delete the backup MCF(s) for 
NAMS ID 1234.
16:45:29 NOTE: Still 5 backup MCF(s) to be deleted.
16:46:57 NOTE: Backup MCF(s) deleted successfully.
16:46:58 NOTE: The bdtidymcf tool has completed 
successfully.

Command output
The Backup Tidy MCF tool directs command output to standard error and 
optionally to a log file.

All progress and error messages are directed to standard error. A progress 
message is displayed at the beginning to notify the user that the tool is 
starting. The list of PMs being processed is also displayed. For each PM, the 
list of backup MCFs to be kept and deleted is displayed. A progress message 
is displayed after every five backup MCFs deleted. Error messages are printed 
as they occur and a termination message is displayed. These messages are not 
generated when the -quiet option is specified.

The log file contains all the messages that are printed to standard error.

Verifying the completeness of MCFs
The following command verifies the completeness of MCFs.

Table 8 
Backup Tidy MCF return codes

Return code Description

0 Success. The MC files that were no longer needed 
have been deleted.

1 Error. Problems were found during parameter 
validation.

2 User requested termination. A termination signal 
(Control-C) was received by the tool.

11, 12, ... Partial success. The tool completed but some PMs 
were not tidied successfully. The number of PMs where 
the tidy was not successful is <return code> minus 10. 
For example, if the return code is 12, then the tidy was 
not successful on 2 PMs.
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checkmcf command
The checkmcf command checks the completeness of an MCF by checking for 
the existence of the MC.* files contained in its DIR file. 

Note: This check differs from the on-switch check mcf command and 
therefore PE images are not included in the check.

Enter the checkmcf command in the following format:

/opt/MagellanNMS/bin/checkmcf MC.<bundle>.<namsid>.0 ...

The following example checks MC.4076.4034.0 before and after deleting one 
of its associated files.

/opt/MagellanNMS/bin/checkmcf /localdisk/uibasher/
MC.4076.4034.0

The response would be:

NOTE: Checking /localdisk/uibasher/MC.4076.4034.0
NOTE: MC.4076.4034.0 is complete.
rm /localdisk/uibasher/MC.4076.4034.GCR
/opt/MagellanNMS/bin/checkmcf /localdisk/uibasher/
MC.4076.4034.0
NOTE: Checking /localdisk/uibasher/MC.4076.4034.0
ERROR: Missing MC.4076.4034.GCR

Deleting MCF MC files
The following command deletes MC.* files associated with an MCF.

deletemcf command
The deletemcf command deletes all the MC.* files associated with an MCF. 
Any files that are used by other MCFs in the same directory will not be 
deleted.

Enter the deletemcf command in the following format:

/opt/MagellanNMS/bin/deletemcf MC.<bundle>.<namsid>.0...

The following example deletes all the MC.* files associated with only 
MC.92061600.4034.0.
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/opt/MagellanNMS/bin/deletemcf /localdisk/uibasher/
MC.92061600.4034.0

The response would be:

NOTE: /localdisk/uibasher/MC.4076.4034.7 used by other 
bundles. Not removing.
NOTE: /localdisk/uibasher/MC.4076.4034.6 used by other 
bundles. Not removing.
NOTE: /localdisk/uibasher/MC.4076.4034.5 used by other 
bundles. Not removing.
NOTE: /localdisk/uibasher/MC.4076.4034.3 used by other 
bundles. Not removing.
NOTE: /localdisk/uibasher/MC.4076.4034.2 used by other 
bundles. Not removing.
NOTE: /localdisk/uibasher/MC.4076.4034.1 used by other 
bundles. Not removing.
NOTE: /localdisk/uibasher/MC.4076.4034.SCR used by 
other bundles. Not removing.
NOTE: /localdisk/uibasher/MC.4076.4034.DCR used by 
other bundles. Not removing.
NOTE: /localdisk/uibasher/MC.4076.4034.ACR used by 
other bundles. Not removing.
NOTE: /localdisk/uibasher/MC.4076.4034.GCR used by 
other bundles. Not removing.
NOTE: /localdisk/uibasher/MC.4076.4034.RID used by 
other bundles. Not removing.
NOTE: Removing /localdisk/uibasher/
MC.92061600.4034.0.DIR
NOTE: Removing /localdisk/uibasher/MC.92061600.4034.0
NOTE: /localdisk/uibasher/MC.4076.4034.FEAT used by 
other bundles. Not removing.
NOTE: /localdisk/uibasher/MC.4076.4034.GSCR used by 
other bundles. Not removing.
NOTE: /localdisk/uibasher/MC.4076.4034.DSPO used by 
other bundles. Not removing.
NOTE: /localdisk/uibasher/MC.4076.4034.PROF used by 
other bundles. Not removing.

Listing MCF files
The following command lists files included in an MCF.
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listmcf command
The listmcf command lists the files included in an MCF by examining the 
contents of its DIR file.

Enter the listmcf command in the following format:

/opt/MagellanNMS/bin/listmcf MC.<bundle>.<namsid>.0...

The following example lists the files associated with MC.4076.4034.0.

/opt/MagellanNMS/bin/listmcf /localdisk/uibasher/
MC.4076.4034.0

The response would be:

NOTE: Listing /localdisk/uibasher/MC.4076.4034.0

MC.4076.4034.0.DIR
MC.4076.4034.FEAT
RMOFF386.PIMG9007
RAUTP.PIMG9007
PELFF2.PIMG9007
RMSERVER.PIMG9007
PELFG1.PIMG9007
L2LOADER.PIMG9007
L3LOADER.PIMG9007
MC.4076.4034.PROF
MC.4076.4034.1
MC.4076.4034.2
MC.4076.4034.3
MC.4076.4034.5
MC.4076.4034.6
MC.4076.4034.7
MC.4076.4034.SCR
MC.4076.4034.DCR
MC.4076.4034.ACR
MC.4076.4034.RID
MC.4076.4034.GSCR
MC.4076.4034.GCR
MC.4076.4034.DSPO
MC.4076.4034.0
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Chapter 15
Using HP OpenView NNM desktop

This chapter describes how you can access DPN Devices configuration tools 
from the HP OpenView Network Node Manager (NNM) desktop application. 
It contains the following information:

• “About HP OpenView NNM desktop” (page 305)

• “Configuration tools available from HP OpenView NNM desktop” 
(page 306)

• “Accessing HP OpenView NNM desktop from MDM” (page 306)

• “Accessing DPN Devices configuration tools from HP OpenView NNM 
desktop” (page 306)

• “How HP OpenView NNM desktop displays DPN device names” 
(page 309)

• “Viewing online documentation” (page 309)

• “Exiting HP OpenView NNM desktop” (page 310)

About HP OpenView NNM desktop
HP OpenView NNM desktop application is an optional feature of Preside 
Multiservice Data Manager (MDM) that runs on an HP OpenView platform. 
With this feature you can launch, from the HP OpenView NNM desktop, tools 
from the DPN Devices configuration toolset. Or, you can use the surveillance 
and configuration tools in the HP OpenView NNM desktop toolset.
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Configuration tools available from HP OpenView NNM 
desktop

See the following sections for information on the DPN Devices configuration 
tools that you can launch from HP OpenView NNM desktop:

• “Component Provisioning” (page 61)

• “Envelope Editor” (page 221)

• “Service Data Backup” (page 161)

• “Service Data Restore” (page 169)

• “Global Data Manager” (page 127)

• “Software Distribution” (page 179)

• “Network Activation” (page 235)

• “Software Substitution” (page 193)

• “Service Data Conversion” (page 207)

• Service Integrity Simplification, See  241-6001-022 Preside MDM 
Network Reporting System User Guide

Accessing HP OpenView NNM desktop from MDM
Access HP OpenView NNM desktop from the Preside Multiservice Data 
Manager (MDM) Toolsets menu.

Accessing DPN Devices configuration tools from HP 
OpenView NNM desktop

See the following procedures for information on how to start HP OpenView 
NNM desktop and access the DPN Devices configuration tools:

• “Starting HP OpenView NNM desktop” (page 307)

• “Starting DPN Devices configuration tools from the Configuration 
menu” (page 308)

• “Starting DPN Devices configuration tools from the pop-up menu” 
(page 308)
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Starting HP OpenView NNM desktop
1 In a UNIX window start HP OpenView:

/opt/OV/bin/ovw &

The About HP OpenView window opens. Click Close to close the window 
or wait for it to close on its own.

The Root map opens, displaying the Nortel Networks symbol and the IP 
Internet symbol. These symbols indicate the state of their respective 
networks through color. The standard HP OpenView color scheme is 
used, as shown in the HP OpenView Display Legend.

The Event Categories window opens. It may display a status message at 
the bottom, stating the percentage of the trapd.log file that has been 
loaded.

2 To view your network on the Root map, double-click the Nortel Networks 
symbol.

The Nortel Networks submap opens and displays the devices in your 
network. The color of the icon indicates the states of the network devices. 
Icons depicting DPN devices in the network contain an O or D. See also, 
“How HP OpenView NNM desktop displays DPN device names” 
(page 309). 
Preside MDM Configuration Management for DPN User Guide   14.3RSUP



308   Chapter 15 Using HP OpenView NNM desktop
3 Access the DPN Devices configuration tools. There are two methods: see 
“Starting DPN Devices configuration tools from the Configuration menu” 
(page 308) or “Starting DPN Devices configuration tools from the pop-up 
menu” (page 308).

Starting DPN Devices configuration tools from the 
Configuration menu

1 At the OVW submap, select a DPN device by clicking the left mouse menu 
button.

2 Select DPN Configuration.

3 Select the tool that you want to open.

Starting DPN Devices configuration tools from the pop-up 
menu

1 At the OVW submap, select a DPN node by clicking the left mouse button.
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2 Press the mouse menu button to display the node pop-up menu, and 
select DPN Configuration.

3 Select the tool that you want to open. 

How HP OpenView NNM desktop displays DPN device 
names

Icons representing DPN devices contain a D or O. They are displayed on the 
Nortel Networks submap as follows, depending on the type of DPN device:

• DPN-100 device names are displayed as
PM/<device_name>. For example, PM/PMDEV1

• Passport 4120 device names are displayed as
PM/<device_name>. For example, PM/PM/DEV2

• Operating Agent on DPN-100 or Passport 4120 are displayed as
OA/<agent_name>. For example, OA/AGENT3

There is no subcomponent submap for DPN devices. To see a list of the 
subcomponents and their states, use the Component Information Viewer.

Note: The device name that appears on the Nortel Networks submap is 
the name with which the device is configured. Lowercase letters in a 
configured name appear as uppercase letters in the submap display.

Viewing online documentation
1 From the Root map Help menu or any submap Help menu, choose Online 

Documentation.

The Netscape browser opens with online documentation.

2 In the left pane of the browser, select a document suite name.

The left pane displays the documentation categories.

3 In the left pane, select a document name.

A table of contents appears. You can now select a topic from the 
document.

4 In the left pane, select the topic you want to view.

The topic details display in the right frame.
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See 241-6001-804 Preside MDM Workstation Utilities User Guide.

Exiting HP OpenView NNM desktop
1 From the Root map or any submap, select Map -> Exit.

An OpenView Windows warning dialog opens.

2 To continue the exit process, click OK.

The dialog closes along with the Event Categories window and any open 
submaps.
241-6001-012   14.3RSUP   



311
Appendix A
Service data format

This appendix provides you with a conceptual model of how service data is 
presented by the Component Provisioning tool. Acquiring such knowledge 
will be beneficial for using the Component Provisioning tool. 

Before discussing the conceptual model, review how service data is structured 
in the Master Configuration Files (MCF), as described in 241-2001-340 
DPN-100 Envelope Definitions. You need to refer to this document for 
detailed descriptions of service data fields.

Within the context of 241-2001-340 DPN-100 Envelope Definitions, service 
data can be viewed as consisting of fields which are grouped into envelopes. 
Envelopes are, in turn, grouped into a service data area (SDA). SDAs and 
other envelopes are grouped into larger SDAs. Each envelope and SDA is 
accessed by a key. 

For example, a port providing ITI service is structured as shown in the figure 
“ITI service structure” (page 312).
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Figure 27
ITI service structure
 

Conceptually, this structure can be described as an up-side-down tree, as 
shown in the figure “up-side-down tree” (page 312).

Figure 28
up-side-down tree

The Component Provisioning tool follows this model with some extensions 
to help you access the data more easily. For example, 

1 There is no need for you to enter any data into the Process Type 
Envelope. Therefore, this envelope is not visible from Component 
Provisioning.

2 The DNA-CUG Envelope contains NCUGs. You want to be able to 
access each NCUG directly.

Port SDA

Process Type envelope

DNA-CUG Envelope

Link Envelope

Hunt-DNA Envelope

............ other envelopes...........

PO

Process Type DNA-CUG Link Hunt-DNA
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Component Provisioning presents the previous example in the following 
format:

Each line in the above example is called a component. The example implies 
the following:

• Τhe port 2 offers ITI service. The previous figure does not help you to 
distinguish services that have the same types of envelopes. This 
component is called navigation component, it does not have any fields.

• The Link component is a subordinate of the ITI component, shown by a 
large indentation. Since its key is always constant, you do not need to be 
concerned about, in contrast to NCUG_Index or ICUG_Index. This is an 
editable component, since it has fields. You can position the cursor at this 
component and use the right button on your mouse to display the editable 
screen.

• The DNA_CUG and Hunt_DNA components have the identical key. The 
navigation component DNA saves you from typing the key 
X3021224321 twice. The level of identification tells you that the DNA 
component is a subordinate of the ITI component. It has two subordinates 
of its own: DNA_CUG and Hunt_DNA. They are editable components.

• The components NCUGs and ICUGs tell you that the DNA_CUG 
component has a group of NCUG_Index and a group ICUG_Index. The 
NCUGs component has two subordinates with the key of 2 and 3. The 
ICUGs component has one subordinate with the key of 6.

In summary, every line on the navigation window, is a component. 
Components that have an editable screen are called editable components. 
Other components are called navigation components.

PO/2
ITI

Link
DNA/X3021224321

DNA_CUG
NCUGs

NCUG_Index/2
NCUG_Index/3

ICUGs
ICUG_Index/6

Hunt_DNA
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Appendix B
Component Provisioning paste keys

This appendix details the services that are supported when pasting PVC or 
direct call components when the Change Keys option is selected from 
Component Provisioning.

See the following tables:

• “Direct call paste keys” (page 315)

• “PVC paste keys” (page 316)

Table 9 
Direct call paste keys

Service name UI Prompt Fields

X25 Remote DNA REMOTEDNA

X32 Remote DNA REMOTEDNA

ITI Remote DNA REMOTEDNA

POS Remote DNA REMOTEDNA

DS_0B Remote DNA REMOTEDNA

NCS Superior Call Remote DNA
OA mnemonic

REMOTEDNA
OAMNEMONIC

Swift BCS Remote DNA REMOTEDNA

Token Ring SNA PAD-
service level

Remote DNA REMOTEDNA

 (Sheet 1 of 2)
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Token Ring SNA PAD-
device level

Remote DNA REMOTEDNA

SNA mnemonic call 
multi-host

Remote DNA REMOTEDNA

Token Ring ISRB Remote DNA ISRBDCREMOTEDNA

Data Spooling DNA of data collection 
system

DSPREMOTEDNA

Broadcast Service Remote DNA REMOTE DNA

Icon Remote DNA
Device Type
PM mnemonic
OA mnemonic

REMOTEDNA
FAXD0DATA
FAXD1DATA
FAXD2DATA

SABRE Remote DNA REMOTEDNA

DSP HPAD Remote DNA REMOTEDNA

API Service Remote DNA REMOTEDNA

Table 10 
PVC paste keys

Service name UI Prompt Fields

X25 Remote DNA
Remote LCN

REMOTEDNA
X25REMOTELCN

X32 Remote DNA
Remote LCN

REMOTEDNA
X25REMOTELCN

ITI Remote DNA
Remote LCN

REMOTEDNA
REMOTELCN

POS Remote DNA
Remote LCN

REMOTEDNA
REMOTELCN
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Table 9  (continued)
Direct call paste keys

Service name UI Prompt Fields

 (Sheet 2 of 2)
241-6001-012   14.3RSUP   



Appendix B Component Provisioning paste keys   317
DS_0B Remote DNA
Remote LCN

REMOTEDNA
REMOTELCN

SNA-multihost, LU Remote DNA
Remote LCN

REMOTEDNA
REMOtELCN

Frame Relay Remote DNA
Remote DLCI

REMOTEDNA
FRREMOTEDLCI

X75 Remote DNA
Remote LCN

REMOTEDNA
X25REMOTELCN

X25 Gateway Remote DNA
Remote LCN

REMOTEDNA
X25REMOTELCN

Broadcast Service Remote DNA
Remote LCN

REMTOEDNA
REMOTELCN

Table 10  (continued)
PVC paste keys

Service name UI Prompt Fields
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Index
A
Accessing UNIX 53
Add command 87
Add envelope command 230
Adding

components 87
subcomponents 87

Adding service data 229
Automatic or Manual backups 161

B
Backup Selected MCFs command 167
Backup to disk 161

C
Change Keys 88, 89
Change service data report print options 97
Changing service data reports file name 97
Changing user preferences 114
checkmcf 302
Clear display fields command 232
Command file command 143
Command line interface 27, 47
Complete download 128
Component area 74
Component Provisioning

capabilities 30, 61
Component area 74
propagate command 121
specifying a component 70
Preside MDM Configurati
Subcomponents area 75
Compress command 75
Compressing components 75
Connecting

to a different module 167
to a module on a different OA 168
to a module on the same OA 168
to modules 167

Context 125
get 125
put 125

Copy images required for an MCF 184
Copying

component 88
Copying images 183
Create module command 70
Creating

new module 70
templates 99

Cut Component command 87
Cutting a component 87

D
Data entry semantics 63
Delete command 96, 100
Delete envelope command 231
deletemcf 302
Deleting

components 87
envelopes or SDAs 231
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templates 100
Deleting service data 231
Dialogs

Change Upload Preferences 116
Download User Preferences 119
Service data reporting 92
Software Distribution--Command file 184

Discard command 89, 232
Discarding

modified components 89
service data 232

Display service data reports 96
Download

changes 91
complete 128
incremental 128
service data 90, 232

Download command 232
Download preferences 118
Downloading images 183
DPN Devices configuration

accessing 47
applications 29

DPN Devices configuration tools
accessing 47
closing 53
opening 47

E
Edit command 80
Editing service data 76, 80
Envelope Editor

capabilities 33, 221
wildcarding 231

Expand all option 75
Expand option 75

F
Filter command 96
Filtering service data reports 96
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Generating service data reports 95
Get context command 125
Global Data Manager

acceptable keywords 130
capabilities 30
command file format 150
command line interface 145–150
keyword mappings 131
main window 132

Graphical user interface 27
without a command file 142, 143

I
Incremental download 128

K
Keep Selected MCFs command 176

L
List envelopes command 231
List MCFs command 167, 175
listmcf 304
Loader mapping files 200
Locating envelopes 231
Log file 55
Logging

propagation 117

M
Manipulating service data 86, 229
MCF Directory Merge

capabilities 35, 277
command line interface 278
command syntax 278

MCF management 35
checkmcf 302
deletemcf 302
listmcf 304
mdsdeletemcf 292
pmdeletemcf 281
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pmtidymcf 284
MCFs

activation date 45
active 42
authentication 40
backup 167
committed 42
dated 44
definition 39
deleting from backup 292
deleting from PM disk 281
downloading 39, 46
keyed 43
location 40
NAMS ID 40
restoring 175
restoring on a different module 176
restoring on a module 176
retrieving 167
retrieving from MDS 175
tidying on PM disk 284
uploading 39
user specified 42

mdsdeletemcf 292
mdstidymcf 297
Module integrity checks 121
Module level semantics 64
Module names file 199

N
Network wide semantics 64

O
Opening 47
OV Desktop

display restrictions 309
exiting 310
online help 309
starting 306
Preside MDM Configurati
P
Paste Component command 88, 89
Pasting a component 88
pmdeletemcf 282
pmtidymcf 287
Print all 97
Print command 97
Printing service data reports 97
Propagate command 121
Propagation logging 117
Provisioning

specific services 35
Provisioning mode 225
Put context command 125

R
Reconnect PM command 168, 177
Reconnecting to a module 168, 177
Removing text from service data reports 96
Replace envelope command 230
Replacing

selected global data components 141, 145
service data 230

Report command 95
Restore Selected MCFs command 176
Restoring

MCFs 175
MCFs on a module 176

Retrieve envelope command 228
Retrieving

data 228
envelopes or SDAs 228
MCFs 167
MCFs on MDS 175

S
Save all command 97
Save as command 97
Save command 97
Save service data reports 97
Semantics
on Management for DPN User Guide   14.3RSUP



322   Index
data entry 63
module level 64
network wide 64

Service data
add 229
clear display fields 232
deleting 231
discarding 232
display area 92
downloading 90, 232
editing 76, 80
generating reports 95
manipulating 86, 229
replacing 230
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